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1 Introduction

Engine control in spark ignited engines means regulating fuel and air intake as well as spark
timing to achieve desired performance and economy.  Until recently, fully programmable
engine management systems were not available to the typical enthusiast and the ones that
were available, based primarily on OEM systems, were complex and cost prohibitive. 
Edelbrock's Pro Flo XT Plus and XTR systems are designed for competition and ultra high
performance street vehicles.  The systems provide the experienced installer/tuner with a
starting point for any custom application.  Pro Flo XT Plus systems feature lower cost
enclosures, connectors and injector drivers.  They are compatible with high impedance
injectors only or low impedance injectors when used in conjunction with a stand alone peak
and hold injector driver box (not included).  Pro Flo XTR systems feature aircraft/mil spec.
style connectors as well as built-in peak and hold injector drivers.  

If you run into problems, you may contact our EFI Technical Hotline at 800-416-8628 from
7:00 am to 5:00 pm PST Monday through Friday. 

Edelbrock EFI system customers can now join others at http://forums.edelbrock.com/forums/
The forum offers support from current experienced users as well as Edelbrock Tech Reps.

  
Pro Flo XT Plus and XTR System Features:

Software
* Live tuning
* 3D fuel and spark maps
* All maps with adjustable breakpoints
* Programmable sensor calibrations
* Closed loop lambda control
* Unique self-mapping software
* Fuel and spark trims for each cylinder
* 3D injection phase map
* Sensor correction tables
* Closed loop boost control
* ECU loadable with 2 maps
* Adjustable internal logger sample rates
* Programmable Engine Protection functions

Outputs
* 8 injector drives - Saturated (XT Plus) or Peak and Hold (XTR)
* 1 coil driver (XT Plus), 4 coil drivers (XTR)
* PWM Wastegate control
* Lambda heater control
* Nitrous control (4 stages)
* Fuel pump output
* Digital tach output
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* Stepper motor (IAC 4 wire)
* PWM output for IAC
* Data link to data logger

Digital Inputs
* Engine speed (hall or mag)
* Cam position (hall or mag)
* Wheel speed (XTR only)

Switch Inputs
*Engine Kill
*Beacon (or clutch switch)
*Pit Switch (or master nitrous enable)
*Map Select (2 unique maps possible switch on the fly)
*Boost Switch (or gear position)

Analog Inputs
* Throttle, Battery, Airbox, Air Temp, Water Temp, Oil Temp, Fuel Press, Oil Press, Lambda
1, Lambda 2, ECU Temp (internal)

Diagnostics
* Error codes for all sensors and pickups
* Programmable error thresholds
* Sensor Min and Max values recorded
* Non-volatile logger memory (1 meg) 
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2 EFI Basics

What is the motivation for electronic engine control?  Is it to make more power?  Better
economy and drivability?  Cold weather improvements?  Other factors?  The answer to all of
these depends on the application.  There are a lot of misconceptions about electronic engine
control and fuel injection in general.  Each of the above items is addressed individually
below: 

More Power
A fuel injection system will add power right?  Not necessarily.  One of the biggest myths or
misconceptions customers have when researching EFI systems is that EFI systems will
"increase horsepower" or "System X will make more power than System Y". There isn't
anything magic about electronically controlling fuel flow or spark advance that will increase
horsepower. Simply put, an engine is an air pump. The amount of power potential an engine
has is in direct proportion to how much airflow is possible. That being said though, when you
switch from a carbureted setup to EFI, you will usually change the intake manifold and
throttle body. If the new intake and throttle body allows your engine to move more air and the
right amount of fuel and timing is added into the mix, your engine will make more power. If
the new manifold and throttle body reduces airflow under certain operating conditions on your
engine, you will lose power...period.

Since fuel suspension and vaporization is no longer an issue with EFI, manifold designers are
not as limited when it comes to runner length or volume. Much longer runners can be created
to increase bottom end torque without worrying about fuel dropping out of suspension.
Beyond that, the job of an EFI system is to control fuel flow and ignition timing just like a
carburetor and points distributor. In most cases mixture distribution can be improved reducing
cylinder to cylinder power fluctuations. You will have much more flexibility with ignition
timing also. There are no mechanical limitations when it comes to spark timing. Most systems
use a 3 dimensional map of indicated engine load and RPM. You can command whatever
spark timing you want based on the operating conditions.

Better Economy and Drivability
Take the example of converting an older V8 carbureted engine to fuel injection.  The potential
for economy and drivability improvements depends on a couple of things:

· How well was the carburetor tuned to begin with?
· What kind of engine is it?  Stock, mildly modified, highly modified, forced induction?
· What kind of camshaft is being used?  

Most traditional carburetors have a given range over which they can operate.  There are
always exceptions to the rule but for the most part, you can't expect a carburetor designed to
support over 500 horsepower to be also capable of maximizing highway fuel economy.  There
are too many tradeoffs in carburetor design.  Usually, the carburetor will be sized and tuned to
make maximum horsepower.  This will create an overly rich condition at light load and part
throttle conditions and will hurt economy.  These limitations are especially important on
forced induction applications.  The required fuel flow range is so large, it is extremely
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difficult to maintain a high fuel flow rate on the top end and still be able to lean the mixture
appropriately for best economy.  Tuning a carburetor for use on a forced induction application
is extremely difficult and usually requires custom modifications to the carburetor design and a
lot of trial and error.  

The potential room for improvement decreases the closer you get to a stock setup, especially
if the original carburetor was sized correctly for the application and tuned well.  There will
always be a little room for improvement but gains are harder to come by on a stock setup and
it takes an experienced tuner to realize them.  In fact, it's entirely possible for an
inexperienced tuner to install an expensive EFI system on a formerly carbureted, stock engine
and lose both power AND economy.

While fuel injectors are still subject to size and flow limitations on the top end, they have
much more useable range on the bottom end and allow for much more precision at low flow
rates.  In other words, you can size your injectors for the required horsepower range without
worrying about losing resolution at idle and cruise settings.  This is especially beneficial on
forced induction engines.  

Proper camshaft selection is always important.  The right camshaft will optimize power
without hurting economy.  The wrong camshaft may make good power but will cause terrible
emissions and fuel economy.  As a rule of thumb, an EFI camshaft should have at least 112
degrees of lobe separation angle to decrease overlap.  EFI engines do not require as much cam
overlap as carbureted engines do.  In fact, too much can cause tuning problems especially on
EFI systems that rely on manifold pressure sensor data for the primary indication of engine
load.  A lot of overlap will decrease manifold vacuum at idle and off idle (where most street
vehicles spend 99.9% of their operating time).  This limits the useable range of the main fuel
map and makes tuning a challenge.  There are tuning strategies available the rely on the TPS
sensor instead of the manifold pressure sensor for load.  This method is referred to as Alpha-
N and avoids the resolution problem caused  by low engine vacuum.  The Alpha-N strategy is
used primarily on racing applications and is best left to an experienced tuner.  

Cold Weather Performance
Provided the camshaft and engine combination are appropriate for an EFI application, there is
a lot of room for improvement in these two areas.  Since the injectors are typically positioned
very close to the intake valve, there is less chance of intake wall wetting in cold conditions. 
Sequential injection also helps to  time the injector opening to the intake valve opening event.
This helps get the right amount of fuel into the cylinder even when cold.  Combined with a
properly tuned idle air control system, cold weather starting and performance will most
certainly improve with EFI.

Other Factors
Depending on the complexity of the system, aftermarket EFI systems can include functions to
control:

· Cooling fans
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· Fuel pump
· Nitrous
· Boost control solenoids
· Staged injectors

Some systems also include on board data logging capabilities.  This is very beneficial for
racing applications.  Many variables can be logged and downloaded  after the race to aid in
diagnostics and tuning.

2.1 Automotive Electronics Fundamentals

2.1.1 Basics of Electric Circuits

To understand the theory of basic direct current (DC) electrical circuits, a few terms must be
defined first:

Volts
Volts are units of electrical pressure.  The symbol used for volts is V.  Very small voltage
values are measured in millivolts (1/1000th of a volt).  Examples include the voltage output
from most engine sensors.  Larger voltages are measured in kilovolts (1,000 volts).  Examples
include the voltage required to jump a spark plug gap during the power stroke.

Amps
Amps or amperes are units of electron flow or how fast the electrons are passing through the
conductor.  The symbol for Amps is A.  Smaller current flow is measured in milliamps (mA
or 1/1000th of an amp)

Ohms
Ohms are units of electrical resistance or how much the conductor or resistor resists the flow
of electrical current.  The symbol for ohms is the greek letter Omega.  Smaller resistances are
measured in milliohms or 1/1000th of an ohm.  Larger resistances are measured in megaohms
or 1000 ohms.  

Ohm's Law
Ohm's law states that the current in a circuit is directly proportional to the applied voltage and
inversely proportional to the resistance in the circuit.  This statement can be re-written using
the following three statements:

1. When the voltage goes up or down, current flow also goes up or down as long as the
resistance stays the same.

2. When resistance goes up, current goes down as long as the voltage stays the same.

3. When the resistance goes down, current goes up as long as the voltage stays the same.

An easy way to understand these concepts is to compare the movement of electricity to that of
running water.  Water flows through a pipe with a certain amount of pressure.  The size
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(diameter) of the pipe dictates how much resistance there will be to the flowing water.  The
smaller the pipe, the more resistance.  You can increase the pressure to get more water to flow
through, or you can increase the size of the pipe to allow more water to flow using less
pressure.  Since too much pressure can burst the pipe, we should probably restrict the amount
of pressure being used.  

Voltage is analogous to water pressure.  Amperage is like the amount or volume of water
flowing through, while resistance is the size of the wire transmitting the current.  Since too
much voltage will damage the electrical components such as light bulbs and computer
circuits, we must limit  the amount of voltage.  Too much water pressure and things could
start breaking.  Too much voltage and things could start overheating. 
 
There are two basic types of circuits, series and parallel.  The following examples illustrate
the differences and how ohm's law applies to each.

The diagram above shows a typical  electrical circuit.  For the sake of this document, assume
the current flows from the positive terminal of the battery trough each load and back to the
negative terminal of the battery.  The load can represent any component in the circuit that
adds resistance.  These can include, ignition coils, injectors, solenoids, light bulbs, etc.  This
type if circuit is referred to as a parallel circuit since the  current flow across each load is
dependent on the load.  As the load resistance goes up, the current flow across that load will
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go down.  The total current flow the battery must provide can be represented as the sum of all
the individual currents in the circuit.   

The diagram above represents a series circuit.  A series circuit is different from a parallel
circuit in that the current flow through the circuit is the same regardless of where it is
measured.  Also, the total resistance the battery sees can be represented by the sum of all
individual load resistances.
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2.1.2 Injector Control Circuit
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The schematic above shows a typical fuel control circuit using the Pro Flo system.  Power is
provided to one side of each injector coil from the main relay.  The relay contacts are supplied
battery voltage through a 20 amp fuse.  The main relay primary coil is supplied power from
the battery through a 3 A fuse and the ignition switch.  The ignition switch must be hot in
both start and run conditions.  The Pro Flo ECU controls the ground side of each injector coil
along with the ground side of the main relay primary coil.  To diagnose basic wiring problems
in this circuit, a digital multimeter can be used to measure the voltage at the positive side of
each injector (usually an orange wire).  If the measurement is performed with the injector
connector unplugged, the data listed in the table above will only apply to the orange wire.  If
the connector is plugged  in, these measurements will apply to both sides of the connector. 
Multimeters do not respond fast enough to be used while the engine is running.  Under these
conditions, an oscilloscope is used to monitor the injector voltage signals.  Note that these
signals are only present when the connector is plugged into the injector.    
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2.1.3 Coil Control Circuit
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The schematic above shows a typical coil control circuit using the Pro Flo system.  Power is
provided to the coil primary from the main relay.  The relay contacts are supplied battery
voltage through a 20 amp fuse.  The main relay primary coil is supplied power from the
battery through a 3 A fuse and the ignition switch.  The ignition switch must be hot in both
start and run conditions.  The Pro Flo ECU controls the ground side of the coil primary along
with the ground side of the main relay primary coil.  To diagnose basic wiring problems in
this circuit, a digital multimeter can be used to measure the voltage at the positive side of the
coil primary (usually a brown wire).  Multimeters do not respond fast enough to be used while
the engine is running.  Under these conditions, an oscilloscope is used to monitor the coil
primary voltage and current signals.  While running power is supplied constantly to the
positive side of the primary coil.  The coil is said to be charging when the Pro Flo ECU
grounds the negative side.  During one engine cycle, the amount of time the coil is grounded
can range from less than 2 milliseconds (0.002 seconds) to more than 7 milliseconds.  This
amount of time is called coil dwell.  The sample oscilloscope trace in the diagram above
shows both voltage and current traces for the coil primary.

2.1.4 Relays

A relay is a remote control switch that uses a small amount of current to control a large
amount of current.  A typical relay has a control circuit called the primary coil and a power
circuit called the contacts.  The primary coil is fed current by the power source and the current
flows through a switch and an electromagnetic coil to ground.  The power circuit is also fed
current from the power source and the current flows to an armature which is attracted by the
magnetic force on the coil.  

When the primary circuit switch is open no current flows through the coil to ground.  The coil
is not energized.  The contacts are open and no current flows to the load.  When the primary
circuit switch is closed, current flows to the relay and energizes the coil.  The resulting
magnetic field pulls the armature down closing the contacts and allowing current to flow to
the load.  The relay control circuit or primary can be switched from either the power supply
side or the ground side.  

2.1.5 5V Analog Circuits

Some sensors require a reference voltage to operate.  Although the reference voltage can
sometimes be 12 volts, most of the time, 5 volts is used.  The sensor will have 3 terminals or
connections:

1. 5 volt high reference
2. Signal
3. Ground

The "ground" pin is important.  It is actually what's called a low reference and is supplied by
the ECU.  The "signal" from the sensor is measured by the ECU relative to the high and low
reference voltages.  The low reference is filtered inside the ECU.  The ground pin from a 3
wire analog sensor should never be connected to battery or chassis grounds.
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2.1.6 Choosing the Right Wire Size

Choosing the correct wire size when constructing harnesses or making circuit repairs is
critical.  Choosing wires too thin may limit current flow to unacceptable levels or even result
in melted wires.  Two size factors must be considered: wire gauge number and wire length. 
Wire gauge numbers are determined by the conductor's cross sectional area.  

In the American wire gauges (AWG) system, "gauge" numbers are assigned to wires of
different thicknesses.  While the gauge numbers are not directly comparable to wire diameters
and cross sectional areas, higher numbers are assigned to increasingly thinner wires and lower
numbers are assigned to increasingly thicker wires.  

The wire cross sectional area in the AWG system is measured in circular mils.  A mil is a
thousandth of an inch (0.001).  A circular mil is the area of a circle 1 mil (0.001) in diameter.  

Wire length must be considered when repairing circuits because resistance increases with
longer lengths.  Fir example, a 16 gauge wire can carry an 18 amp load for 10 feet without
excessive voltage drop.  But if the section of wiring being replaced is only 3 feet long, an 18
gauge wire can be used.  The following table is an excerpt from the Handbook of Electronic
Tables and Formulas and can be used for reference.

AWG
Gauge

Conductor
Diam (in)

Maximum
Current (amps)

0 0.3249 245
1 0.2893 211
2 0.2576 181
3 0.2294 158
4 0.2043 135
5 0.1819 118
6 0.162 101
7 0.1443 89
8 0.1285 73
9 0.1144 64

10 0.1019 55
11 0.0907 47
12 0.0808 41
13 0.072 35
14 0.0641 32
15 0.0571 28
16 0.0508 22
17 0.0453 19
18 0.0403 16
19 0.0359 14
20 0.032 11
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21 0.0285 9
22 0.0254 7
23 0.0226 4.7
24 0.0201 3.5
25 0.0179 2.7
26 0.0159 2.2
27 0.0142 1.7
28 0.0126 1.4
29 0.0113 1.2
30 0.01 0.86
31 0.0089 0.7
32 0.008 0.53

2.1.7 Fuses

Fuses are the most common circuit protection device.  Fuses have a fusible element, or low
melting point metal strip, in a glass tube or plug-in plastic cartridge.  Fuse ratings range from 
0.5 to 35 amps, but 3 amp to 20 amp fuses are most common.

Notes
1. Turn off all electrical components and the ignition switch before replacing a fuse.  Do not

exceed the fuse amp rating.
2. Always use a fuse puller for removing and inserting a fuse.  Remove and install straight in

and out without twisting.  Twisting could force open the terminals too much, resulting in a
bad connection.

   

2.2 Fuel System Basics

2.2.1 Fuel Injector Sizing

A simple formula can be used to select properly sized injectors for your application.  To select
the proper injector size, the required flow rate at each injector must be calculated

BSFC = Brake Specific Fuel Consumption (Typically 0.50 for normally
aspirated and 0.65 for supercharged)

# Injectors = the number of injectors used in the engine 

Max HP = Maximum engine rated (or estimated) power (HP)

Max Inj Duty Cycle  = 0.80 - 0.90 (typically)
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Example: What size injectors would be required to support a 600 hp engine?

2.2.2 Fuel Pump, Filter and Regulator

Fuel Pump and Filter
It is very important that the fuel flow capacity of the EFI pump exceed your peak demand by
20-25% to avoid engine damage due to loss of pressure. Electrical connectors should face the
front of vehicle when mounting. Consult your Edelbrock representative for assistance in
pump selection. A high pressure/high volume EFI fuel filter should be mounted between the
engine compartment and the fuel pump.  A high quality inlet filter should also be installed to
protect the fuel pump from contamination. 

The fuel filter must have the capacity, efficiency and burst strength to withstand the pressures
of an EFI system.  The flow capacity must meet or exceed the maximum fuel pump flow rate.
The filter must be located after the fuel pump but it does not matter if it is located in the front
or rear of the vehicle.  

A pre-filter must be mounted to the fuel pick up in the tank.  These filters are very high
volume and create very little pressure drop.  The use of a pre filter protects the fuel pump
from debris entering the pump inlet.

Consult your Edelbrock representative for assistance in filter selection. Use the mounting
instructions for the pump and filters that you are using.

Recommended Fuel Pumps and Regulators

Up to 600 HP
Edelbrock P/N 35943 - Kit includes fuel pump #3594 and regulator #1728

Up to 800 HP
Edelbrock P/N 17903 - Kit includes fuel pump #1790 and regulator #1729

Up to 1500 HP
Edelbrock P/N 17943 - Kit includes fuel pump #1794 and regulator #1729
 
Fuel Pressure Regulator
Fuel pressure is as important as fuel volume, particularly in fuel injection. The Pro Flo system
requires that the fuel pressure regulator maintains a constant pressure at the injectors. It is
recommended that Manifold Absolute Pressure references the regulator diaphragm to
maintain constant pressure across all 8 injectors, regardless of fluctuating manifold pressure
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(vacuum) level. The fuel that is not injected is returned to the fuel tank via the return fuel line.
Recommended pressure settings vary with application. There are two basic types of
regulators.  They are adjustable or non-adjustable.  A non-adjustable regulator is set to a fixed
value and is manifold vacuum referenced.  A regulator is said to be vacuum referenced when
intake manifold vacuum is plumbed into the chamber above the regulator diaphragm.  Most
regulators are referenced to manifold vacuum.  This means that the highest fuel pressure will
be observed with the pump running and the engine off (key-on / engine off).  When the engine
starts and begins pulling vacuum in the intake manifold, the observed fuel pressure at the rail
will drop.  The differential pressure, if measured between the fuel rail and the intake
manifold, will remain constant.   Adjustable regulators can be set to different values by
adjusting a set screw that changes the pre-load on the spring above the diaphragm.  Consult
your Edelbrock representative for pressure recommendations.

2.2.3 Fuel Rails and Lines

Fuel System Plumbing
Edelbrock recommends parallel plumbing for performance applications.  Parallel plumbing is
accomplished by teeing the feed hose from the pump into both fuel rails and connecting the
two outlets to the fuel pressure regulator.  This gives twice the capacity of series configuration
plumbing.  It also reduces the fuel velocity in the fuel rail when compared to series plumbing.
If the fuel velocity is too high it may cause flow disturbance in the fuel rails.  A parallel
configuration is recommended to achieve the best cylinder to cylinder distribution.

A fuel system will not flow adequately unless the hoses that deliver the fuel to the fuel rails
are of sufficient size and are routed properly.  Never route fuel lines through the interior of the
vehicle.  The lines should be rated to withstand at least twice the maximum pressure of the
EFI system.  Fuel lines should be protected from road hazards and exhaust system
components.  Use clamps to secure AN hose every 15 inches or 24 inches if rigid tube is
used. 

Supply hose recommendations:

Gasoline Engines

Up - 500 hp 0.344" hose -6AN
500 - 800 hp 0.437" hose -8AN
800 - 1100 hp 0.562" hose -10AN

Methanol Engines

Up - 500 hp 0.437" hose -8AN
500 - 800 hp 0.562" hose -10AN
800 - 1100 hp 0.687" hose -12AN

Return hose recommendations:
It is difficult to make specific recommendations with regard to return line size.  The
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requirements will be dependent on the fuel pump capacity and target fuel rail pressure range. 
The fuel pump, supply line, regulator and return line must work together as a system.  Most
available three port adjustable regulators use a -6 AN fitting on the return port.  This limits
the maximum return line size to 3/8" hose.     

2.3 Ignition System Basics

2.3.1 Inductive Ignition Systems

Coils work on the principle of induced voltage.  When electricity flows through a wire, it
generates a magnetic field outside the wire.  Conversely, when a magnetic field moves across
a wire, it induces an electrical current in the wire.  Inside any coil, there are two sets of
windings, the primary and secondary.  Both windings are made of insulated copper wire. 
Although the windings are next to each other, there is no direct electrical connection between
the windings.  The primary winding usually has 100 - 150 turns of a heavier gauge wire.  The
secondary winding can have more than 10,000 turns of a very fine gauge wire that is typically
smaller than a human hair.  Coil operation starts with low voltage current flowing through the
primary windings.  As current flows through the primary windings, it generates a magnetic
field that surrounds both windings.  The ignition control signal from the ECU interrupts the
current flow when commanding the coil to fire.  When this happens, the magnetic field
collapses.  This induces current flow in the secondary windings.  Because of the higher
number of windings on the secondary side and lower number of windings on the primary side,
the current induced in the ignition coil has very low amperage but very high voltage.   

The ECU controls the current flow through the coil primary by providing a ground path.  A
switching power transistor inside the ECU opens and closes sinking current to ground
charging the coil.  When the ground path is removed, the coil fires.

Inductive Coil Selection 
The Pro Flo XT Plus ignition output is rated at 8 amps maximum continuous current.  It is
designed to fire a coil directly without an ignition amplifier.  Coil primary resistance should
be no less than 0.7 ohms (a typical value  for most popular MSD Blaster ignition coils). 
Avoid coils designed specifically for CDI ignition systems.  The primary resistance of these
coils is much too low and will cause an over-current condition.
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2.3.2 Distributed Spark

The schematic above shows a typical points type distributor arrangement.  Ignition power is
supplied to the positive side of the primary coil.  The negative side is controlled by a cam
attached to the distributor shaft.  The cam forces the breaker points (or contacts) closed at 90
degree evenly spaced intervals.  When the points are closed, current flows through the
primary side of the ignition coil charging it to capacity.  When the points open, the magnetic
field breaks down and a high energy voltage pulse is transmitted through the coil wire to the
distributor firing each plug in sequence.   
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The schematic above shows a typical electronically controlled distributor arrangement.  An
electronically controlled system replaces the traditional points with a power transistor.  A
power transistor is like an electronic relay in that a small amount of current from one leg to
ground allows a larger amount of current to flow from the other leg to ground.  The
controlling device, the microprocessor in the example above, does not need to supply a large
amount of current flow.  It only needs to supply enough current to turn the transistor on which
is typically on the order of milliamps. 
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2.3.3 Wasted Spark

The above schematic represents a typical wasted spark ignition system for an 8 cylinder
application.  Wasted spark ignition systems use dual-spark coils.  Each high voltage output is
connected to a spark plug to produce arcs at both plugs when the primary current is
deactivated.  Each plug fires twice per engine cycle, once on compression and once again 360
crank degrees later when there is no combustible mixture to ignite (hence the wasted spark).
The advantage to this setup over a distributed system is much more available time for coil
dwell.  This means the engine can rev higher without requiring a capacitive discharge ignition
box.     

2.3.4 Coil on Plug

Most "Coil On Plug" systems are actually "Coil Near Plug" with a single coil dedicated to
each spark plug.  A short length of high tension wire is used to connect the plug to the coil. 
One ignition control output from the ECU is required for each engine cylinder.  A 4 cylinder
engine will have 4 coils and 4 ignition outputs from the ECU.  An 8 cylinder engine will have
8 and so on.  These systems allow the most time for coil charging and cooling between charge
cycles.  This system simplifies the secondary ignition to the minimum number of components
and reduces the distance the high-voltage circuit must travel.  
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2.3.5 Multiplexed Ignition

The above schematic represents a typical multiplexed ignition system.  A single ignition
output from the Pro Flo ECU is "distributed" to 8 individual ignition coils electronically with
an integrated circuit.  This system includes some benefits of a true coil near plug setup.  The
high voltage secondary circuit can be simplified and shortened to avoid voltage leaks. 
Because there is only one ignition control output from the ECU, there is no charge time
advantage compared to a traditional distributed system. 

2.3.6 Capacitive Discharge Ignition Systems

Capacitive discharge ignition systems work by storing energy in an external capacitor, which
is then discharged into the ignition coil primary winding when required. This rate of discharge
is much higher than that found in inductive systems, and causes a corresponding increase in
the rate of voltage rise in the secondary coil winding. This faster voltage rise in the secondary
winding creates a spark that can allow combustion in an engine that has excess oil or an over
rich fuel air mixture in the combustion chamber. The high initial spark voltage avoids leakage
across the spark plug insulator and electrodes caused by fouling, but leaves much less energy
available for a sufficiently long spark duration; this may not be sufficient for complete
combustion in a “lean burn” turbocharged engine resulting in misfiring and high exhaust
emissions.
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The high voltage power supply required for a capacitive discharge system can be a
disadvantage, as this supply provides the power for all ignition firings and is liable to failure.

Ignition in lean fuel mixtures by capacitive discharge systems can sometimes only be
accomplished by the use of multi-spark ignition, where the ignition system duplicates the
prolonged spark of inductive spark systems by sparking a number of times during the cycle.
This adds greater stress onto the high-tension leads and can cause considerable spark plug
wear and possible failure. 

Capacitive discharge systems are beneficial on distributed V8 applications that rev above
7,000 RPM.  At these speeds, the time between firing events is less than 2 milliseconds. 
Unless the inductive coil is designed for high RPM applications and charges very quickly, 2
milliseconds is usually not enough time.  This can result in a misfire, especially if the cylinder
pressures are high.

See your CDI manufacturer's installation instructions for more information.

2.4 EFI Sensors

EFI systems use several different types of sensors:

· Thermistors are temperature sensitive variable resistors.  The operate on a reference voltage
supplied by the control module.  Resistance changes with temperature, changing the signal
voltage to the control module.  Examples include Air Temperature and Coolant
Temperature.

· Potentiometers are mechanically variable resistors that also operate using a controller
supplied reference voltage.  Signal voltage changes with position or rotation.  Examples
include Throttle Position.

· Hall Effect Devices generate a digital pulse.  As rotational speed changes, the frequency of
this digital pulse will change as well.  Examples include crank position, cam position and
vehicle speed.

· VR or variable reluctance devices do not require a reference voltage to generate a signal. 
They are used for frequency measurement as well.  Examples include crank position, cam
position and vehicle speed.

2.4.1 Pressure Scales & Units

Pressure 
The term pressure is defined as force per unit area or the amount of force applied to a given
area.  Barometric or atmospheric pressure is the term used by your local weather reporter.  It's
the result of air pressing down and in all directions.  Typical standard day pressure in three
different units of measurement are:



Power to Win32

101 kPa (kiloPascals)
14.7 psi (pounds per square inch)
29.92 in. Hg (inches of Mercury)  Hg is the chemical symbol for Mercury.

Each of these values represents the exact same pressure.  

Vacuum
For many years, automotive technicians and enthusiast have referred to engine air flow and
load in terms of "vacuum".  When the piston moves down the cylinder bore, it creates a
vacuum.  The average amount of vacuum from all cylinders is measured in the intake
manifold.  Using atmospheric pressure as a zero baseline, manifold pressure is expressed as a
negative value - vacuum.  The Edelbrock calibration module supplied with all Pro Flo2 and
Pro Flo XT kits, displays engine load in terms of inches of Mercury vacuum.  A displayed
value of 10.0 means 10.0 inches of vacuum.

2.4.2 Engine Position

Engine position sensors are used to calculate engine speed and locate injector/coil firing
events.  Some systems use two sensors, one to calculate engine speed and locate firing events,
the other to determine which cycle the engine is on.  Engine position sensors generate a
frequency signal that is read by the engine controller.  The relative location and frequency of
the signal determines engine speed and position.  Two basic types are used.  Variable
reluctance or (VR) type sensors are two wire devices that generate their own voltage.  Hall
effect type sensors are three wire devices and require a reference voltage, usually either 5
volts or 12 volts.

2.4.3 Load

The engine load indication is used as a primary variable in several areas of the calibration. 
These include:

· Main fuel map
· Main spark map
· Injection phasing map
· Lambda target map
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2.4.3.1 Manifold Pressure (MAP)

Manifold Absolute Pressure (MAP)

The MAP sensor measures pressure in the intake manifold.  Manifold pressure provides the
ECU information that helps the system determine the load on the engine so the appropriate
output changes are calculated and executed.  

2.4.3.2 Throttle Angle

When throttle angle is used as the primary load indication, the fuel control strategy is referred
to as Alpha-N.  Alpha refers to the angle of throttle opening and N represents engine speed. 
In most cases, the Alpha-N tuning strategy is best used for racing only applications.  There are
several reasons for this.  Alpha-N tuning strategies are sometimes difficult to use on
automatic transmission vehicles with relatively tight torque  converters or any application that
uses an idle air control valve.  Under idle conditions when the throttle is closed, there is no
way to compensate for changes in airflow or applied load on the engine such as shifting from
park to drive.  The ECU commands fuel flow vs throttle position and RPM only.  It has no
way of knowing that a richer mixture is required when you shift into drive.  All it knows is the
throttle is closed and there is only one commanded fuel value for a closed throttle position.   
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2.4.4 Throttle Position

Throttle Position Sensor (TPS)

 

The Throttle Position Sensor (TPS) measures the position of the throttle shaft.  A closed
throttle indication (below a programmed angle threshold) tells the ECU to enter idle control
mode.  The rate of change of throttle shaft position is calculated by the ECU and used to
provide either enrichment (acceleration fuel) or fuel cutoff (deceleration mode).  Throttle
shaft position or angle can also be used on racing engine applications as the primary
indication of engine load.

2.4.5 Coolant Temperature

Engine Coolant Temperature Sensor (ECT)

 

The engine coolant temperature sensor is a thermistor device which measures coolant
temperature. This input is used to adjust fuel and spark requirements for changes in engine
temperature.
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2.4.6 Air Temperature

Intake Air Temperature Sensor

The Intake Air Temperature sensor is a thermistor device which measures air temperature.
This input is used to adjust fuel and spark requirements for changes in intake air temperature.
 

2.4.7 Oxygen

Standard "narrow band" O2 sensors operate between 0 and 1 volts, and are only capable of
accurately measuring a stoichiometric air/fuel ratio (e.g. 14.7:1). A richer or leaner condition
results in an abrupt voltage change and thus is only useful for qualitative determination.
Modern automobiles use this "switch" like sensing at idle and part throttle to make small
compensations in fuel delivery to keep the air/fuel ratio near 14.7:1. 
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Wide band oxygen sensors, such as the Bosch LSU 4.2, utilize a more sophisticated sensing
element which enable it to produce precise voltage output in proportion to the air/fuel ratio. 
As a result a wide band sensor can measure accurately from as rich as 9.0:1 to as lean as free
air. Wide band sensors used to be cost prohibitive, however recently their wide spread use has
reduced prices to as low at $50.   

2.4.8 Fuel Pressure

Steady reliable fuel pressure is a fundamental requirement for any EFI system.  A fuel
pressure input can be very beneficial and can aid in setup, tuning and diagnostics.  Many fuel
system anomalies can be diagnosed using fuel pressure.  These include injector, fuel pump
and regulator problems.  

All Pro Flo XT Plus systems include an auxiliary input connector on the engine side harness. 
The fuel pressure input to the ECU is located at pin 12 of the AUX connector.  A mating
connector with pigtails is provided as well.  The AUX connector also includes 5 volt
reference and sensor ground outputs located on pins 11 and 10 respectively.  These can be
used to provide power and ground to most common fuel pressure sensors.  Edelbrock offers
the following:

Edelbrock P/N 36011, Fuel and oil pressure transducer (0-100 psi)

This sensor is supplied with a pigtail harness that uses the following connections:

A - Ground (Black)
B - Supply Voltage (Gray)
C - Output Signal (Light Blue)

To use with the Pro Flo XT Plus system, make the following connections:

Pressure Transducer Pins XT Plus Harness AUX Connector
A - Ground Pin 10
B - Supply Voltage Pin 11
C - Signal Pin 12
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2.4.9 Oil Pressure

The oil pressure input to the ECU is located at pin 7 of the AUX connector.  A mating
connector with pigtails is provided as well.  The AUX connector also includes 5 volt
reference and sensor ground outputs located on pins 11 and 10 respectively.  These can be
used to provide power and ground to most common oil pressure sensors.  Edelbrock offers the
following:

Edelbrock P/N 36011, Fuel and oil pressure transducer (0-100 psi)

This sensor is supplied with a pigtail harness that uses the following connections:

A - Ground (Black)
B - Supply Voltage (Gray)
C - Output Signal (Light Blue)

To use with the Pro Flo XT Plus system, make the following connections:



Power to Win38

Pressure Transducer Pins XT Plus Harness AUX Connector
A - Ground Pin 10
B - Supply Voltage Pin 11
C - Signal Pin 12

2.5 EFI Actuators

Actuators do the work in any EFI system.  Fuel system actuators include the injectors and fuel
pump.  Ignition system actuators include the coil(s) and spark  plugs.  The idle control system
uses either a 2 wire PWM or a 4 wire stepper motor valve.  OEM vehicles employ a host of
additional actuators for emissions and transmission control functions.  Higher end aftermarket
ECUs like the Edelbrock Pro Flo XT Plus and XTR systems also include actuator control
outputs for many racing functions like nitrous solenoid control and turbocharger wastegate
control. 

2.5.1 Fuel Injectors

The actuators that control the air-fuel ratio are the injectors.  Injectors are solenoid valves. 
The are electrically hot when the fuel pump relay or main relay is closed.  The ECU controls
the ground side of the injector circuit.  When the ECU grounds the circuit, the injector valve
opens.  Two things affect the amount of fuel flow though the injectors:

1. Pressure - the greater the pressure, the greater the flow
2. Time - the longer the injector valve is open, the greater the flow through it

Note on fuel injection drivers:
High impedance injectors are used with Saturated Drivers. Low impedance injectors are used
with Peak and Hold Drivers or with Saturated drivers when used in conjuction with a ballast
resistor (resistor box). The following, taken from SAE J1832 Nov 1989 - Gasoline Fuel
Injector, defines each method and also lists the advantages and disadvantages to each. The Pro
Flo XTR system is capable of operating either high or low impedance injectors. All other
Edelbrock ECU's including the Pro Flo, Pro Flo XT and Pro Flo XT Plus will only operate
high impedance injectors.

Injector Driver - An electronic circuit that supplies voltage pulses to an electromagnetic fuel
injector for a precise increment of time and at a given repetition rate. The accuracy of these
pulses and their repetition is
normally ±0.001 ms. The peak-hold driver and the saturated driver are most commonly used
by the industry for vehicle applications.

Peak and Hold Driver 
A driver that uses two levels of current to operate the injector. The driver circuit applies
battery voltage to the injector until a predetermined current level is reached. The current is
then reduced and held at a lower level for the duration of the PW. This type of driver is
normally used with injectors having low resistance coils (typically around 2 ohm). The
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accuracy of the driver peak current level (Ip) and the hold current level (Ih) is held to ±0.50%.

Advantages - The high peak current minimizes OT response and the low hold current
minimizes CT response. This method of control results in an increased linear range of injector
operation.

Disadvantages - Heat is primarily dissipated at the driver. Circuitry is more complex than that
of the saturated driver.

Saturated Driver 
A power transistor driver that turns fully on for the entire duration of the injector PW. This
type of driver is used with injectors having high resistance coils (typically 12 to 16 ohm) or
with injectors having low resistance coils in combination with a ballast resistor.

Advantages - Heat is primarily dissipated through the injector or ballast resistor and not at the
driver circuit. Circuitry is simplified compared to the peak-hold driver.

Disadvantages - The inherently slower dynamic response of this system decreases the
injector’s usable flow range. The Q of an injector used with this type of circuit is more duty
cycle sensitive due to heat dissipation considerations. This driver’s inductive suppression,
which may be resistance, capacitance or zener, significantly affects the injector’s Qd rates due
to variations in the circuit’s current decay rate. This decay results in a change of the injector’s
closing time.  

2.5.2 Ignition Coils

Ignition coils are comprised of two sets of wound wire called the primary and secondary
windings.  The primary side is the low voltage part controlled by the ECU.  The secondary
side is the high voltage part and is connected to the distributor cap and ultimately the spark
plugs.  The high voltage pulses that create combustion at the spark plug gap are generated in
the ignition coil.  Voltage is applied to one side of the primary coil.  The ECU supplies
ground to the other side in the form of precisely timed ground "pulses".  The amount of time
the primary negative side is grounded is referred to as ignition dwell. During dwell, current
flows through the primary which creates a magnetic field between the primary and secondary
windings in the coil.  When the current flow stops, this magnetic field breaks down and
creates a high voltage pulse in the secondary side.  The amount of step up voltage is
determined by the overall coil design and the ratio of windings between the primary and
secondary (usually 100:1).

 

2.5.3 Spark Plugs

The spark that initiates combustion is produced by applying a high voltage pulse (20,000 to
40,000 volts) between the center electrode and ground.  The actual voltage to start the spark
varies with the size of the gap, the compression ratio and the air/fuel ratio.  Once the spark is
started, the voltage required to sustain it is much lower because the gas mixture near the gap



Power to Win40

becomes highly ionized.  The spark is sustained long enough to ignite the air/fuel mixture.  

The spark plug consists of a pair of electrodes, called the center and ground electrodes,
separated by a gap.  The gap size is important and may range from 0.025" to 0.065" depending
on the engine.  The center electrode is insulated from the ground electrode and the metallic
shell.  The ground electrode is at electrical ground potential because one terminal of the
battery which supplies the current to generate the high voltage pulse for the ignition system is
connected to the engine block and frame.  This is one reason why good clean ground wires are
very important.  

Resistor Plugs
Resistor spark plugs use a ceramic resistor in the spark plug to suppress ignition noise
generated during sparking. Edelbrock strongly recommends using resistor spark plugs in any
fuel injected application. This is because resistor spark plugs reduce electromagnetic
interference with on-board electronics.

Using a non-resistor plug in certain applications can actually cause the engine to suffer
undesirable side effects such as an erratic idle, high-rpm misfire, engine run-on, power drop
off at certain rpm levels and abnormal combustion.

Note: Edelbrock recommends a Champion RC-12YC (or equivalent) for all NORMALLY
ASPIRATED crate engine applications. 

2.5.4 Idle Air Control Actuators

The idle air control (IAC) is an electronically actuated valve that bypasses a controlled
amount of air around the throttle blade(s).  The engine calibration defines the target idle speed
as a function of coolant temperature.  If the actual engine speed is below the target, the ECU
will command the IAC to open.  If the actual engine speed is above the target, the ECU will
command the IAC to close.

2.6 Terminology

4 Stroke Cycle
Intake - During the intake stroke, the piston is moving from top to bottom and the intake
valve is open. As the piston moves down, a vacuum is created which draws the air/fuel
mixture into the combustion chamber. The intake valve is closed after the piston reaches the
bottom. This position is normally called bottom dead center (BDC)

Intake - During the intake stroke, the piston is moving from top to bottom and the
intake valve is open. As the piston moves down, a vacuum is created which draws the
air/fuel mixture into the combustion chamber. The intake valve is closed after the
piston reaches the bottom. This position is normally called bottom dead center (BDC)

Compression - During the compression stroke, the piston moves up and compresses
the air/fuel mixture against the cylinder head. When the piston is near the top of the
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stroke (the top of the stroke is typically called top dead center, TDC), the ignition
system produces a spark at the spark plug. The spark ignites the mixture which creates
a rapid rise in cylinder pressure.

Power - During the power stroke, the high pressure gases produced by the burning of
air/fuel mixture force the piston back down the cylinder bore. This is the only stroke
that actually produces useable power from the engine.

Exhaust - During the exhaust stroke, the piston moves upward. The exhaust valve is
open and the piston forces the spent gases out the exhaust port and into the exhaust
system.

5 Volt Reference
The high voltage reference for most automotive analog sensors. Typical three wire sensors
will have a high reference, a low reference and a signal output. The signal output will always
fall between the low and high reference points.

Air / Fuel Ratio
In engine testing, both the air mass flow rate and the fuel mass flow rate are normally
measured. The ratio of these flow rates is useful in defining engine operating conditions. The
normal operating range for a conventional spark ignited gasoline burning engine is between
12:1 and 18:1. Turbo/supercharged engines typically operate even richer with air/fuel ratios as
low as 11:1. The most common way to measure Air/Fuel ratio for engine calibration work is
by using an oxygen sensor in the exhaust stream.

Analog Circuits
Electrical circuits that amplify or alter a voltage signal to represent some physical quantity.

Atmospheric Pressure
Normal pressure in the surrounding atmosphere generated by the weight above us pushing
down.  At sea level, in average weather conditions, atmospheric pressure is approximately
100 kPa (about 14.5 psi) above vacuum or zero absolute pressure.

Base Idle
Idle RPM when the throttle lever is at rest on the throttle stop and the idle speed control
function is disabled.

BDC
Bottom dead center; the extreme lowest position of the piston during its stroke.

Boost
Describes positive pressure in the intake manifold relative to atmospheric pressure.  Standard
atmospheric pressure is 14.5 psia.  10 psi of boost would result in 24.5 psia in the manifold.  

Breakpoints
Define the axis values on two dimensional or three dimensional lookup tables
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BSFC
Brake Specific Fuel Consumption or BSFC is the fuel flow rate per unit power output. It
measures how efficiently an engine is using the fuel supplied to produce work.

Calibration
Engine calibration in its most basic form is the setting of the air/fuel ratio and ignition timing
for the engine. Modern electronic engine control systems serve many more functions though.
These can include: idle control, automatic transmission control, turbocharger boost control
and knock control. The engine controller can also be used to enable/disable ancillary
functions like emissions control solenoid valves (EVAP/purge, air injection), air conditioner
compressor clutch relays, etc. The engine calibrator is responsible for configuring and tuning
all of these items to satisfy the performance requirements for the engine.

Capacitor
An electronic device that stores electrical charge.

Closed Loop Fuel Control
An engine control mode of operation where the air/fuel ratio is controlled by varying the fuel
flow rate in response to the rich/lean indication from an exhaust

Coil
For ignition system is comprised of two sets of insulated wire wound around a common
ferrous core.  The primary winding is typically made up of tens or hundreds of turns of course
wire.  The secondary winding is made up thousands of turns of fine wire.  A single set of coil
windings can be used to build a solenoid that converts electrical field energy into mechanical
movement.

Coil on Plug
Refers to ignition systems that include one coil for each spark plug.  Most modern automotive
ignition systems are of this type.

Cold Start
Starting the engine when it is cold; when the engine has not run for several hours. gas oxygen
sensor.

Combustion
The burning of the fuel-air mixture in the cylinder.

Combustion Chamber
Space left between the cylinder head and the top of the piston at TDC; where combustion of
the air-fuel mixture takes place.

Compression Ratio
The ratio of the cylinder volume at BDC to the volume at TDC.
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Constants
Single value in an engine calibration.  Can sometimes be referred to as an option.  Constants
and tables (2D and 3D) make up the tuneable portion of an engine calibration file. 

Continuity
Little or no resistance in an electrical circuit to the flow of current.  A solid electrical
connection between two points in a circuit.  The opposite of an open circuit.

Controller
In automotive electronics, refers to a module made up of semiconductor circuits sometimes
containing imbedded software code.   

Data
Information calculated or obtained directly from sensor inputs to a controller.  

Data Analysis
The task of interpreting information obtained from engine sensors and controller calculations. 

Density
The ratio of the mass of something to the volume it occupies.  Air has less density when it is
warm and less density at higher altitudes.

Digital Circuit
Electronic circuits whose outputs can change only by specific amounts and between a limited
number of different voltages.

Stoichiometric
The air/fuel ratio for complete combustion; all the fuel is burned using exactly all the oxygen
in the air. For gasoline, this ratio is 14.7:1 or 14.7 parts of air to 1 part fuel.

Display
Device used to indicate information in a human readable form.

Distributed Ignition
High voltage ignition pulses transmitted to the wires and spark plugs by means of a rotating
shaft, rotor and cap.

Driveability
Condition describing a car in which it starts easily and idles, accelerates and shifts smoothly
and with adequate power for varying temperatures.

Driver
In automotive electronics, refers usually to a transistor circuit that is designed to either source
or sink electrical current.

Duty Cycle
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In components which cycle on and off at a given frequency, the measurement of the amount
of time the component is on versus the time it is off.

Dwell
The amount of time that current is flowing through the primary side of the ignition coil. 
Dwell measurements can be expressed in either units of time (usually milliseconds) or
crankshaft degrees.

ECU
Engine Control Unit.  Refers to an electrical module that receives inputs from sensors and
outputs signals to actuators on an engine.

Emissions
Chemical by-products of combustion; comprised primarily of carbon monoxide (CO),
hydrocarbons (HC) and nitrous oxides (NOX).

Engine Calibration
The values contained in the controller program that are adjustable by the tuner and are used to
control engine operation, primarily fuel and spark requirements.

Engine Mapping
A procedure of experimentally determining the performance of an engine at selected operating
points and recording the results.

Equivalence Ratio
Actual air/fuel ratio divided by the air/fuel ratio at stoichiometry.

Export
To output information or data from one piece of computer software for use in another.

Gain
In closed loop control terminology, refers to constants that vary the magnitude of each term in
the manipulated variable calculation or algorithm.

Hall Effect Position Sensor
Type of sensor used in all Pro Flo distributors for measuring crankshaft position. Outputs a
square wave signal pattern that is either low (ground) or high (reference voltage) depending
on whether or not a tooth is passing near the sensor.

Hg
The chemical representation for the element Mercury.

High Impedance
Refers to injectors that have coil resistance values of 12.0 ohms or more

Hot Keys
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Single or combinations of key strokes that can be programmed to perform certain tasks.

Import
To receive information or data from one piece of computer software for use in another.

Inches Hg
A relative measure of pressure or vacuum.  

Injector
Solenoid actuated fixed orifice valve used to inject precise amounts of fuel 

Integrated Circuit
A semiconductor device that contains many circuits on a single chip.

Lambda
Term referring to the oxygen sensor itself or the data obtained from an oxygen sensor that
represent the air / fuel ratio of the engine.  The lambda value is a ratio and is therefore unit-
less.    

Load
In fuel injection calibrations, a term used to scale the demand on an engine.  Commanded
fuel, spark and other variables are assigned in the calibration file based on the load and
current operating mode of the engine. 

Lookup Table
A table in software that equates one variable to another.

Low Impedance
Refers to injectors that have coil resistance values of 2.5-3.0 ohms

Macro
A feature of some computer software programs that allows a number of repeated tasks to be
combined and performed on command.

Math Channel
In data analysis software, a channel calculated using raw data and mathematical functions. 
Can be included in a plot with other data. 

mS
Abbreviation for millisecond or one thousandth, 0.001 seconds.

Open Loop Fuel Control
Method of controlling fuel flow without modification from a feedback variable such as
oxygen content.

Outing
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In data analysis software, refers to a complete set of data. 

Parallel Circuit
Contains two or more circuit elements that have the same voltage measured across each.

Peak and Hold Driver
A driver that uses two levels of current to operate the injector. The driver circuit applies
battery voltage to the injector until a predetermined current level is reached. The current is
then reduced and held at a lower level for the duration of the PW. This type of driver is
normally used with injectors having low resistance coils (typically around 2 ohm). The
accuracy of the driver peak current level (Ip) and the hold current level (Ih) is held to ±0.50%.

Permanent Power
Sometimes referred to as "Perm" power. This is uninterrupted battery power. Typically a
direct connection to the battery positive terminal.

Pickup
Term that sometimes refers to frequency measurement sensors such as crank or cam position.

Pigtail
One or more wires terminated only on one end.  Sometimes specialized automotive
connectors are supplied with a short piece of wire installed in each cavity.  Can be spliced into
an existing harness.

Pinout
Refers to the description of each circuit or pin on a connector.

Power
Power is the rate at which work is done. It is the product of torque and angular speed.

psi
Abbreviation for pounds per square inch, a unit of pressure measurement.

psia
Abbreviation for pounds per square inch absolute.  A unit of pressure measurement relative to
a perfect vacuum.  

RS232
A common standard used in serial communication between a PC and an engine controller. 

RXD
Abbreviation for Receive Data.

Saturated Driver
A power transistor driver that turns fully on for the entire duration of the injector PW. This
type of driver is used with injectors having high resistance coils (typically 12 to 16 ohm) or



EFI Basics 47

with injectors having low resistance coils in combination with a ballast resistor

Sensor Calibration
Sensors used on EFI systems output a voltage that is proportional to whatever the sensor is
monitoring, manifold pressure, coolant temperature, etc. A calibration curve is a 2
dimensional lookup table that assigns sensor voltage settings to values in particular
engineering units. Manifold pressure will be calibrated in units of pressure, coolant
temperature will be calibrated in units of temperature, either Fahrenheit or Celsius, etc.

Sensor Ground
Also known as analog ground or low reference. The voltage output from a sensor is always
relative to some reference. Most analog sensors use a clean 5 volt high reference and a clean
low reference or sensor ground. Sensor grounds are actually outputs from the ECU. The
engine controller isolates and filters these reference grounds so they are not affected by stray
electrical noise.

Serial 
In communication hardware, serial refers to sending data sequentially, one bit at a time over a
communication channel or cable.

Series Circuit
Two or more circuit elements are said to be in series if the same current flows through each of
the elements.

Spark Timing
Time measured in degrees of crankshaft rotation between the spark plug firing event and top
dead center for that cylinder.

Stoichiometric
The air/fuel ratio for complete combustion; all the fuel is burned using exactly all the oxygen
in the air. For gasoline, this ratio is 14.7:1 or 14.7 parts of air to 1 part fuel.

Switch
A device that can break an electrical connection interrupting the current or diverting it from
one conductor to another.

Switched Ground
Using an electromechanical of electronic switch to connect a circuit element to a ground
reference.

Switched Power
Battery power provided to the system when the ignition switch is in both the "run" and "start"
positions.

Tile
Software feature allowing multiple windows to be displayed at once.
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Torque
Torque is a measure of an engine's ability to do work. Engine torque is normally measured
with an engine dynamometer.

Trims
Alternate term used to describe correction tables in an engine calibration file.

TXD
Abbreviation for Transmit Data

uS
Abbreviation for microsecond or one ten thousandth of a second or 0.0001 seconds.

USB
Universal Serial Bus (USB) is a serial bus standard to connect devices to a computer. Other
convenient features include providing power to low-consumption devices, eliminating the
need for an external power supply; and allowing many devices to be used without requiring
manufacturer-specific device drivers to be installed.

Vacuum
Vacuum is measured in units of pressure. In automotive technology, vacuum is often
measured using inches of mercury on the barometric scale or as a percentage of atmospheric
pressure in bars or atmospheres. Low vacuum is often measured in inches of mercury (inHg)
below atmospheric pressure. "Below atmospheric" means that the absolute pressure is equal to
the current atmospheric pressure (e.g. 29.92 inHg) minus the vacuum pressure in the same
units. Thus a vacuum of 26 inHg is equivalent to an absolute pressure of 4 inHg (29.92 inHg -
26 inHg).  The reciprocating motion of the pistons in an internal combustion engine create a
vacuum in the manifold.  

Volumetric Efficiency
The intake system on a spark ignited engine, restricts the amount of air that an engine of a
given displacement can flow. The parameter used to measure the effectiveness of an engine's
induction process is the volumetric efficiency. It is defined as the volume flow rate of air into
the intake system divided by the rate at which volume is displaced by the piston.

Wasted Spark
A wasted spark is when in an ignition system in a four-stroke cycle internal combustion
engine spark plugs fire in pairs, on both the exhaust and compression strokes. The extra spark
on the exhaust stroke has no effect and is thus "wasted". This design is simpler than a
conventional ignition system, but the extra sparks reduce the lifespan of components (contact
breaker, spark plugs).

XY Plot
In data analysis, a plot of one variable versus another rather than time.
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3 Hardware and Wiring Installation

3.1 XT Plus Pinout

Connector 1

Pin Description Comments

1 Injector E See notes.  Connect to fifth injector to fire in order.

2 Injector F See notes.  Connect to sixth injector to fire in order.

3 Injector G See notes.  Connect to seventh injector to fire in order.

4 Injector D See notes.  Connect to fourth injector to fire in order.

5 Injector C See notes.  Connect to third injector to fire in order.

6 Injector B See notes.  Connect to second injector to fire in order.

7 Injector A See notes.  Connect to first injector to fire in order.

8 Valve 1 Boost control solenoid swtiched ground.  1.5A max current.

9 Fuel Pump
Switched ground. Connect to fuel pump RELAY primary
ground.  Do not connect directly to pump motor.  1.5A max
current.

10 Injector H See notes.  Connect to eighth injector to fire in order.

11 Nitrous 1
Nitrous Stage 1 - switched ground.  Connect to stage 1
solenoid RELAY primary ground.  Do not connect directly to
solenoid.  1.5A max current.

12 Lambda Heater
Narrow band oxygen sensor heater control.  Switched ground.
 3A  max current

13 VR Crank +
VR (mag) type crank position sensor input.  Significant edge
= falling.

14 Nitrous 3
Nitrous Stage 3 - switched ground.  Connect to stage 3
solenoid RELAY primary ground.  Do not connect directly to
solenoid.  1.5A max current.

15 Switch 2 Map Select

16 Not Used

17 Switched 12V in Key on 12 volts, ignition switch

18 GND Ground input

19 Nitrous enable Normally high.  Ground to activate.

20 RS232 RXD Data receive, PC to ECU

21 GND Ground input 

22 Clutch Switch Normally high.  Ground to activate.

23 Nitrous 2
Nitrous Stage 2 - switched ground.  Connect to stage 2
solenoid RELAY primary ground.  Do not connect directly to
solenoid.  1.5A max current.
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24 PWM IAC
Pulse width modified idle control solenoid output.  Switched
ground.

25 VR Cam +
VR (mag) type cam position sensor input.  Significant edge =
falling

26 GND Ground input

27 GND Ground input

28 Nitrous 4
Nitrous Stage 4 - switched ground.  Connect to stage 4
solenoid RELAY primary ground.  Do not connect directly to
solenoid.  1.5A max current.

29 Switch 1 Engine Kill.  Disables all injector outputs when active.

30 Oil Temp 0-5V analog sensor input.

31 Lambda 2 Wideband Oxygen Sensor Input

32 Data ECU Serial data output

33 RS232 TXD Data transmit, ECU to PC

34 Not Used

Connector 2

Pin Description Comments

1 GND Ground input

2 GND Ground input

3 Sync Hall effect cam position input.

4 Oil Pressure 0-5V analog sensor input

5 Lambda 1 Narrow band oxygen sensor input.

6 Not Used

7 IAC Coil 1B Stepper Motor Coil 1B

8 RS232 RXD Not used 

9 Crank Hall effect crank position input

10 GND Ground input

11 Mixture SW Not used

12 IAC Coil 2B Stepper Motor Coil 2B

13 IAC Coil 1A Stepper Motor Coil 1A

14 VREF 5 volt sensor reference

15 TPS 0-5V analog throttle position sensor input

16 Air Temp Variable resistance air temperature input

17 Coolant Temp Variable resistance coolant temperature input

18 RS232 TXD Not used

19 IAC Coil 2A Stepper Motor Coil 2A
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20 GND Ground input

21 Tach Out 0-12V square wave tach output

22 TXD Current Loop

23 Gear Position Boost Switch

24 Map Sensor 0-5V analog manifold pressure sensor input

25 Fuel Pressure 0-5V analog fuel pressure sensor input

26 Ignition Coil 1 See notes.  Direct drive ignition output.  No ignitor required.  

Notes
· All Injector drivers are high impedance outputs with 2 amp maximum drive current.
· Ignition output is open collector with 8 amp maximum drive current.
· All switch inputs are normally high and are active when pulled low (grounded).

3.2 XT Plus Wiring

The Pro Flo XT Plus kits are available in four different configurations depending on the
application firing order:

Edelbrock Part Number Application Firing Order
3660 GM (Non LS) 1-8-4-3-6-5-7-2
3661 GM LS Engine Series 1-8-7-2-6-5-4-3
3662 Ford 1-5-4-2-6-3-7-8
3663 Ford 1-3-7-2-6-5-4-8

WIRING INSTALLATION (KITS 3660, 3662, 3663)
The wiring harnesses are made up of two main pieces, an engine side and a chassis side.  The
engine side is meant to be installed in the engine side of the firewall and the chassis side is
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meant to be installed in the cabin side of the vehicle.  A round firewall bulkhead connector is
provided to mate the two halves.  The engine side harnesses are identical for each kit in the
table above.  The chassis side harnesses are unique and include the appropriate injector wiring
for each firing order.  Connect all other sensor/actuators according to each connectors
description.  See the EFI Sensors section in EFI Basics for more information on sensor
installation.  

Each connector and flying lead wire in the harness is labeled to aid installation.  Following is
a description of each labeled termination:

ECU1
34 pin main ECU connector.  Connect to corresponding ECU receptacle.  The two connectors
are unique.  They can't be connected to the wrong location.  

ECU2
26 pin main ECU connector.  Connect to corresponding ECU receptacle.  The two connectors
are unique.  They can't be connected to the wrong location.  

PC Comms
DB9 style (9 pin) PC communication terminal.  Connect to a PC using a serial extension cable
(not included).  This connection is required for communication to the ECU.

Pin 2 - PC TXD  (Red/Blue)
Pin 3 - PC RXD  (Wht/Brown)
Pin 5 - Comms Ground  (Black)

AUX (optional)
AMP CPC style round 9 pin connector.  Provides access to switch panel type interfaces.  A
mating connector with terminated pigtails is provided with the harness assembly.

Pin 1 - Nitrous Activation or Lap Beacon input (Red/Blk)
Pin 2 - Nitrous Arm (Yel/Vio)
Pin 3 - Injector Kill Switch (Red/Vio)
Pin 4 - Map Switch (Blue/Wht)
Pin 5 - Mixture Switch (Red/Yel)
Pin 6 - Boost Switch (White/Orange)
Pin 7 - Battery Ground (Black)
Pin 8 - Not Used
Pin 9 - Not Used

Key Power
Pink/Black flying lead - connect to a Key-On 12 volt source.  It must be hot in both START
and RUN positions.  

Fuel Pump Relay (optional)
Tan/White flying lead - can be used to activate a fuel pump relay.  This output is a switched
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ground.  Connect to the ground side of the relay coil primary.

Lambda (optional)
Interface connector for use with customer supplied wideband UEGO systems.

Pin A - Signal Ground.  Connect to UEGO controller low reference, signal ground or sensor
ground output.
Pin B - Lambda Signal.  Connect to UEGO controller signal output (0 - 5V)
Pin C - 12V Power.  Connect to UEGO 12V power input
Pin D - Power Ground.  Connect to UEGO power ground.

Firewall
Firewall bulkhead connector.  Use as firewall pass through.  Connect to mating engine side
firewall connector.

AUX (optional)
For use with firewall forward auxiliary functions.  A mating connector with terminated
pigtails is provided with the harness assembly.

Pin 1 - Nitrous Stage 3 output. Switched ground.  Connect to stage 3 nitrous solenoid relay
(primary coil ground).  Do not connect directly to solenoid.
Pin 2 - Nitrous Stage 2 output . Switched ground.  Connect to stage 2 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 3 - Nitrous Stage 1 output. Switched ground.  Connect to stage 1 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 4 - Nitrous Stage 4 output. Switched ground.  Connect to stage 4 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 5 - 12V battery power.  Can be used to power auxiliary devices such as relays.  Installer
responsible for adding appropriately sized fuses.
Pin 6 - PWM Boost.  Switched ground.  Connect to boost control solenoid (coil ground).
Pin 7 - Oil Pressure. 0 - 5V input to ECU.  Connect to analog output signal from oil pressure
transducer.
Pin 8 - Battery Negative.  
Pin 9 - +12V Switched.  Hot with ignition switch on.  Can be used to power auxiliary devices
such as relays.  Installer responsible for adding appropriately sized fuses.
Pin 10 - Sensor Ground.  Low reference for use with 0 - 5V sensors.  Connect to sensor
ground.
Pin 11 - VREF.  +5V reference voltage for use with 0 - 5V sensors.  Connect to sensor
reference voltage.
Pin 12 - Fuel Pressure.  0 - 5V input to ECU.  Connect to analog output signal from fuel
pressure transducer.
Pin 13 - Not used
Pin 14 - Not used

Starter B+
12 volt main power supply.  Edelbrock recommends installing a relay and fuse for the main
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power supply.  

Batt Ground
Battery Ground.  Connect to battery negative terminal.

Crank
Crank position interface connector.  Requires appropriate adapter harness.  Several options
are available.  

Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
Pin C - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin D - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.
Pin E - Hall Crank. Hall Effect type crank sensor input.
Pin F - Hall Sync.  Hall Effect type cam sensor input.
Pin G - Hall Return. Hall Effect sensor signal ground.
Pin H - + 12V Switched.  From + 12V switched input.

AIT
Air inlet temperature sensor connector.  Connect to GM style AIT sensor:

Edelbrock P/N 3578 or 3588
GM P/N 25036751 or equivalent.

A - AIT signal. (Tan)
B - AIT signal ground (Blk/Wht/Yel)

IAC
Idle air control connector.  Connect to GM style, 4 wire stepper motor IAC.

A - IAC Coil B Low Control, White/Blue
B - IAC Coil B High Control, White/Yellow
C - IAC Coil A Low Control, White/Red
D - IAC Coil A High Control, White/Violet

INJ A - F
Injector Outputs.  Cylinder ID depends on application.  See diagrams below.

Pin A - +12V Power (Orange)
Pin B - Injector Control

Cool Temp
Engine Coolant Temperature.  Connect to GM style ECT sensor.

Edelbrock P/N 3589
GM P/N 25036979
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TPS
Throttle Position Sensor.  Connect to GM style three wire TPS.

Edelbrock P/N 36018

Pin A - +5 Volt Reference (Grey)
Pin B - Signal (Dk Blue)
Pin C - Signal Ground (Blk/Wht/Yel)

MAP
Manifold Absolute Pressure Sensor.  Connect to GM style 3 wire MAP sensor.

Edelbrock P/N 36019, 1 bar
Delphi P/N 12569240, 1 bar
Delphi P/N 16235939, 2.5 bar
Delphi P/N 09373269, 3.3 bar

The following diagram shows the basic wiring installation.  The engine side harnesses are
identical regardless of the application.  The chassis harness determines the injector firing
order.  The injector connectors are labeled INJ A-F.  To install your harness, find your
application below and lay the harness on the engine with the injector connectors in the correct
locations according to your engines cylinder ID and firing order.
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WIRING INSTALLATION (KIT 3661)
The wiring harnesses are made up of two main pieces, an engine side and a chassis side.  The
engine side is meant to be installed in the engine side of the firewall and the chassis side is
meant to be installed in the cabin side of the vehicle.  A round firewall bulkhead connector is
provided to mate the two halves.   See the EFI Sensors section in EFI Basics for more
information on sensor installation.   

Each connector and flying lead wire in the harness is labeled to aid installation.  Following is
a description of each labeled termination:

ECU1
34 pin main ECU connector.  Connect to corresponding ECU receptacle.  The two connectors
are unique.  They can't be connected to the wrong location.  

ECU2
26 pin main ECU connector.  Connect to corresponding ECU receptacle.  The two connectors
are unique.  They can't be connected to the wrong location. 

IMU
Multi-Coil Driver.  Used to control 8 individual coils on GM LS engines.  

PC Comms
DB9 style (9 pin) PC communication terminal.  Connect to a PC using a serial extension cable
(not included).  This connection is required for communication to the ECU.

Pin 2 - PC TXD  (Red/Blue)
Pin 3 - PC RXD  (Wht/Brown)
Pin 5 - Comms Ground  (Black)

AUX (optional)
AMP CPC style round 9 pin connector.  Provides access to switch panel type interfaces.  A
mating connector with terminated pigtails is provided with the harness assembly.

Pin 1 - Nitrous Activation or Lap Beacon input (Red/Blk)
Pin 2 - Nitrous Arm (Yel/Vio)
Pin 3 - Injector Kill Switch (Red/Vio)
Pin 4 - Map Switch (Blue/Wht)
Pin 5 - Mixture Switch (Red/Yel)
Pin 6 - Boost Switch (White/Orange)
Pin 7 - Battery Ground (Black)
Pin 8 - Not used
Pin 9 - Not used

+12V SW
Pink/Black flying lead - connect to a Key-On 12 volt source.  It must be hot in both START
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and RUN positions. 

TACH (optional)
Tachometer driver output. 12 volt square wave signal.    

Relay 
Main Relay.  Mount away from engine heat and moisture sources.

20A FUSE
20 amp fuse.  Protects power supplied through main relay to injectors, coils and auxiliary
loads.  Mount away from engine heat and moisture sources.

3A FUSE
3 amp fuse.  Protects switched 12 volt power (PNK/BLK wire).  Mount away from engine
heat and moisture sources.

Lambda (optional)
Interface connector for use with customer supplied wideband UEGO systems.

Pin A - Signal Ground.  Connect to UEGO controller low reference, signal ground or sensor
ground output.
Pin B - Lambda Signal.  Connect to UEGO controller signal output (0 - 5V)
Pin C - 12V Power.  Connect to UEGO 12V power input
Pin D - Power Ground.  Connect to UEGO power ground.

Firewall
Firewall bulkhead connector.  Use as firewall pass through.  Connect to mating engine side
firewall connector.

AUX (optional)
For use with firewall forward auxiliary functions.  A mating connector with terminated
pigtails is provided with the harness assembly.

Pin 1 - Nitrous Stage 3 output. Switched ground.  Connect to stage 3 nitrous solenoid relay
(primary coil ground).  Do not connect directly to nitrous solenoid.
Pin 2 - Nitrous Stage 2 output . Switched ground.  Connect to stage 2 nitrous solenoid relay
(primary coil ground).  Do not connect directly to nitrous solenoid.
Pin 3 - Nitrous Stage 1 output. Switched ground.  Connect to stage 1 nitrous solenoid relay
(primary coil ground).  Do not connect directly to nitrous solenoid.
Pin 4 - Nitrous Stage 4 output. Switched ground.  Connect to stage 4 nitrous solenoid relay
(primary coil ground).  Do not connect directly to nitrous solenoid.
Pin 5 - 12V battery power.  Can be used to power auxiliary devices such as relays.  Installer
responsible for adding appropriately sized fuses.
Pin 6 - PWM Boost.  Switched ground.  Connect to boost control solenoid (coil ground).
Pin 7 - Oil Pressure. 0 - 5V input to ECU.  Connect to analog output signal from oil pressure
transducer.
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Pin 8 - Battery Negative.  
Pin 9 - +12V Switched.  Hot with ignition switch on.  Can be used to power auxiliary devices
such as relays.  Installer responsible for adding appropriately sized fuses.
Pin 10 - Sensor Ground.  Low reference for use with 0 - 5V sensors.  Connect to sensor
ground.
Pin 11 - VREF.  +5V reference voltage for use with 0 - 5V sensors.  Connect to sensor
reference voltage.
Pin 12 - Fuel Pressure.  0 - 5V input to ECU.  Connect to analog output signal from fuel
pressure transducer.
Pin 13 - Not used
Pin 14 - Not used

Starter +12V
12 volt main power supply.  Typically connected to starter solenoid feed line (battery power).

Batt GND
Battery Ground.  Connect to clean battery ground reference (typically back of cylinder head).  

Crank
Crank position sensor connector.  Compatible with OEM sensor.  Connect to crank sensor
located passenger side rear of engine near starter motor.

Cam
Cam position sensor connector.  Compatible with OEM sensor.  Connect to cam sensor
located center rear of lifter valley cover area.  

Air Temp
Air inlet temperature sensor connector.  Connect to GM style AIT sensor:

Edelbrock P/N 3578 or 3588
GM P/N 25036751 or equivalent.

A - AIT signal. (Tan)
B - AIT signal ground (Blk/Wht/Yel)

IAC
Idle air control connector.  Connect to GM style, 4 wire stepper motor IAC.

A - IAC Coil B Low Control, White/Blue
B - IAC Coil B High Control, White/Yellow
C - IAC Coil A Low Control, White/Red
D - IAC Coil A High Control, White/Violet

INJ# 1 - 8
Injector Outputs.  
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Pin A - +12V Power (Orange)
Pin B - Injector Control

Cool Temp
Engine Coolant Temperature.  Connect to GM style ECT sensor.

Edelbrock P/N 3589 or equivalent
Delphi P/N 15326388

TPS
Throttle Position Sensor.  Connect to GM style three wire TPS.

Edelbrock P/N 36018

Pin A - +5 Volt Reference (Grey)
Pin B - Signal (Dk Blue)
Pin C - Signal Ground (Blk/Wht/Yel)

MAP
Manifold Absolute Pressure Sensor.  Connect to GM style 3 wire MAP sensor.

Edelbrock P/N 36019, 1 bar
Delphi P/N 12569240, 1 bar
Delphi P/N 16235939, 2.5 bar
Delphi P/N 09373269, 3.3 bar

B1 Coil
Driver side ignition interface.  Connect to GM factory coil harness.

B2 Coil
Passenger side ignition interface.  Connect to GM factory coil harness.

Fuel Pump (optional)
Optional fuel pump output control.  

Pin A - Pump negative (heavy black)
Pin B - Pump positive (heavy orange)

The following diagram shows the basic wiring installation.  The injector connectors are
labeled INJ# 1-8.  To install your harness, lay the harness on the engine with the injector
connectors in the correct locations according to the cylinder ID.  Connect all other sensor/
actuators according to each connectors description.
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3.3 XT Plus Crank Position Wiring

CRANK POSITION ADAPTER  INSTALLATION 

Not used on Pro Flo XT Plus applications for GM LS series engines.

The Pro Flo XT Plus system is compatible with several different crank and cam sensor input
configurations.  The main engine harness has a connector that mates with available adapter
harnesses.  The adapter harnesses route the crank and cam inputs to the appropriate pins.  The
diagrams below list the connection requirements for each adapter harness:
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37-3587 HALL CRANK POSITION
Adapts a 3 wire hall effect sensor output to the Pro Flo XT Plus ECU.  For use with
Edelbrock Pro Flo, Pro Flo XT and Pro Flo2 compatible distributors only.  Pinouts and
descriptions listed below.  

CRANK POS
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
Pin C - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin D - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.
Pin E - Hall Crank. Hall Effect type crank sensor input.
Pin F - Hall Sync.  Hall Effect type cam sensor input.
Pin G - Hall Return. Hall Effect sensor signal ground.
Pin H - + 12V Switched.  From + 12V switched input.

DISTRIBUTOR
3 pin Weather-Pack tower.  Mates with Weather-Pack shroud Delphi P/N 12010717
Pin A - Hall Return. Hall Effect sensor signal ground.
Pin B - Hall Crank. Hall Effect type crank sensor input.
Pin C - + 12V Switched.  From + 12V switched input.



Hardware and Wiring Installation 65

37-3589 HALL CRANK AND CAM POSITION
Adapts a 3 wire hall effect crank and cam sensor output to the Pro Flo XT Plus ECU such as
Accel DFI dual sync distributor model # 77190 or equivalent.  Confirm crank and cam sensor
connector pinout before installing.  De-pin and re-configure adapter harness as necessary.  See
Weather-Pack tools below.  

CRANK POS
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
Pin C - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin D - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.
Pin E - Hall Crank. Hall Effect type crank sensor input.
Pin F - Hall Sync.  Hall Effect type cam sensor input.
Pin G - Hall Return. Hall Effect sensor signal ground.
Pin H - + 12V Switched.  From + 12V switched input.

CRANK
3 pin Weather-Pack tower.  Mates with Weather-Pack shroud Delphi P/N 12010717
Pin A - Hall Return. Hall Effect sensor signal ground.
Pin B - Hall Crank. Hall Effect type crank sensor input.
Pin C - + 12V Switched.  From + 12V switched input.

CAM
3 pin Weather-Pack shroud.  Mates with Weather-Pack tower Delphi P/N 12015793
Pin A - Hall Return. Hall Effect sensor signal ground.
Pin B - Hall Sync. Hall Effect type cam sensor input.
Pin C - + 12V Switched.  From + 12V switched input.
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37-3588 VR CRANK AND CAM POSITION
Adapts a 2 wire VR crank and cam sensor output to the Pro Flo XT Plus ECU such as MSD
Crank Trigger Kit:

MSD P/N 8600, Chevy Small Block 6" balancer 

De-pin and re-configure adapter harness as necessary.  See Weather-Pack tools below.   

CRANK POS
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
Pin C - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin D - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.
Pin E - Hall Crank. Hall Effect type crank sensor input.
Pin F - Hall Sync.  Hall Effect type cam sensor input.
Pin G - Hall Return. Hall Effect sensor signal ground.
Pin H - + 12V Switched.  From + 12V switched input.

CRANK
2 pin Weather-Pack tower.  Mates with Weather-Pack shroud Delphi P/N 12010973
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
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CAM
2 pin Weather-Pack shroud.  Mates with Weather-Pack tower Delphi P/N 12015792
Pin A - Hall Return. Hall Effect sensor signal ground.
Pin B - Hall Sync. Hall Effect type cam sensor input.
Pin C - + 12V Switched.  From + 12V switched input.

SHIELD GROUND
Protective shield ground for VR type inputs.  Connect to clean ground.

37-3600 VR CRANK AND HALL CAM POSITION
Adapts a 2 wire VR crank and 3 wire hall cam sensor output to the Pro Flo XT Plus ECU. 
Can be used with Edelbrock Pro Tuner compatible distributors:

Edelbrock P/N 3615 - Small and Big Block Chevy V8 Large Cap
Edelbrock P/N xxxx - Small Block Ford V8
Edelbrock P/N xxxx - Pontiac 326 - 455 V8 

De-pin and re-configure adapter harness as necessary.  See Weather-Pack tools below

CRANK POS
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.
Pin C - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin D - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.
Pin E - Hall Crank. Hall Effect type crank sensor input.
Pin F - Hall Sync.  Hall Effect type cam sensor input.
Pin G - Hall Return. Hall Effect sensor signal ground.
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Pin H - + 12V Switched.  From + 12V switched input.

CRANK
2 pin Weather-Pack tower.  Mates with Weather-Pack shroud Delphi P/N 12010973
Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.

CAM
3 pin Weather-Pack tower.  Mates with Weather-Pack shroud Delphi P/N 12010717
Pin A - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.

SHIELD GROUND
Protective shield ground for VR type inputs.  Connect to clean ground.
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3.4 XTR Pinout

Connector pin assignment and functions.

Pin Description Comments

1 Ignition 1
See notes.  Connect to coil (-), CDI points trigger input or
first ignition to fire in order (custom firmware only)

2 Ignition 2 See notes.  Custom firmware only.  Connect to second ignition
to fire in order.

3 Ignition 3 See notes.  Custom firmware only.  Connect to third ignition to
fire in order.

4 Injector 1 See notes.  Connect to first injector to fire in order.

5 Injector 2 See notes.  Connect to second injector to fire in order.

6 Injector 3 See notes.  Connect to third injector to fire in order.

7 Injector 4 See notes.  Connect to fourth injector to fire in order.

8 Fuel Pump
Switched ground.  8 amps max.  Connect to fuel pump
relay primary coil negative.

9 Lambda Heater
8 amps max.  Can be used to supply ground to wideband
controller.

10 Valve 1 Boost control solenoid switched ground.  10 amps max.

11 Not Used

12 Throttle Position 0-5 volt analog throttle position sensor input.

13 Airbox Pressure 0-5 volt analog manifold pressure sensor input.

14 Exhaust Pressure 0-5 volt analog exhaust (or aux) pressure sensor input.

15 Fuel Pressure 0-5 volt analog fuel pressure sensor input

16 Oil Pressure 0-5 volt analog oil pressure sensor input.

17 Tach Output 12 volt rising edge square wave.

18 Injector 5 See notes.  Connect to fifth injector to fire in order.

19 Injector 6 See notes.  Connect to sixth injector to fire in order.

20 Injector 7 See notes.  Connect to seventh injector to fire in order.

21 Injector 8 See notes.  Connect to eighth injector to fire in order.

22 Not Used

23 Not Used

24 Not Used

25 Not Used

26 ECU 12v Key on 12 volts, ignition switch
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27 Lambda 1 Wideband oxygen sensor input

28 Not Used

29 Not Used

30 Not Used

31 Not Used

32 Lambda 2 Wideband oxygen sensor input

33 Not Used

34 Not Used

35 Not Used

36 Not Used

37 Ignition 4 See notes.  Custom firmware only.  Connect to fourth ignition to
fire in order.

38 Not Used

39 Not Used

40 Not Used

41 Not Used

42 Not Used

43 Not Used

44 Fuel Temperature Variable resistance fuel temperature input.

45 Air Temperature Variable resistance air temperature input.

46 Water Temperature Variable resistance water temperature input.

47 Oil Temperature Variable resistance oil temperature input.

48 Crank Pickup
VR (mag) type crank position sensor input.  Significant
edge = falling.

49 Sync Pickup
VR (mag) type cam position sensor input.  Significant
edge = falling.

50 Frontwheel
VR (mag) type front wheel speed sensor input. 
Significant edge = falling.

51 Rearwheel
VR (mag) type rear wheel speed sensor input.  Significant
edge = falling

52 Mixture Switch
Software controlled multi-position fuel trim.  Must use
EFI Technology Inc. switch P/N 62-605.  

53 Boost Switch
Rotary switch input used to select one of 5 different boost
control curves.

54 STP 1
Nitrous Stage 1 - switched ground.  Connect to stage 1
solenoid RELAY primary ground.  Do not connect
directly to solenoid.  1.5A max current.

55 STP 2
Nitrous Stage 2 - switched ground.  Connect to stage 2
solenoid RELAY primary ground.  Do not connect
directly to solenoid.  1.5A max current.
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56 STP 3
Nitrous Stage 3 - switched ground.  Connect to stage 3
solenoid RELAY primary ground.  Do not connect
directly to solenoid.  1.5A max current.

57 STP 4
Nitrous Stage 4 - switched ground.  Connect to stage 4
solenoid RELAY primary ground.  Do not connect
directly to solenoid.  1.5A max current.

58 Knock 1 Option for Pedal position

59 Cooling Fan
Switched ground 2.5 amps max.  Connect to cooling fan
relay primary coil ground.

60 Shift Lamp
Switched ground 2.5 amps max.  Connect to shift lamp
ground.

61 RXD Expansion Box

62 TXD Output Dash driver or 3rd party ECU link

63 Switch 1
ECU kill switch.  Ground = ON.  Disables all fuel
injectors.

64 Switch 2
Map select switch.  Ground = ON.  Selects map position 1
or 2

65 Shift Cut Input

66
Pit Limiter switch
(nitrous enable)

Nitrous - Enable switch. Ground = ON

67 Beacon (nitrous clutch) Nitrous - Clutch switch.  Ground = ON

68 Not Used

69 Not Used

70 VREF 5V sensor reference.  200mA max.

71 VREF 5V sensor reference.  200mA max.

72 GND Sensor ground

73 GND Sensor ground

74 GND Sensor ground

75 GND Sensor ground

76 GND Sensor ground

77 PWR GND Connect to Battery Negative

78 PWR GND Connect to Battery Negative

79 PWR GND Connect to Battery Negative

Notes
· Mating connector Part No. is MS27473 20-35S.
· All Injector drivers are peak and hold outputs with 8 amp maximum driver current.
· All Ignition outputs are open collector with 10 amp maximum drive current.
· All switch inputs are normally high and are active when pulled low.
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3.5 XTR Wiring

Below is a wiring diagram for the optional Edelbrock XTR Engine Harness.  It can be used
for troubleshooting or for help in hooking up auxiliary inputs and / or outputs.  See detailed
descriptions below for each connector.
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WIRING HARNESS INSTALLATION
Each connector and flying lead wire in the harness is labeled to aid installation.  Following is
a description of each labeled termination:

ECU
79 pin main ECU connector.  Connect to corresponding ECU receptacle.  

PC Comms Extension Cable
DB9 style (9 pin) PC serial communication terminal.  Connect to the ECU using included
serial extension cable.  This connection is required for communication to the ECU.  The serial
output connector is a small black round connector located on the ECU enclosure opposite the
main 79 pin connector.

AUX 1(optional)
Delphi GT 150 style round 14 pin connector.  For use with firewall forward auxiliary
functions.  A mating connector with terminated pigtails is provided with the harness
assembly.

Pin 1 - Nitrous Stage 3 output. Switched ground.  Connect to stage 3 nitrous solenoid relay
(primary coil ground).  Do not connect directly to solenoid.
Pin 2 - Nitrous Stage 2 output . Switched ground.  Connect to stage 2 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 3 - Nitrous Stage 1 output. Switched ground.  Connect to stage 1 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 4 - Nitrous Stage 4 output. Switched ground.  Connect to stage 4 nitrous solenoid relay
(primary coil ground). Do not connect directly to solenoid
Pin 5 - Fuel Temperature
Pin 6 - PWM Boost.  Switched ground.  Connect to boost control solenoid (coil ground).
Pin 7 - Oil Pressure. 0 - 5V input to ECU.  Connect to analog output signal from oil pressure
transducer.
Pin 8 - Relay Power.  Hot with ignition switch on.  Can be used to power auxiliary devices
such as relays.  Installer responsible for adding appropriately sized fuses.
Pin 9 - Exhaust Pressure. 0 - 5V pressure sensor input to ECU.  Connect to analog output
signal from pressure transducer.
Pin 10 - Sensor Ground.  Low reference for use with 0 - 5V sensors.  Connect to sensor
ground.
Pin 11 - VREF.  +5V reference voltage for use with 0 - 5V sensors.  Connect to sensor
reference voltage.
Pin 12 - Fuel Pressure.  0 - 5V input to ECU.  Connect to analog output signal from fuel
pressure transducer.
Pin 13 - Cooling Fan. 2.5 amps max switched ground.  Must use relay to control fan motor.  
Do not connect directly to fan motor.
Pin 14 - Oil Temperature

AUX 2 (optional)
Delphi GT 150 style 14 pin connector.  Provides access to switch panel type interfaces.  A
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mating connector with terminated pigtails is provided with the harness assembly.

Pin 1 - Nitrous Activation or Lap Beacon input - Ground to activate. 
Pin 2 - Nitrous Arm - Ground to activate. 
Pin 3 - Injector Kill Switch - Disables all fuel control outputs.  Ground to activate. 
Pin 4 - Map Switch - Switches to secondary calibration file.  Ground to activate
Pin 5 - Mixture Switch - Software controlled multi-position fuel trim.  Must use EFI
Technology Inc. switch P/N 62-605.  
Pin 6 - Boost Switch - Rotary switch input used to select one of 5 different boost control
curves.
Pin 7 - Battery Ground 
Pin 8 - TXD Output - ECU Data Stream.  Output to 3rd party dash or logger system.
Pin 9 - Shift Lamp - 2.5 amps max switched ground
Pin 10 - Tach - 12 volt square wave rising edge trigger
Pin 11 - Lambda 1 
Pin 12 - Lambda 2 
Pin 13 - Heater - 8 amps max switched ground.  Can be used to enable wideband controller. 
Pin 14 - Relay Power - Hot with ignition switch on.  Can be used to power auxiliary devices
such as relays.  Installer responsible for adding appropriately sized fuses.

12V SW
Pink/Black flying lead - connect to a Key-On 12 volt source.  It must be hot in both START
and RUN positions.  

BATT (+)
12 volt main power supply.  Connect to battery or main 12 volt power bus.

BATT (-)
Battery Ground.  Connect to battery negative terminal.

Crank
Crank position interface connector.  Mating connector and terminals included  

Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.

Cam
Pin A - VR Cam + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Cam - input.  (-) Signal from variable reluctance (mag) sensor.

AIT
Air inlet temperature sensor connector.  Connect to GM style AIT sensor:

Edelbrock P/N 3578 or 3588
GM P/N 25036751 or equivalent.



Power to Win76

A - AIT signal. (Tan)
B - AIT signal ground (Blk/Wht/Yel)

INJ A - F
Injector Outputs.  Cylinder ID depends on application.  

Pin A - +12V Power (Orange)
Pin B - Injector control switched ground from ECU

CLT
Engine Coolant Temperature.  Connect to GM style ECT sensor.

Edelbrock P/N 3589
GM P/N 25036979

TPS
Throttle Position Sensor.  Connect to GM style three wire TPS.

Edelbrock P/N 36018

Pin A - +5 Volt Reference (Grey)
Pin B - Signal (Dk Blue)
Pin C - Signal Ground (Blk/Wht/Yel)

MAP
Manifold Absolute Pressure Sensor.  Connect to GM style 3 wire MAP sensor.

Edelbrock P/N 36019, 1 bar
Delphi P/N 12569240, 1 bar
Delphi P/N 16235939, 2.5 bar
Delphi P/N 09373269, 3.3 bar

IGN
Flying leads.  Ignition output to coil or ignition box (CDI).  Rising edge fire.

White wire - Ignition trigger.  Connect to coil (-) terminal or CDI points trigger.
Orange wire - Relay power, hot with key switch on.  Connect to coil (+) terminal or CDI
switched power input.  Do not connect to coil (+) terminal if using a CDI type ignition.

FWHEEL
Front wheel speed interface connector.  Mating connector and terminals included  

Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.

RWHEEL
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Rear wheel speed interface connector.  Mating connector and terminals included  

Pin A - VR Crank + input.  (+) Signal from variable reluctance (mag) sensor.
Pin B - VR Crank - input.  (-) Signal from variable reluctance (mag) sensor.

The following diagram shows the basic wiring installation using the optional Edelbrock XTR
Engine Harness.  The injector connectors are labeled INJ A-F.  The INJ A connector is
intended for the driver's side front most cylinder.  The INJ E connector is intended for the
passenger side front most cylinder.  The injector firing order is determined by the engine
harness injector circuit pinout.  Contact Edelbrock EFI Tech department for more
information. 
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3.6 Mating Connectors

WEATHER-PACK MATING CONNECTORS:
Below is a list of each mating Delphi Weather-Pack connector.

       Delphi 12010973 Delphi 12015792

       Delphi 12010717 Delphi 12015793

WEATHER-PACK TERMINALS:

Male Terminals Female Terminals
Delphi 12089040 (20 - 18 AWG) Delphi 12089188 (20 - 18 AWG)
Delphi 12089307 (24 - 22 AWG) Delphi 12020801 (24 - 22 AWG)
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WEATHER-PACK SEALS:

Delphi 12015323, Green (20 - 16 AWG)
Delphi 12089679, Purple (20 AWG)
Delphi 15324983, Red (22 AWG)

WEATHER-PACK PIN REMOVAL TOOL:

Delphi/Packard 12014012
SPX Kent Moore J-38125-10A
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4 System Editor Software

This section covers using the System Editor and introduces the basic concepts of creating and
editing engine maps providing a foundation for users new to Power to Win. Additional topics
such as engine monitoring, diagnostics and ECU programming are also covered in this
chapter.

The System Editor is tool for managing all of your engine maps, calibrations and setups. It
features a file folder window to facilitate easy loading and viewing of your files and their
associated Function Groups.

Engine calibration data can be displayed and edited in either graphic or numeric formats. Any
combination of maps can be displayed simultaneously in their own windows and moved or
resized for optimal viewing. In addition any of the 3 dimensional maps can be rotated or tilted
to change the perspective of the graph.

The System Editor simplifies the management of engine maps by organizing associated
features into sections called Function Groups. Each group contains the various Maps, Tables
and Constants that define how each engine control function operates.

If your system was configured with logging memory the setup of the internal data logger is
also done within the System Editor. The number of channels, sample rates and calibrations
can all be defined along with settings for the System Alarms.

Notes
· If you are using Power to Win for the first time be sure to read the section on Initial

Setup which will guide you through the fundamental steps necessary to setup and
configure your system.

4.1 Software File Types and Descriptions

Name Where Comments

Analysis.exe C:\Power to Win logger data analysis application

Config.exe C:\Power to Win logger configuration application

Usbcoms.exe C:\Power to Win logger communication application

mTelem.exe C:\Power to Win realtime telemetry application

nEditor.exe C:\Power to Win engine control system application

Telemsrv2.
exe

C:\Power to Win telemetry network server

Telemadapt.
dll

C:\Power to Win telemetry network adapter library

EFiLink.dll C:\Power to Win iLink data communication library
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Settings.usb C:\Power to Win default usb screen setup file

-

*.stp C:\Power to Win\Libs exported logger setup files

*.lib C:\Power to Win\Libs user defined setup library files

-

Control.def C:\Power to Win\Maps engine map definition file

Sample.tab C:\Power to Win\Maps sample engine map

-

Obmath.def C:\Power to Win\Math onboard math definition file

Obconst.def C:\Power to Win\Math onboard constant definition file

-

*.rpt C:\Power to Win\Reports user defined data analysis report files

-

Sample.dat C:\Power to Win\Sample sample logger data file

-

Channel.def C:\Power to Win\Setup logger channel definition file

@LCU1.cal C:\Power to Win\Setup logger car(1) setup file

ECU.cal C:\Power to Win\Setup ecu logger channel calibrations

001.mdf C:\Power to Win\Setup comms control screen setup file

Mathchl.def C:\Power to Win\Setup logger math channel definition file

Constant.def C:\Power to Win\Setup logger math constant definition file

*.qmt C:\Power to Win\Setup user defined qualifying mode file

Telem.def C:\Power to Win\Setup telemetry channel definition file

001.tlm.def C:\Power to Win\Setup telemetry screen setup file

-

Sample.map C:\Power to Win\Track sample logger track map file
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4.2 Software System Requirements

The system requirements for Power to Win are as follows:
· Pentium personal computer or laptop with 1GHz or higher processor.
· Microsoft Windows 98 or higher operating system.
· 256 MB of RAM (512 MB recommended) for Windows XP.
Hard disk space required for installation:
· Power to Win (50 MB Typical, 94 MB Maximum)
Additional system requirements:
· CD-ROM drive.
· VGA or higher-resolution monitor (Super VGA recommended).
· Microsoft Mouse or compatible pointing device.
· Serial communications port.
· Universal Serial Bus (USB port).
· High speed internet access (for iLink users).

4.3 Initial Setup

If you are using Power to Win for the first time the following information will guide you
through the fundamental steps necessary to setup and configure your system.

1. Register your ECU's. To specify download paths for your logger data you must first
register the serial numbers for each of your ECU's.

2. If your system was shipped with the internal memory option you should follow this link
to help you Setup the Data Logger.

3. This section helps you setup your System Alarms to help troubleshoot any potential
problems when running your engine for the first time.

4. For help on defining System Units, Setting up Digital channels and general calibration
information refer to the topic System Calibrations.

5. This section describes the procedure for choosing the appropriate firmware file.
6. Refer to the Calibration Loading procedure for help choosing a startup calibration.

4.4 File Menu

Summary
The System Editor file menu includes standard file related function as well as setup options
for PC to ECU communications, data related tasks, user login, password and printing features.
 Menu items include:

· Add/Replace File
· Save File
· Work Offline
· Synchronize
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· Register ECU's
· Importing Data
· Options
· Port Settings
· User Login
· Set Password
· Printing a Map

4.4.1 Add/Replace File

Use this function to open an engine map in the System Editor. The map will be added to file
folder window and each of the function groups will be displayed.

1. On the File menu, click Replace File.
2. Select the drive and folder where the engine map is located.
3. Click on the engine map to read the file details and comments.
4. Double-click the engine map or click OK to open it.

Notes
· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Add File menu to add additional engine maps to the File Folder.
· Only engine map files of the type (*.TAB) can be read by the System Editor.
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4.4.2 Save File

Use this function to save changes to your engine map after editing.
1. On the File menu, click Save File As.
2. Select the drive and folder where you want to save your engine map.
3. In the File name box, type a name for the map.
4. Click Save.

Notes
· If the map name already exists you will see a prompt to confirm overwrite.
· You can also use Save File, to save using the existing name.

4.4.3 Work Offline

When this menu is selected changes will only be made to the current map loaded in the Editor
and no changes will be made to the ECU.

1. On the File menu, click Work Offline.
2. The feature is now enabled.
3. Click on the menu again to disable this feature.
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Notes
· Work Offline must be selected to allow more than one map to be loaded into the File

Folder.

4.4.4 Synchronize

Use this function to extract the map in the ECU and replace the one currently loaded in the
Editor.

1. On the File menu, click Synchronize.
2. The map in the ECU will be extracted.
3. The current map in the Editor will be replaced.
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The synchronize function always checks if a copy of the map in the ECU already exists on
disk. If the map on disk is not an exact match you will be prompted to choose from the
following options.

· Overwrite the existing map on disk.
· Save the map under a new name.
· Continue working but set Offline.
· Overwrite and load new map into ECU.

Notes
· The ECU must be on line to use this function.

4.4.5 Register ECU's

ECU logger data when downloaded is automatically saved to a user defined location on disk.
To specify download paths for your logger data you must first register the serial numbers for
each of your ECU's. The serial number can be found stamped on the housing of the ECU and
also appears on the status bar of Comms when connected

1. On the File menu, click Register ECU's.
2. Enter the ECU serial number and logger download path.
3. You can browse for a path by clicking the [...] button.
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Select the new path or enter the name in the path text box. If the download path does not
exist you will be prompted to have it created for you.

4. Repeat step 2 for additional ECU's.
5. Click OK to save changes.

Notes
· Unused serial number fields should be be set to zero.
· Data downloaded from an unregistered ECU will default to position one.

4.4.6 Importing Data

Exported binary engine rpm and throttle position logger data can be imported by the System
Editor and overlayed on a fuel or spark map. This feature highlites the percentage of time
spent at each of the breakpoints of the engine map thus identifying the map areas that are most
critical to performance.

1. On the File menu, click Import Data.
2. Select the drive and folder where the data is located.
3. Double-click the data file or click Open.



System Editor Software 89

Notes
· Only exported binary logger files of the type (*.BIN) can be used with the System

Editor.
· To show the imported data on a fuel or spark map the Overlay On menu must be

checked.

4.4.7 Options

The various option checkboxes on this window allow you to customize your version of the
System Editor.

Miscellaneous

Always Synchronize Maps
When connecting to the ECU the current map will always be extracted from the ECU and
then loaded into the Editor.

Lock comms controls
Use this option to lock the controls in their current positions and prevent accidental
movement.

Grids
Each of the map displays have vertical and horizontal axis grid lines. Click on these check
boxes to enable/disable this feature.

Hide Status Bar
This option hides the main status bar on the MDI form thus increasing the available screen
area.
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Mapping

Copy Cell Right
When using the "F11" key to update the current cell during mapping this option will copy the
value from the current cell to the next cell to the right.

Copy Count
Defines the total number of cells copied if the "Copy Cell Right" option is selected.

Copy Cell Up
When using the "F11" key to update the current cell during mapping this option will copy the
value from the current cell with a 5% increase, to the next cell up.
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4.4.8 Port Settings

Use this window to change the serial port settings.
1. On the File menu, click Port Settings.
2. Select the serial port number.
3. Check the number of stop bits.
4. Select the parity setting.
5. Click OK to save changes.

Notes
· The baud rate cannot be changed and is fixed at 115200 bps.
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4.4.9 User Login

Certain features of Power to Win are password protected. This window is used when
Edelbrock personnel need to login and activate these features.

1. On the File menu, click User Login.
2. From the drop-down list select your user name.
3. In the Password box, type in your password.
4. Click OK.

Notes
· You can click on the Logout button to return to the default Login.

4.4.10 Set Password

This window is used if you want to password protect your engine maps. Once activated you
will not be able to view or edit your map without the correct password.

1. On the File menu, click Set Password.
2. In the Password box, type in your password.
3. In the Verification box, re-enter your password.
4. Click OK.

Notes
· Once an engine map is password protected it can't be unprotected by entering nulls for

both the entry fields.
· BE VERY CAREFUL WITH THIS OPTION.  IF THE PASSWORD IS LOST,

THE MAP CANNOT BE VIEWED.  IT IS COMPLETELY LOCKED DOWN.



System Editor Software 93

4.4.11 Printing a Map

Use this feature to print out numeric tables and constants from your engine maps. Before
printing make sure that the map that you want to print is in the current window

1. On the File menu, click Print.
2. The active window will be sent to the printer.

Notes
· Use the Print Setup menu to configure your printer.
· Only numeric tables and constants can be printed.

4.5 Logger Menu

Summary
The System Editor logger menu includes items related to ECU data logger setup and data
download options.  Menu items include:

· Download Logger
· Stop Download
· Auto Download
· ECU Configuration
· Send Config
· Session Data
· Clear Fuel Counter
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4.5.1 Download Logger

If your ECU has been configured with an internal data logger you can use this function to
download any recorded data to disk. Once downloaded the data can be viewed with the 
Analysis software.

1. On the Logger menu, click Download Logger.
2. A progress bar will display during the download routine.
3. After the download is complete the setup is automatically re-loaded.

Notes
· You cannot download the internal logger while it is still recording data.
· See the section on Register ECU's in System Editor for information on specifying

download paths for your logger data.

4.5.2 Stop Download

Once the download routine has started you can interrupt the process using this function.
1. On the Logger menu, click Stop Download.
2. A dialog box will appear with options on resetting the logger.

Notes
· Press Yes to reset the logger and exit. Any recorded data will be lost.
· Press No to exit without resetting. Any further logging will continue from where it last
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stopped.
· Press Cancel to continue downloading.

4.5.3 Auto Download

When this feature is enabled the logger will automatically start the download process when a
valid connection to a computer is detected.

1. On the Logger menu, click Auto Download.
2. The auto download feature is now enabled.
3. Click on the menu again to disable this feature.

Notes
· You cannot download the internal logger while it is still recording data.
· See the section on Register ECU's in Editor for information on specifying download

paths for your logger data.

4.5.4 ECU Configuration

Use this function to display information about the ECU's current configuration.
1. On the ECU menu, click ECU Configuration.
2. The Configuration window will be displayed.

Information
· ECU type.
· Config loaded.
· Config version.
· Firmware checksum.
· Firmware release.
· ECU serial #.
· ECU clock.
· Installed memory.
· ECU resets.
· Map loaded.
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Notes
· Some of the configuration information will not be available if your ECU does not have

logging memory installed.

4.5.5 Send Config

Use this function to send a new configuration to the internal logger. The memory buffer will
be cleared and any existing data will be overwritten and lost.

1. On the Logger menu, click Send Config.
2. The current setup will be sent to the logger.



System Editor Software 97

Notes
· You cannot send a new setup to the logger while it is recording data.
· See the section on Internal Logger in System Editor for information on setting up your

logger.

4.5.6 Session Data

Use this function to change the session data for subsequent data sets. Setting these values
helps to identify specific data sets later on when using the Analysis module.

1. On the Logger menu, click Session Data.
2. The session data edit window will open.
3. Enter the Session, Outing, Out Lap and Pace Lap numbers.
4. Click Save to save changes.

Notes
· The lap counter will automatically increment after receiving a beacon signal.
· The outing counter increments after each data set is downloaded.
· Session data can also be edited after the logger has been downloaded to disk from within

the Analysis module.

4.5.7 Clear Fuel Counter

Use this function to reset to zero the ECU fuel counter.
1. On the Logger menu, click Clear Fuel Counter.
2. A dialog box to confirm your action will open.
3. Click OK to continue and clear the counter.
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Notes
· The ECU fuel counter can count up to a maximum of 655.35 Gals and then will rollover

and start back over from zero.
· If the ECU is connected to an external logger or dash it is recommended that its fuel

counter is also reset at this time.

4.6 Tools Menu

Summary
The System Editor tools menu includes workspace setup options, map extract and compare
features, calibration file comments and lambda table options.  Menu items include:

· Hide File Folder
· Extract Map
· Compare Map
· Edit Comments
· Read Lambda Table
· Clear Lambda Table
· Lambda Table
· Active Cursor

4.6.1 Hide File Folder

To maximize the viewing area for your maps you can use this option to hide the file folder
window.

1. On the Tools menu, click Hide File Folder.
2. The file folder will be hidden and the the menu will be checked.
3. Click on the menu again to restore the view.
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Notes
· You can also use the F5 hot key to perform this function.

4.6.2 Extract Map

Use this function to retrieve an engine map from the ECU. The current map will be uploaded
from the ECU and can then be saved to disk.

1. On the ECU menu, click Extract Map.
2. A progress bar will display during the upload routine.
3. Select the drive and folder where the map is to be saved.
4. Click Save to save to disk.

Notes
· Some ECU's have a provision for 2 maps. Use the map select switch to select which

location is to be uploaded.
· The status bar panel show the currently selected map position.
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4.6.3 Compare Map

Use this function to retrieve an engine map from the ECU and then compare it with a selected
map on disk. Any differences between the 2 maps will be displayed in a window.

1. On the ECU menu, click Compare Map.
2. A progress bar will display during the upload routine.
3. Select the drive and folder where the compare map is stored.
4. Double-click on the map name or click OK to select it.
5. Any differences will be displayed in the compare window.

Notes
· You can use the Another button to select a different map.
· Some ECU's have a provision for 2 maps. Use the map select switch to select which

location is to be uploaded.
· The status bar panel show the currently selected map position.

4.6.4 Edit Comments

Each of your engine maps can have text comments saved with the map. You can use this
feature to keep track of specific details or changes you want to save for each map.

1. On the Tools menu, click Edit Comments.
2. Click on the text box where you want to add/edit the comments.
3. Type in the information for the engine map.
4. Repeat step 2 for additional comments.
5. Click OK to save changes.
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Notes
· You can also double-click in the bottom pane of the file folder window to edit

comments.
· To permanently save the changes to the comments, the engine map must be saved to

disk. See the topic Saving a Map for further information.

4.6.5 Read Lambda Table

This function reads the lambda corrections table from the ECU. During closed loop operation
the ECU keeps track of the corrections applied to the map needed to reach the lambda target
values. This table can be downloaded, saved on disk and then viewed with the System Editor.

For further information about viewing, editing and applying the self learn table to an engine
map, read the section on Lambda Table in the System Editor.

1. On the Tools menu, click Read Lambda Table.
2. If any previous data exists you will be asked if its OK to overwrite.
3. A progress bar will display during the download routine.
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Notes
· The lambda correction data is saved on disk as "Lambda.Avg" and is stored in the

current map directory.
· Before using the lambda correction function for the first time make sure you clear the

lambda table to reset any previously saved data.

4.6.6 Clear Lambda Data

This function resets the lambda correction table in the ECU. Before using the lambda
correction function for the first time it is recommended that you clear the lambda table to reset
any previously saved data.

1. On the Tools menu, click Clear Lambda Data.
2. A progress bar will display during the upload routine.

Notes
· Using this function will erase any previously saved lambda correction data.

4.6.7 Lambda Table

If you have previously downloaded a lambda correction table from your ECU you can use this
option to view, edit and apply the data to your engine map.

1. On the Tools menu, click Open Lambda Table.
2. If a data file exists the lambda window will open.
3. Click and drag over a range of cells. You will see a popup menu of the available editing

functions. Each of these is described below.
4. Close the lambda table window to save the changes.
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Copy
Copies the currently selected range of cells to the clipboard.

Paste
Pastes the contents of the clipboard to the currently selected range of cells. If there is more
data than the number of cells selected only the highlighted cells will be changed.

Fill Range
Fills the currently selected range of cells with the number displayed in the correction value
field.

Apply Table
Applies each of the corrections from the selected region of the lambda table to the current
map.

Correction Limits
Sets the maximum and minimum correction values for the lambda table.

Notes
· The information in the lambda window can be printed using the Printing a Map

function.

4.6.8 Active Cursor

This option makes the edit cursor track the current breakpoint for your engine map. If
activated you will not be able to manually change the cursor position within the map.

1. On the Tools menu, click Active Cursor.
2. The data cursor will now automatically track the active cell of the current map.
3. Click on the menu again to disable this feature.
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Notes
· The ECU must be on-line for this feature to work.

4.7 Config Menu

Summary
The System Editor config menu includes data logger channel setup options, outing data
information, channel offset and scaling, units selections, injector data and system alarms setup
options.  Menu items include:

· Channel Setup
· Enable Conditions
· Outing Data
· ECU Channels
· System Units
· Injector Details
· System Alarms

 

4.7.1 Channel Setup

Use this function to setup the internal logger and set the sample rates for each of the channels
that you want to log.

1. On the Config menu, click Logging Table.
2. The available channels and current sample rates will be displayed.
3. Double-click on the channel you want to change the sample rate.
4. Pick a new sample rate from the available options window.
5. Click OK.

The ECU has a fixed amount of logging memory and has a maximum throughput of
samples which dictates the logging rates for channels. If you choose to log channels at a
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high rate you will reduce the total number of channels that you can log. If a channel does
not vary much during a lap, for example; temperatures, pressures then choose slower
logging rates.

6. Repeat step 3 for the next channel.
7. Click OK to accept the changes.

Notes
· The number of channels enabled and the total logging time is updated each time you

make a change.
· You can click and drag over a range of channels to change more than one channel at a

time.

4.7.2 Enable Conditions

Use this function to setup the enable conditions that define the logging start and stop criteria.
Logging will start when either of the start conditions are met but will only stop when both
stop conditions are true.
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1. On the Config menu, click Logging Table.
2. Click on the Enable Conditions tab.
3. Set the Start logging conditions.
4. Set the Stop logging conditions
5. Click OK to accept the changes.

Notes
· The Cyclic Logging and Pit Stop Beacon option checkboxes can also be set in this

window.
· Use the Expansion Box checkbox to enable the optional ECU channels.  This option is

not applicable to the Edelbrock Pro Flo Xt Plus or XTR systems.

4.7.3 Outing Data

This function allows the user to enter outing specific data that will be stored with each
downloaded data set. This information also helps identify each logger outing when browsing
for specific data files with the analysis program.

1. On the Logger menu, click Outing Data.
2. Enter the driver and car names.
3. Type in any text comments for the data set.
4. Enter the track name and length information.
5. Set the beacon mask time.
6. Click OK to save changes.
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Notes
· The track length is used to calculate average vehicle speed per lap.
· The beacon mask is the time period that must elapse before any subsequent beacons can

be detected
· The outing data is saved and will be downloaded as part of each logger data set.

4.7.4 ECU Channels

To view ECU channel data in engineering units in the analysis, comms and telemetry
programs it must be calibrated by applying a scale and offset to the raw data.

1. On the Config menu, click Calibrations.
2. Select ECU Channels from the menu.
3. Select the channel you want to edit from the combo box.
4. Enter the calibration scale value.
5. Enter the calibration offset value.
6. Repeat steps 3 thru 5 for any additional channels.
7. Click OK to save changes.
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Notes
· Default values can be found in the Appendix under ECU Calibrations.

4.7.5 System Units

Use this function to define your system units. Setting this parameter effects the units used for
the wheelspeeds, distance and fuel used channels.

1. On the Config menu, click Calibrations.
2. Select System Units from the menu.
3. Click on either the Imperial or Metric menu.
4. The System Units have now been changed.

Notes
· Additional information on System Units can be found in the Appendix.

4.7.6 Injector Details

The System Editor Fuel Counter feature is used to log and monitor fuel consumption.  This is
primarily used by customers competing in closed course road or oval track racing events.  To
calculate fuel used the injection pulse widths are accumulated and then converted to
engineering units using the specified injector flow rate. It is important that the calibration
information is correct for the fuel used data to be accurate.

1. On the Config menu, click Injector Details.
2. Enter the Injector flow rate in cc/min.
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3. Enter the number of Injectors on the engine.
4. Enter any correction factor or set the default value of one.
5. Click OK to save changes.

Notes
· Injector flow rate must be specified at the fuel pressure used.
· The minimum injector flow rate allowed is 135cc/min.

4.7.7 System Alarms

The ECU has user programmable alarm channels. The limits for each channel can be set along
with a mask time and an optional engine rpm qualifying threshold.

1. On the Config menu, click System Alarms.
2. Double-click on the channel you want to edit.
3. Click on the Enable Alarm checkbox.
4. Enter the upper and lower alarm limits.
5. If the Alarm is qualified enter the RPM limit.
6. Enter the Alarm mask time. (30 secs max)
7. Click OK.
8. Repeat step 2 for additional channels.
9. Click OK to save changes.
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Notes
· A channel must be above the set limit for the mask time before an alarm is triggered.
· The alarm enable conditions can also be set from this window.
· You can use the Defaults button to reset all Alarms.

4.8 Syscon Menu

Summary
The System Editor syscon menu is used to update ECU firmware, monitor raw ECU sensor
data and system flags and to reset the ECU/engine run time clock.  Menu items include:

· Flash Loader
· Extract Config
· Monitor ADC
· System Flags
· Reset Engine Clock

4.8.1 Load Hex File

Use this function for loading a new version of firmware into a Pro Flo XTR ECU only. 

Warning : Failure to load the correct version of firmware into an ECU may result in loss of
functionality and/or non operation. In some cases the ECU may have to be returned to the
factory for repair. Contact your Edelbrock Tech Support representative for further information
about loading firmware.

1. On the Syscon menu, click Load Hex File.
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2. Select the drive and folder where the file is located.
3. Double-click the hex file or click OK to select it.
4. A progress bar will display during the programming routine.

Notes
· After loading a flash file the ECU must be powered down and restarted before it will

function.
· Only flash files of the type (*.hex) can be programmed into a Pro Flo XTR ECU.  

4.8.2 Flash Loader

Use this function for loading a new version of firmware into a Pro Flo XT Plus ECU. 

Warning : Failure to load the correct version of firmware into an ECU may result in loss of
functionality and/or non operation. In some cases the ECU may have to be returned to the
factory for repair. Contact your Edelbrock Tech Support representative for further information
about loading firmware.

1. On the Syscon menu, click Flash Loader.
2. Select the drive and folder where the file is located.
3. Double-click the hex file or click OK to select it.
4. A progress bar will display during the programming routine.
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Notes
· After loading a flash file the ECU must be powered down and restarted before it will

function.
· Only flash files of the type (*.FSX) can be programmed into a Pro Flo XT Plus ECU.  

4.8.3 Extract Config

Use this function to retrieve the existing logger setup from the ECU. The setup will be
uploaded from the ECU and is automatically saved to disk.

1. On the Syscon menu, click Extract Config.
2. A progress bar will display during the upload routine.
3. The logger setup is automatically saved to disk.

Notes
· The extracted setup file is saved on disk as "Header.Bin".

4.8.4 Monitor ADC

This function is used to directly read the Analog to Digital converter (ADC) bit values for the
ECU channels. This feature is used for checking the raw bit data for channels or for
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calibrating new sensors.
1. On the Syscon. menu, click Monitor ADC.
2. The channel ADC monitor window will open.
3. Select a channel from the dropdown combo box.
4. Select the ECU Type.  Pro Flo XT Plus ECUs use the "1.2" designation
5. The raw bit data will display in the ADC Count window.

Notes
· The raw ADC counts are 10 bit by default but can optionally be viewed as 8 bit data.

4.8.5 System Flags

This function requires password access. The bit definitions for each of the system flags is
described below.
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FLAG 0 - General Flags
· (1) - MAP #2 - Map 2 selected
· (2) - Word Write
· (4) - Shift Cut - Mode active
· (8) - Pit Limiter - Limiter active
· (16) - VTEC On - Enabled
· (32) - Spark Trims - Trims active
· (64) - Fuel Trims - Trims Active
· (128) - A/C Kick - Idle kick active

FLAG 1 - Firmware
· (1) - CRC Flag - Checking CRC
· (2) - Reserved
· (4) - Reserved
· (8) - Reserved
· (16) - Reserved
· (32) - Reserved
· (64) - Reserved
· (128) - Hex Load - Firmware loading

FLAG 2 - Lambda Functions
· (1) - Lambda On - Closed loop enabled
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· (2) - At Target - Lambda matches setpoint
· (4) - Temp OK - Sensor temp OK
· (8) - Air Temp - Above air temp limit
· (16) - H2O Temp - Above water temp limit
· (32) - RPM Limit - Above RPM limit
· (64) - TPS Limit - Above throttle limit
· (128) - Trans OK - Transient inactive

FLAG 3 - PID Windup
· (1) - IWPLOW - Integral windup (Pit Limiter)
· (2) - IWP_HI
· (4) - IWTLOW - Integral windup (Traction Control)
· (8) - IWT_HI
· (16) - IWLLOW - Integral windup (Lambda)
· (32) - IWL_HI
· (64) - IWBLOW - Integral windup (Boost Control)
· (128) - IWB_HI

FLAG 4 - Dwell flags
· (1) - FG1 - Position 1
· (2) - FG2
· (4) - FG3
· (8) - FG4
· (16) - FG5
· (32) - FG6
· (64) - FG7
· (128) - FG8

LOG_EN - Logger
· (1) - Download - Downloading
· (2) - State - Speed status
· (4) - Reserved
· (8) - Reserved
· (16) - Speed - Above speed limit
· (32) - RPM - Above RPM limit
· (64) - Empty - No memory installed
· (128) - Ram Full - Logger memory full

FLGINT - Interrupt
· (1) - IGN + - Spark trim flag
· (2) - Double Inj. - Staged injection active
· (4) - IWDLOW - Integral windup (DC Motor)
· (8) - IWD_HI
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· (16) - FGSYNC - Sync pickup toggle
· (32) - SYN OVW - 5 tooth flag
· (64) - ASYNC - Ignition above cranking
· (128) - FASOK - Signal frame OK

FLGCUT - Cut Flags
· (1) - Overrun - Engine overrun
· (2) - Fuel Limiter - Limiter active
· (4) - Boost Limit - Limiter active
· (8) - Reserved
· (16) - Reserved
· (32) - Reserved
· (64) - IGN Limiter - Limiter active
· (128) - Kill Switch - Switch active

Notes
· Some flag functions may vary depending on the version of firmware in use.

4.8.6 Reset Engine Clock

This function is used to reset the ECU engine clock. The engine clock is a counter that keeps
track of the total time the engine has been running since the clock was last reset.

1. On the Syscon menu, click Reset Engine Clock.
2. The ECU clock will be reset to zero.

Notes
· The engine clock is displayed at the bottom of the screen in the status bar.
· The clock counts whenever the engine rpm is above 1000 rpm.
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4.9 iLink Menu

Summary
The System Editor iLink menu is used to setup options associated with the iLink feature. 
iLink allows Edelbrock EFI personnel to monitor customers ECU data directly via an internet
connection.  Menu items include:

· Setup
· Connect
· Disconnect
· Send Map

4.9.1 Setup

This function is used to configure the iLink software. This feature allows realtime ECU data
to be sent to a remote location over the internet allowing EFI personnel to monitor your ECU,
check engine sensors, read diagnostic codes, view your engine map and more.

Before you can use iLink you must have installed and registered the iLink library file. The
install CD should perform this step for you but if not this can be done manually from the
command line of the Power to Win directory.

Enter "c:\windows\system32\regsvr32.exe EFiLink.dll"

You will see a dialog box confirming that the library was successfully registered. If the
message says "failed to register library" you can use the depends.exe program described later
in this chapter to diagnose the problem.

1. On the iLink menu, click Setup.
2. Enter the IP address for the remote location.
3. Enter the port number.
4. Select the Send or Receive option.
5. Click OK to save changes.
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Notes
· Some iLink setup options are only available to Edelbrock personel.
· Contact your Edelbrock EFI Tech representative for further information about iLink and

correct Port Assignments.

4.9.2 Connect

Use this function to connect to a remote site using iLink. Before a valid connection can be
established the remote site must be first configured and ready to accept your data.

1. On the iLink menu, click Connect.
2. Your ECU data will now be sent over iLink.

4.9.3 Disconnect

Use this function to disable and close your iLink connection.
1. On the iLink menu, click Disconnect.
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2. Your iLink connection will be closed.

4.9.4 Send Map

Use this function to send your engine map over the iLink connection. Before using this feature
a valid connection must be established and the remote site must be configured and ready to
accept your data.

1. On the iLink menu, click Send Map.
2. The current map will be sent over iLink to the remote site.
3. The recipient will receive notification that your map has been sent.
4. The transmission of engine data over iLink will resume.

4.10 Editing Maps

Summary
There are many ways to edit a calibration file.  System Editor simplifies the process by
offering many ways to view, manipulate and edit calibration data.  The following sections
describe:

· The file folder
· Graphic display options
· Numeric table options
· How to edit calibration constants
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4.10.1 File Folder

The file folder window has been designed to simplify the management of your engine maps. It
features an intuitive tree view window to facilitate easy loading and viewing of your function
groups, maps and constants. Multiple maps can be loaded simultaneously and easily selected
using the drop-down combo box at the top of the window.

Menus

To expand the tree to view maps and constants in detail double-click on the function group.
Double-clicking on an individual map will then open it in the main window. When you right-
click over items in the file folder you will see the one of following popup menus and editing
functions.

 File Functions
· Add File - Adds a new engine map to the file folder.
· Replace File - Replaces the current engine map with another.
· Properties - Opens a window with details about the current map.
· Edit Comments - Opens the edit comments window.
· Delete - Deletes the currently selected engine map.
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 Function Groups
· Open All -Opens all of the maps and constants for this function group.
· Copy - Copies the entire function group to the clipboard.
· Paste - Pastes the entire clipboard contents to the current function group.
· Close - Closes all of the maps and constants for this function group.



Power to Win122

 Maps & Constants
· Open Map -Opens the selected map or constants.
· Copy - Copies the entire map or constants to the clipboard.
· Paste - Pastes the entire clipboard contents to the current map.
· Breakpoints -Opens the map breakpoint editor window.
· Map Color - Opens the map color selection window.
· Show Numeric - Toggles the current map display mode.
· Close - Closes the current map or constants.
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 Overlay
· Import Data -Opens the overlay file selection window.
· Overlay On - Toggles the overlay function on/off.
· Unload - Unloads the current import overlay file.
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4.10.2 Graphic Displays

The engine maps can be displayed and edited in graphic format. Depending on the number of
variables the map will be displayed in a 2 or 3 dimensional format. Specific details for each
map can be found under the section on Function Groups.

1. Click in the file folder window and locate the function you want to edit.
2. Double-click on the map folder to open the edit window.
3. Click on a point to position the cursor or move about the graph using the arrow keys.
4. Use the + & - keys to scroll to the new value.
5. Changes to the modified graph will be displayed in red.
6. Move to the next position and repeat step 3.
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When you click and drag over a numeric grid to select a range of cells you will see a popup
menu of the available block editing functions. Each of these is described below.

Copy
Copies the currently selected range of cells to the clipboard.

Paste
Pastes the contents of the clipboard to the currently selected range of cells. If there is more
data than the number of cells selected only the highlighted cells will be changed.

Multiply Range
Multiplies the currently selected range of cells by the number displayed in the correction
value field. For example a multiplier of 1.05 will correct the selected range by 5%.

Fill Range
Fills the currently selected range of cells with the number displayed in the correction value
field.

Offset Range
Offsets the currently selected range of cells by the number displayed in the correction value
field.
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Interpolate
Using the values of the first and last cells selected the intermediate cell values are recalculated
by linear interpolation.

Notes
· The block editing functions are useful for making large changes to your engine maps but

should be used with caution.
· The interpolate routine supports both vertical and horizontal functions.

Notes
· You can select a region of the map for block editing by positioning the cursor at the start

point and then holding down the Ctrl key while clicking on the end point.
· The graph orientation can be changed using the Perspective options on the popup menu.

4.10.3 Numeric Tables

The engine maps can be displayed and edited in numeric format. Depending on the number of
variables the map will be displayed as a 2 or 3 dimensional grid. Specific details for each map
can be found under the section on Function Groups.

1. Click in the file folder window and locate the function you want to edit.
2. Double-click on the map folder to open the edit window.
3. Click on a cell to make it active or move about the grid using the arrow keys.
4. To see a different area of the grid you can use the scroll bars.
5. Type in the new value or use the + & - keys to scroll to the new value.
6. Changes to the modified cell will be displayed in red.
7. Move to the next edit cell and repeat step 3.
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Notes
· You can click and drag over a range of cells for block editing functions.
· Clicking on the header cell will select all of the cells in the grid.
· Holding down the Ctrl key when scrolling will change the data in larger increments.

4.10.4 Editing Constants

Engine map constants are displayed in a table format with text fields for editing. Specific
details for each constant can be found under the section on Function Groups.

1. Click in the file folder window and locate the function you want to edit.
2. Double-click on the constant folder to open the edit window.
3. Click on the constant you want to edit.
4. Enter the new value.
5. Repeat step 3 for further constants.
6. Click Save to save changes.
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Notes
· Any changes will not be saved to the current map unless the Apply button is pressed.
· Left click in the numeric box to open the bit editor window.

4.11 Function Groups

Function groups in the file folder are used to organize calibration tables and constants into
logical groups.  Fuel related functions, spark related functions, etc.  All basic tuning tasks can
be accomplished by editing calibration data located in these groups.  

4.12 Fuel Injection Function Group

Summary
The fuel injection function group includes tables and constants associated with fuel control. 
The fuel injection function group includes:

· Injection map - the primary tuning table for fuel control
· Injection phase - used to calibration injection timing or phase
· Injection f(Battery) - the battery offset table
· Cylinder trims - individual fuel trims
· Fuel control related constants



Power to Win130

4.12.1 Injection Map

The Fuel Injection map is a 3 dimensional table of the Injection pulse widths for each of the 
Load and RPM points on the map. The standard map consists of 40 rpm and 20 throttle sites
which can be individually set by the user by editing the breakpoints.

The values in the map are Injection pulse widths expressed in millseconds and represent the
base time period that each injector is open. These values can be edited to change the amount
of fuel delivered at each site.

4.12.2 Injection Phase

The Injection Phase map is a 3 dimensional table of the Injection phasing for each of the 
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Throttle and RPM points on the map. The standard map consists of 20 rpm and 10 throttle
sites which can be individually set by the user by editing the breakpoints.

The values in the map are the angular position at which the injection event starts expressed in
deg ATDC. These values can be edited to change the injection phasing at each site.

4.12.3 Injection f(Battery)

The Injection Battery correction map is a 2 dimensional table of correction values for each of
the Battery Voltage values on the map. The standard map consists of 20 calibration points
which can be individually set by the user by editing the breakpoints. The values in the map are
injector delay times expressed in microseconds and are added to the base injection time. 
Changing battery voltage conditions will affect the fuel injector flow rate.  To maintain
consistent fuel flow regardless of battery voltage, the battery offset table is used.  Edelbrock
has pre-defined tables for most popular injectors.  Contact tech support for more information.
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Notes
· The battery correction for a particular injector will vary at different operating fuel

pressures.

4.12.4 Cylinder Trims

The Cylinder Trim map is a table of correction values for each of the Injector numbers on the
map. The standard map consists of 16 injector numbers with a correction value for each. The
values in the map are multipiers of the base injection time.
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Notes
· The correction table is referenced to injector number not cylinder number.
· Example : A correction value of 1.05 will multiply the injectors base pulse width by 5%.
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4.12.5 Constants

Cyl. trim RPM limit - Sets the minimum engine speed to enable the Injection cylinder trims.
Below this limit cylinder trims are disabled.

Cyl. trim Throttle limit - Sets the minimum throttle angle to enable the Injection cylinder
trims. Below this limit cylinder trims are disabled.

Fuel Rev-limiter - When the engine exceeds this rpm the fuel to the next cylinder is cut. If
the engine speed continues to exceed the limit the next cylinder is cut and so on. This type of
rev-limiter is generally soft in action and may allow the engine to exceed the set limit by 50 -
100 rpm.

Staged Injection Max. - The injection pulse width to de-activate staged injection. Above this
threshold both injectors are enabled.

Staged Injection Min. - The injection pulse width to activate staged injection. Below this
threshold one injector is enabled with double the pulse time.

Phase Rate - The maximum allowed change in the injection phase per engine cycle. This
prevents engine misfire when there are large changes in the injection phase map.

Cranking Pulse - Sets the base injection pulse width during engine start. This feature is
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active when below the cranking rpm limit. Typical values for this constant are 2 to 3 times the
idle pulse width.

Cranking Limit - Sets the engine rpm that activates the cranking pulse width. Above this
value the injection time from the map is used.

Fuel Pump timeout - Sets the time period that the fuel pump control output is active after the
engine shuts down. This timer is also activated when the ignition is first turned on.

Notes
· The Staged Injection constants are not used when the Injection Bias Map is functional.

4.13 Spark Advance Function Group

Summary
The spark advance function group includes tables and constants associated with ignition
control.  The spark advance function group includes:

· Ignition map - the main table for base spark advance
· Dwell f(Battery) - dwell control as a function of engine speed
· Cylinder trims - individual spark cylinder trims
· Ignition control constants

4.13.1 Ignition Map

The Ignition map is a 3 dimensional table of the Ignition timing values for each of the Load
and RPM points on the map. The standard map consists of 40 rpm and 20 throttle sites which
can be individually set by the user by editing the breakpoints.

The values in the map are spark timing expressed as degrees BTDC and represent the base
ignition advance numbers. These values can be edited to change the amount of spark advance
at each site.
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4.13.2 Dwell f(Battery)

The Dwell correction map is a 2 dimensional table of correction values for each of the 
Battery Voltage values on the map. The standard map consists of 20 calibration points which
can be individually set by the user by editing the breakpoints. The values in the map are
correction multiplier values of the base coil dwell time.
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Notes
· This table is only for use when using an inductive ignition system. Set this to all ones

when using a CDI or other type ignition system.
· Failure to set the correct values for a particular coil may lead to ECU and/or ignition coil

failure.

4.13.3 Cylinder Trims

The Cylinder Trim map is a table of correction values for each of the Ignition coil numbers
on the map. The standard map consists of 16 coil numbers with a correction value for each.
The values in the map are offsets to the base spark advance time.
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Notes
· The correction table is referenced to ignition coil number not cylinder number.
· Example : A correction value of 5.0 will offset the base spark advance by 5 deg.
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4.13.4 Constants

Cyl. trim RPM limit - Sets the minimum engine speed to enable the Ignition cylinder trims.
Below this limit cylinder trims are disabled.

Cyl. trim Throttle limit - Sets the minimum throttle angle to enable the Ignition cylinder
trims. Below this limit cylinder trims are disabled.

Spark Rev-limiter - When the engine exceeds this rpm the spark to the next cylinder is cut. If
the engine speed continues to exceed the limit the next cylinder is cut and so on. This type of
rev-limiter is generally abrupt in action and will not allow the engine to exceed the set limit.

Base dwell time - Sets the duration of the base ignition coil charge time on an inductive type
ignition system. For CDI ignitions this value should be set to 200uS.

Pickup Delay - Compensation constant for the inherent delay time of the crank pickup.
Typical values are 150uS for Magnetic pickups and 50uS for Hall effect pickups.

Pickup Position - Defines the position of the crank pickup in degrees BTDC of the #1
cylinder. Any variance in the actual crank pickup position to this value will result in ignition
timing errors.

Tacho pulse width - Sets the duration of the output pulse used to drive an external
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tachometer. For most applications set this to 500uS.

Notes
· Some custom versions of ECU firmware require the pickup position to be set greater

than the values in the spark advance table i.e. 60 deg BTDC. Failure to set this value
correctly will result in the ignition outputs not functioning.

4.14 Boost Control Function Group

Summary
The boost control function group includes tables and constants associated with closed loop
boost control.  This feature is primarily used for turbocharged applications using pressure
balanced wastegates.  The boost control function group includes:

· Base duty table - base open loop duty table
· Boost curves - multiple closed loop boost target tables
· Boost control related constants

4.14.1 Base Duty

The Base Duty map is a 2 dimensional table of the base wastegate valve duty cycle output for
each of the RPM points on the map. The standard map consists of 20 calibration points which
can be individually set by the user by editing the breakpoints. The values in the map are the
percentage of wastegate valve On/Off times at the frequency specified.
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Notes
· The closed loop control modifies the base duty cycle to achieve the target boost values.
· See the section on tuning PID controls in the appendix for further information.

4.14.2 Boost Curves

The Boost Curves are 2 dimensional tables of the boost values for each of the RPM points on
the map. The standard map consists of 20 calibration points which can be individually set by
the user by editing the breakpoints. The values in the maps are the target boost values for each
of the 5 selectable positions.
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Notes
· The active boost curve is selected using the boost switch input, or defaults to curve one

if no switch is connected.
· When using the optional boost trim mode curve one is the default.
· See the section on tuning PID controls in the appendix for further information.
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4.14.3 Constants

Boost Configuration - Enables the following ECU control functions. With this constant
selected, left click on the numeric value to open the bit editor window.

· Select Boost trim mode.
· Invert Valve 1 Output.
· Invert Valve 2 Output.
· Select Boost Map as f(Gear)
· Vanos Control on Valve 1.
· Enable RPM Control on Valve 2.

Frequency Duty 1 - Sets the base frequency for the Valve 1 output.

Frequency Duty 2 - Sets the base frequency for the Valve 2 output. This is only in effect
when in duty cycle mode.

Proportional Gain - Proportional gain constant. 

Integral Gain - Integral gain constant. 

Derivative Gain - Derivative gain constant. 

Integral Timer - Integral Timer constant.



Power to Win144

Derivative Timer - Derivative Timer constant. 

Throttle limit - Sets the angle that the throttle must be above to activate the integral part of
the PID calculation.

Fuel Boost limiter - When the engine boost exceeds this value the fuel is cut to all cylinders
providing over-boost protection.

Valve 2 RPM limit - Sets the engine rpm that enables the on/off Valve 2 output.

Notes
· See the section on tuning PID controls for further information.
· The Boost Limiter is only active in Speed Density mode.
· The Valve 2 output is normally open when in RPM control mode and cannot be

inverted.

4.15 Lambda Control Function Group

Summary
The lambda control function group includes tables and constants associate with closed loop
fuel control.  The Lambda control function group includes:

· Lambda setpoint - the base lambda or AFR target table
· Lambda 1 and 2 calibration tables - voltage to lambda conversions
· Lambda function constants

Lambda is the ratio of the measured AFR to that of the chemically correct air-to-fuel ratio for
any type of fuel. If the air fuel ratio measured in the exhaust pipe of an engine is at the
chemically correct (stoichiometric) ratio of air-to-fuel, lambda is equal to 1.0. In the case of
gasoline, 1.0 is equivalent to 14.7:1 air-to-fuel.  Values less than 1.0 indicate the engine is
running RICHER, while values greater than 1.0 indicate the engine is running LEANER than
the stoichiometric AFR for the fuel being used.

Example: 1.2 Lambda means that the AFR is 20% LEANER than stoichiometric. 0.9 Lambda
means that the AFR is 10% RICHER than stoichiometric.
Equivalence ratio is another term commonly used.  Equivalence ratio is the inverse of the
lambda value.  The following table can be used to convert from one unit to another:

Equiv Ratio Lambda Gasoline
AFR

1.458 0.686 10.08

1.437 0.696 10.23

1.416 0.706 10.38

1.397 0.716 10.53

1.376 0.727 10.69

1.353 0.739 10.86

1.333 0.75 11.03
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1.312 0.762 11.2

1.292 0.774 11.38

1.271 0.787 11.57

1.250 0.8 11.76

1.229 0.814 11.96

1.208 0.828 12.17

1.188 0.842 12.38

1.167 0.857 12.6

1.145 0.873 12.83

1.125 0.889 13.07

1.105 0.905 13.31

1.083 0.923 13.57

1.063 0.941 13.84

1.042 0.96 14.11

1.020 0.98 14.4

1.000 1 14.7

0.964 1.037 15.25

0.928 1.078 15.84

0.892 1.121 16.48

0.855 1.169 17.18

0.820 1.22 17.93

0.784 1.276 18.76

0.748 1.337 19.66

0.712 1.405 20.66

4.15.1 Lambda Setpoint

The Lambda Setpoint map is a 3 dimensional table of the lambda values for each of the Load
and RPM points on the map. The standard map consists of 20 rpm and 10 throttle sites which
can be individually set by the user by editing the breakpoints.

The values in the map are the target lambda values for the closed loop control and can be
edited to change the lambda value at each site.
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4.15.2 Lambda Calibration

The Lambda Sensor calibrations are 2 dimensional tables of raw bit values for each of the 
Lambda points on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. 

Note: On Pro Flo XT Plus systems, the Lambda 1 input is used for narrow band sensors only.
The Lambda 2 input is for wideband sensors only.  The harnesses supplied with the Pro Flo
XT Plus kits from Edelbrock do not include the Lambda 1 circuit.  

Note: On Pro Flo XTR systems, both Lambda inputs (1 and 2) are wideband only.    
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4.15.3 Constants

Lambda Configuration - Enables the following ECU control functions. With this constant
selected, press the Details button to open the bit editor window.

· Enable Closed Loop Control.
· Control from Lambda 1.
· Control from Lambda 2.
· Lambda 1 Temp Compensation.
· Lambda 2 Temp Compensation.
· Enable Setpoint Adjustment.
· Independent Bank Control.

PID Throttle limit - Sets the minimum throttle angle required to activate closed loop control.

PID RPM limit - Sets the minimum engine rpm required to activate closed loop contrrol.

Air Temp limit - Sets the minimum air temp required to activate closed loop control.

Water Temp limit -Sets the minimum water temp required to activate closed loop control.

Lean Correction limit - Sets the maximum percent the mixture can be leaned out under
closed loop control.
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Rich Correction limit - Sets the maximum percent the mixture can be richened under closed
loop control.

PID Active temp - Sets the minimum sensor resistance required to enable closed loop
control. This is only used in temperature compensation mode and must be set to 255 when
using an NGK sensor.

Lambda failed high - Sets the lambda sensor failed high value that disables closed loop
control.

Lambda failed low - Sets the lambda sensor failed low value that disables closed loop
control.

Heater disable temp - Sets the sensor resistance at which the heater circuit is disabled. This
is only used in temperature compensation mode and must be set to zero when using an NGK
sensor.

Bank Configuration - Defines which injectors are on each bank of the engine when using
independant bank lambda control.

Notes
· The Temp Compensation option is only for use with Bosch Wide Band sensors.
· The lambda heater circuit will only activate when the engine is running to prevent

excessive power drain on the battery.
· The setpoint adjustment feature uses the mixture switch input for corrections. Each click

of the switch adjusts the setpoint by 2%.
· Independent Bank Control is not supported for all versions of ECU firmware. Contact

your EFI representative for further information.
· The lambda 1 temperature is always used for the lambda heater disable control function.

Independent Bank Control
When using this mode Control from Lambda 1 and Lambda 2 must also be selected. The
adjustment displayed on the status bar is still the average of the 2 corrections but each bank is
adjusted independently. This is done so that manual updating of the map and the self learn
mode can still be used.
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4.15.4 Constants

Proportional Gain - Proportional gain constant. (see notes)

Derivative Gain - Derivative gain constant. (see notes)

Integral Timer - Integral Timer constant. (see notes)

Derivative Timer - Derivative Timer constant. (see notes)

TPS rate limit - Sets the throttle rate that disables closed loop control.

RPM rate limit - Sets the engine rpm rate that disables closed loop control.

Transient delay - Sets the delay time before closed loop will re-activate after detecting a
transient condition.

Notes
· See the section on tuning PID controls in the appendix for further information.

4.16 Idle Speed Function Group

Summary
The idle speed function group includes tables and constants associated with closed loop idle
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control.  The idle speed function group includes:

· Speed f(Water T) - primary idle target table
· Idle control constants

4.16.1 Speed f(Water T)

The Idle Speed map is a 2 dimensional table of engine rpm values for each of the Water
Temperature points on the map. The standard map consists of 20 calibration points which
can be individually set by the user by editing the breakpoints. The values in the map are the
target engine idle speed values used by the stepper motor controller.

Notes
· The stepper motor controller is not available on all ECU's. Contact your EFI

representative for further information.



System Editor Software 153

4.16.2 Constants

IAC Configuration - Enables the following ECU control functions. With this constant
selected, press the Details button to open the bit editor window.

· Enable IAC control.
· Enable A/C kick rpm.
· Invert kick Switch.
· Reserved.
· Reserved.

Base Frequency - Sets the base control frequency of the IAC stepper motor. Typical values
are 15 to 30 Hz depending on the IAC motor you are using.

Throttle limit - Sets the position at which the throttle angle must be below for the IAC
control to activate.

RPM limit - Sets the engine rpm at which the engine must be below for the IAC control to
activate.

Proportional Gain - Proportional gain constant. (see notes)

Integral Gain - Integral gain constant. (see notes)
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A/C Kick RPM - Sets how much the idle setpoint is changed when the A/C switch or Idle
Stop switch input is closed.

A/C Kick Time - Sets the length of time the IAC moves at high speed to its new position
when the A/C switch or Idle Stop switch input is first opened or closed.

Notes
· See the section on tuning PID controls in the appendix for further information.
· IAC control can only be used if your engine is configured for Speed Density mode.

4.17 Sensor Calibration Function Group

Summary
The sensor calibration function group includes all tables necessary to calibrate system sensors.
 All sensors inputs are measured in raw bit values.  Each bit value is proportional to the
voltage output from the sensor.  The calibration tables transform the raw bit values into
engineering units.  The sensor calibration function group includes:

· Air temp
· Coolant temp
· Oil temp
· Fuel temp
· Airbox pressure (manifold pressure)
· Crankcase pressure
· Fuel pressure
· Oil pressure
· Throttle sensor (TPS calibration)
· Spare sensor (not used)
· Spare sensor (not used)
· Gear position 
· Gear ratios
· Calibration constants

4.17.1 Temperatures

The Temperature Sensor calibrations are 2 dimensional tables of raw bit values for each of
the Temperature points on the map. The standard map consists of 20 calibration points
which can be individually set by the user by editing the breakpoints. Temperature sensor units
are deg C.
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Notes
· You can read the sensor raw bit values using the Monitor ADC function.

4.17.2 Pressures

The Pressure Sensor calibrations are 2 dimensional tables of raw bit values for each of the 
Pressure points on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. Airbox pressure units are In Hg and
Fuel/Oil pressure units are psi.
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Notes
· You can read the sensor raw bit values using the Monitor ADC function.
· Alternate units are available using a custom control file. Contact your EFI representative

for further information.

4.17.3 Throttle

The Throttle Sensor calibration is a 2 dimensional table of raw bit values for each of the 
Throttle points on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. Throttle sensor units are deg.
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Notes
· You can read the sensor raw bit values using the Monitor ADC function.
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4.17.4 Gear Position

Reverse - Sets the bit value for the reverse gear position.

Neutral - Sets the bit value for the neutral gear position.

1st - 8th Gears - Sets the bit values for the forward gear positions.

Notes
· You can monitor the boost switch channel ADC count when calibrating the gear

channel.
· Unused gear position constants should be set to zero.
· Gear position is interpolated when between bit values.
· The ECU can calculate gear position from the engine rpm and rear wheelspeed inputs if

no position sensor is available.
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4.17.5 Gear Ratios

The ECU can calculate gear position from the engine rpm and rear wheelspeed inputs. To do
this accurately it is important that the correct gear ratios are defined.

Final Drive - Final drive ratio.

Gear Ratio - Individual gear ratios. (maximum 8 gears)

Notes
· All gear ratio values must be input as a number between 0 and 2.
· Unused gear position ratio constants should be set to zero.
· Some ECU's have a direct gear position sensor input that alternatively can be used to

measure gear position.
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4.17.6 Constants

MAP Offset - Sets the minimum value for the MAP sensor calibration.

MAP Scale - Sets the scale factor for the MAP sensor calibration.

Notes

Typical values in inches of mercury for use with the following pressure sensors are listed
below. These values must also be set under ECU Calibrations for the internal data logger.

· 1 bar sensor : 0 and 0.125
· 2 bar sensor : 0 and 0.250
· 3 bar sensor : 0 and 0.500

4.18 Correction Tables Function Group

Summary
The correction tables function group consolidates all correction or trim tables into one
location.  Correction tables include functions that modify base fuel or spark values based on
other variables.  The correction tables function group includes:

· Inj f(Airbox) - manifold pressure trim for fuel pulsewidth
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· Inj f (Water) - warmup enrichment table 
· Inj f (Air) - air temperature corrrection table for fuel pulsewidth
· Inj f(Fuel P) - fuel pulsewidth correction for fuel pressure
· Reserved - not used
· Spark f(Airbox) - manifold pressure trim for spark timing
· Spark f(Water) - coolant trim for spark timing
· Spark f(Air) - air temperature trim for spark timing
· Spark f (Fuel P) - spark timing correction for fuel pressure

 

4.18.1 Injection

The injection corrections are 2 dimensional tables of correction values for each of the Sensor
values on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. The values in the map are multipiers of
the base injection time.

Available Corrections :
· f(Airbox) - Airbox pressure correction.
· f(Water) - Water temp correction
· f(Air T) - Air temp correction
· f(Fuel P) - Fuel pressure correction

An example correction table is shown below.  It is called the Inj. f(water) table and is
commonly referred to as the "warmup enrichment" table.  The other correction tables function
the same.
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Notes
· Example : A correction value of 1.05 will multiply the base injection time by 5%.

4.18.2 Spark Advance

The spark corrections are 2 dimensional tables of correction values for each of the Sensor
values on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. The values in the map are added/
subtracted to the base spark advance value.

Available Corrections :
· f(Airbox) - Airbox pressure correction.
· f(Water) - Water temp correction
· f(Air T) - Air temp correction
· f(Fuel P) - Fuel pressure correction

An example correction table is shown below.  It is the Spark f(Air) table.  It corrects ignition
timing as a function of air temperature.  The other correction tables function the same.
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Notes
· Example : A correction value of 5.0 will offset the base spark advance by 5 deg.

4.19 Accel/Decel Function Group

Summary
The accel / decel function group includes tables and constants associate with transient fuel
control.  Transient or Accel/Decl fuel is an fuel multiplier that occurs under rapid changes in
throttle angle.  Rapid throttle opening require a very fast enrichment that also decays away
quickly.  Rapid throttle closings require a quick trim to fuel flow to avoid an overly rich
condition during transition.  The Accel/Decel function group includes:

· Accel f(Water T) - transient fuel trim for coolant temperature
· Accel f(RPM) - RPM trim for accel fuel
· Transient fuel constants

4.19.1 Accel f(Water T)

The Accel f(Water) map is a 2 dimensional table of correction values for each of the Water
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Temperature points on the map. The standard map consists of 20 calibration points which
can be individually set by the user by editing the breakpoints. The values in the map are
multipliers for the accel fuel enrichment.

Notes
· The Accel f(RPM) table is used in combination with this function.
· Details of the accel enrichment calculations can be found under Accel Function in the

Appendix.

4.19.2 Accel f(RPM)

The Accel f(RPM) map is a 2 dimensional table of correction values for each of the RPM
points on the map. The standard map consists of 20 calibration points which can be
individually set by the user by editing the breakpoints. The values in the map are multipliers
for the accel fuel enrichment.
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Notes
· The Accel f(Water T) table is used in combination with this function.
· Details of the accel enrichment calculations can be found under Accel Function in the

Appendix.
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4.19.3 Constants

Max Accel limit - Sets the maximum throttle rate that will be used for the accel fuel
calculation. An accel rate greater than this limit will be saturated to this value. (Typical values
are 20 to 30 bits)

Min Accel limit - Sets the minimun throttle rate required to enable the accel fuel function.
Any accel rates less than this value will not enable fuel enrichment. (Typical values are 1 to 5
bits)

Accel Decay - Sets how long the accel enrichment function is active. The accel rate is reduced
by this value per engine cycle until the value returns to zero. (Typical values are 2 to 5 bits)

RPM Cutoff limit - Sets the rpm the engine must be above to activate the overrun fuel cutoff
function.

Throttle Cutoff limit - Sets the position that the throttle must be below to activate the
overrun fuel cutoff function.

Notes
· The throttle accel rate can be logged by the ECU internal logger to help with tuning this

function.
· Details of the accel enrichment calculations can be found under Accel Function in the
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Appendix.

4.20 System Constants Function Group

Summary
The system constants function group is combines all system level constants and other function
constants that don't fall into any of the previously mentioned categories.  The system
constants function group includes:

· Configuration
· Shift cut
· Pit limiter
· Shift Cut f(Gear)

4.20.1 Configuration

ECU Configuration - Enables the following ECU control functions. With this constant
selected, press the Details button to open the bit editor window.

· Set Speed Density calibration mode.
· Enable Wasted Spark Ignition.
· Invert the Crank pickup input signal.
· Invert the Sync pickup input signal.
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· Invert both the Wheelspeed inputs.
· Enable Ignition Dwell control.
· Disable the Fuel Mixture switch input.
· Run without a Sync pickup Input.

RPM Offset - Sets the minimum engine rpm value for the scaling of the fuel and spark maps.

RPM Scale - Sets the resolution for scaling of the fuel and spark maps. This value is usually
set to 50 allowing rpm breakpoint values up to 13,300 rpm.

Injection Offset - Sets the minimum injection time for the fuel injection map.

Injection Scale - Sets the resolution for scaling of the fuel injection map. This value is
usually set to 0.05 allowing base injection map values up to 12.8 mS.

Cooling Fan On Temp - Above this temperature threshold the cooling fan output is enabled.
(The battery voltage must also be above the minimum specified).

Cooling Fan On VBAT - Sets the minimum battery voltage required for the cooling fan
output to operate.

Notes
· The RPM and Injection scaling constants should not be changed on existing engine

maps and should be defined before starting any engine calibration work.
· Cooling fan output available on XTR ECU's only

4.21 Nitrous Control Function Group

Summary
The Nitrous Control function group includes tables and constants to define auxiliary outputs
for nitrous solenoid activation along with required fuel and spark trims for each nitrous stage.
The nitrous control function group includes:

· Nitrous control constants
· Individual stage constants

Note
In addition to the software selectable criteria, the following conditions must be met for the
system to activate the nitrous control function:

1. The Nitrous Enable pin must be active (grounded)
2. The Clutch Switch pin must be active (grounded)
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4.21.1 Constants

Nitrous Configuration - Enables the following ECU control functions. With this constant
selected, press the Details button to open the bit editor window.

· Enable Nitrous Control.
· Reserved.
· Reserved.
· Reserved.

Nitrous RPM Enable - Sets the minimum engine rpm for the NOS control to activate.

Throttle Limit - Sets the minimum throttle position for the NOS control to activate.

Note - Both the RPM enable AND Throttle Limit conditions must be satisfied for the nitrous
function to activate.

Staging rev-limiter - Sets the engine rev-limiter value while the clutch switch is engaged.

Injector static flow - Defines the static flow rate for the fuel injectors. This must be specified
for the fuel pressure used.
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4.21.2 Stage Setup

The Nitrous control has 3 stages with independent settings for each stage. The constants for
each are described below.

Fuel Added - Sets the amount of fuel added when this stage is active.

Nitrous Enable - Sets the nitrous time delay before this stage is active.

Fuel Enable - Sets the fuel time delay before this stage is active.

Spark retard - Sets the amount the ignition timing is retarded when this stage is active.

Stage setup example:
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The stage setup example above will do the following:

· Add 12 lb/hr fuel flow per injector per stage
· Nitrous stages 1 - 4 activate sequentially one second apart each stage
· Spark timing is retarded 2 degrees per stage

Notes
· Unused stages must have the fuel added and spark retard constants set to zero.
· Fuel units are pounds per hour (lbs/hr) and time constants are in seconds (sec).

4.22 Engine Protection Function Group

Summary
The engine protection function group includes constants associated with protection limits. 
Various options are available for using the engine protection function.  The following section
describes each.  

4.22.1 Constants

This feature allows the user to set safety limits for each of the engines temperature and
pressure inputs which if exceeded put the engine into limp home mode. The maximum rpm is
restricted in this mode preventing any damage to the engine.
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A mask time is provided so that sensor spikes or short periods outside the operating limits do
not activate the protection mode and inadvertantly shut down the engine. If the Reset On
Power down feature is selected the ECU must be power cycled to clear the protection codes.
The engine will not return to normal operation even if the temp or pressure limits drop within
their limits in this mode.

Protection Configuration - Enables the following ECU control functions. With this constant
selected, press the Details button to open the bit editor window.

· Enable Engine Protection.
· Reset on Power Down.
· Reserved.
· Reserved.

Engine RPM Limit - Sets the rev-limit when engine protection is active.

Mask Time - The delay time before the protection mode is active

Air Temp Limit -Maximum air temp protection limit.

Coolant Temp Limit -Maximum coolant temp protection limit.

Oil Temp Limit -Maximum oil temp protection limit.

Fuel Temp Limit -Maximum fuel temp protection limit.

ECU Temp Limit -Maximum ECU temp protection limit.

CDI Temp Limit -Maximum CDI temp protection limit.

Fuel Pressure Limit -Minimum fuel pressure protection limit.

Oil Pressure Limit -Minimum oil pressure protection limit.

Notes
· The alarm lamp will turn on when protection mode is activated.
· To disable a temp protection channel set its limit to 205 deg C.
· To disable a pressure protection channel set its limit to 0 psi.
· In Reset mode the ECU must be power cycled to clear the protection codes.

4.23 Diagnostics

Summary
The diagnostics function group includes setup options associated with the programmable
alarm and diagnostics feature.  The following section describes how to use diagnostics.
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4.23.1 Clear Diagnostics

The ECU has user programmable alarm and diagnostics channels. Use this function to reset
the internal ECU diagnostics data.

1. Right click over the Diagnostics section of the monitor window.
2. Select either Standard ECU's or Race 1.0 Series.
3. All internal system alarms will be reset.

Notes
· Information on setting up the Alarm channels can be found under System Alarms in

Editor.

4.23.2 Clear Resets

The ECU has an internal critical condition alarm. Each time the CPU resets when the battery
voltage drops below 6 volts this counter is incremented. Use this function to reset the counter.

1. Right click over the Diagnostics section of the monitor window.
2. Click on Clear ECU Resets.
3. The ECU resets counter will be reset.

Notes
· Resets are stored for both map positions. If necessary select map 2 and repeat.

4.23.3 Error Codes

This section describes the digital and analog error codes generated by the ECU. These codes
can be viewed using the Diagnostics window while connected to the ECU. These errors
should periodically be cleared so that in the event of a problem this window contains the most
recent codes.

Digitals

Error Cause Description
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Crank < 1000
rpm

Failed Crank pickup
The ECU received 3 sync pulses without a single
crank pulse at low speed.

Crank > 1000
rpm

Failed Crank pickup
The ECU received 3 sync pulses without a single
crank pulse at high speed.

Sync < 1000 rpm Failed Sync pickup
The ECU received 20 crank pulses without a sync
pulse at low speed.

Sync > 1000 rpm Failed Sync pickup
The ECU received 20 crank pulses without a sync
pulse at high speed.

Sequence < 5000 Intermittent pickup
The ECU received an incorrect signal frame
below 5000 engine rpm.

Sequence > 5000 Intermittent pickup
The ECU received an incorrect signal frame
above 5000 engine rpm.

Over-revs Over-rev counter
The total number of times the engine exceeded
the overspeed limit.

ECU Resets CPU shutdown
The supply voltage to the ECU dropped below 6
volts and the CPU reset.

Max Engine RPM Engine Overspeed
The engine revs exceeded the overspeed limit for
10 consecutive cycles.

In addition to the digital error codes the ECU has 15 programmable analog alarm channels.
The upper and lower thresholds can be set for each sensor along with rpm qualification
settings and mask times. Before an alarm is triggered the sensor must be above or below the
threshold for the duration of the mask time and above the rpm specified if qualification is
enabled.

Analogs

Error Cause Description

Low Low error count
The total number of times the sensor went below
the alarm threshold.

High High error count
The total number of times the sensor went above
the alarm threshold.

Minimum
Minimum sensor
value

The minimum value recorded for this sensor since
the last time it was cleared.

Maximum
Maximum sensor
value

The maximum value recorded for this sensor
since the last time it was cleared.

Notes
· Refer to the section on Clearing Diagnostics for further information on resetting error

codes.
· When the ECU receives a sequence error the fuel to the injectors is disabled until the

next valid sync pulse is received. The ignition outputs will continue to function normally
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under these conditions.
· The Analog alarm values are subject to engine rpm qualification if enabled and alarm

mask times. Refer to the section on System Alarms for further infomation.

4.24 Creating Setups

Summary
The following sections describe the procedures necessary to create custom display screens.  A
typical display screen is shown below:
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4.24.1 New Template

This function is used to create a new display template. Once created different display controls
can be added to the window.

1. Right click over the data controls window and click New Template.
2. A dialog box will open to enter the name for the new template.
3. A blank new template will open.

Notes
· See the section on Editing Windows for further information about customizing your

display.

4.24.2 Editing Controls

Once controls have been added to a template they can be edited. Right-click over the control
and the popup menu with the following options will appear.

Edit Control
Opens the channel editor window for changing scalings, colors and fonts for each control.

Change Channel
Opens the available channel list window and replaces the current channel.

Delete
Deletes the current channel.

4.24.3 Adding Controls

Once a template has been created channels and their control types can be added. Right-click
anywhere over a blank section of the window and the popup menu with the following options
will appear. See the section on Editing Controls for further information about customizing
your controls.
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Save As
Use this menu to rename the current template.

Add Control
This function is for adding controls to the current window. A channel list will open and
display the available channels and controls.
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Display Settings
Use this menu to edit the graph control settings.

Show Grid
Use this menu to display or hide the control drawing grid.

Reset Maximums
Resets the maximum pointers on controls that support this function.

4.25 Hot Keys

Hotkey Menu Description

Ctrl+F1 Replace File Replace the current map with another map.

Ctrl+S Save File Save the current map with the same name.

Ctrl+F Save File As Save the current map with a new name.

Ctrl+O Work Offline Set the work offline option.

Ctrl+W Set Password Set a password for the current map.

Ctrl+P Print Print the current map or constants.

Ctrl+Q Exit Exit the program.

Ctrl+D Download Logger Download internal logger data.

Ctrl+C Send Config Send the logger setup to the ECU.

F5 Hide File Folder Hide the file folder display window.

Ctrl+E Extract Map Extract the current map from the ECU

Ctrl+M Compare Maps Compares the loaded maps in the file folder.
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Ctrl+A Active Cursor Toggles the active cursor option.

Ctrl+L Logging Table Open the internal logger setup window.

Ctrl+I iLink Setup Open the iLink setup window.

Ctrl+T Telemetry Open the telemetry setup window.

Ctrl+H Load Hex File load a new hex file into the ECU.

Ctrl+R Reset Engine Clock Clear the free running engine clock.

Shift+F5 Cascade Windows Cascade the open windows.

Shift+Ctrl+F4 Tile Horizontal Tile the open windows horizontally.

Shift+F4 Tile Vertical Tile the open windows vertically.

F8 Global trim Subtract Use Ctrl+F8 for large change.

F9 Global trim Add Use Ctrl+F9 for large change.

F11
Copy Cell Up and
Right

Apply trim and copy current cell to several sites.

Enter Write to Cell Apply the global trim to the current cell.

Bksp Reset global trims Clears the current global trim.

4.26 ECU Calibrations

Channel Units Offset Scale Comments

Engine RPM rpm 0 1

Battery volts 0 0.07

Throttle deg 0 0.5

Airbox Pressure In Hg 0 0.125 See Notes

Exhaust Pressure In Hg 0 0.125 See Notes

Fuel Pressure psi 0 1

Oil Pressure psi 0 1

Lateral G G -6.35 0.05

Fuel Temperature deg C -50 1

Air Temperature deg C -50 1

Water Temperature deg C -50 1

Oil Temperature deg C -50 1

ECU Temperature deg C -50 1

Lambda 1 ratio 0.6 0.005

Lambda 2 ratio 0.6 0.005

CDI Temperature deg C -50 1 Race 4.0 only

TPS rate bits -128 1

Gear Position # -1 1
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Mixture Switch % -12 2

Boost Switch # 1 1

Beacon volts 0 0.02

Duty 1 % 0 0.39 Wastegate Output 1

Duty 2 % 0 0.39 Wastegate Output 2

Frontwheel mph 0 1 See Notes

Rearwheel mph 0 1

Fuel Used Gal 0 0.01 Use 0.1 for liters

Injection mSec 0 0.001

Spark Advance deg 0 0.25

Lambda Correction 1 % -100 0.781

Lambda Setpoint ratio 0.6 0.005

EGT 1 deg C -98 4.731 Race 4.0 only

EGT 2 deg C -98 4.731 Race 4.0 only

FLAG0 bits 0 1

FLGCUT bits 0 1

Power Cut % 0 3.125

FLAG2 bits 0 1

FLAG3 bits 0 1

FLAG4 bits 0 1 Knock output

Intake Cam deg 0 0.25

Exhaust Cam deg 0 0.25

Sync Position deg 0 1

Slip % 0 0.195

Lambda 1 Temp ohms 0 1

Heater Duty % 0 0.391

Shift Switch volts 0 0.02

Pit Limiter bits 0 1

Lambda Correction 2 % -100 0.781

Duty 3 % 0 0.391 DC Motor Output

Pedal Position deg 0 0.5

Feedback volts 0 0.5

Duty 4 bits 0 1 Nitrous Stage Flag

Lambda 2 Temp ohms 0 1

Notes
· Pressure calibrations may vary depending on scales used in the map.
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· Wheelspeeds will output in kph if metric units are selected in the setup.
· To change temperatures to Deg F use Offset = -58 and Scale = 1.8.
· Lambda temps are only valid when using Bosch Wide Band sensors.

5 Data Analysis Software

The Data Analysis module is a powerful tool designed to let you view and manipulate
information collected from your data logger. Using the software you are better equipped to
make informed decisions about your race setup and make changes to improve performance.
 
More detailed analysis may be achieved by combining data from sensors, mathematical
equations, setup information and knowledge of race engineering. However you use the
information, this tool helps you decide on what changes to make according to your
interpretation of the data.
 
If you are going to make informed decisions then you must have confidence in your data. This
can be achieved by making sure that you have good quality data and that you are looking at
and interpreting the data in the right way.  The Analysis software package is designed to work
seamlessly with the Pro Flo XT Plus and XTR hardware as well as the System Editor
program.  Launch the Analysis program by clicking on the desktop icon below:

or by browsing to C:\Power to Win and launching the Analysis application.  The Analysis
main screen is shown below:
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5.1 File

Summary
The file menu includes items associated with typical file functions as well as user login, setup
options, export options and print features.  The file menu includes:

· Add new outing
· Replace outing
· User export
· Subset
· Setup file
· Options
· User login
· Add new folder
· Print
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5.1.1 Add New Outing

Use this function to add a new dataset to the File Folder.
1. On the File menu, click Add Outing.

 
2. Select the drive and folder where the dataset is located. This is the location the data was
downloaded, designated when you registered your ECU and set the download path in the 
File menu under Register ECU
3. Click on the dataset to read the file details and comments.
4. Double-click the dataset or click OK to open it.



Data Analysis Software 187

Notes
· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Replace Outing menu to replace the current outing.

5.1.2 Replace Outing

Use this function to replace the current dataset in the File Folder.
 
1. On the File menu, click Replace Outing.
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2. Select the drive and folder where the new dataset is located.
3. Click on the dataset to read the file details and comments.

 
4. Double-click the dataset or click OK to select it.

Notes
· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Add Outing menu to add a new outing to the File Folder.
· Only dataset files of the type (*.DAT) can be read by Analysis.
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5.1.3 User Export

This function allows the data displayed for the current dataset to be saved to disk in a variety
of formats.
 
1. On the File menu, click User Export.

 
2. Select a type from one of the three different formats.
3. Select the drive and folder where the exported data is to be saved.

4. Click Save to save to disk.
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Formats
· Ascii (*.ASC) - A comma delimited text file.
· Binary (*.BIN) - Single precision (4 byte) floating point data.
· Matlab (*.MAT) - Double precision (8 byte) floating point data.

When creating a Matlab (*.MAT) file and have Microsoft Access installed on your
computer you may have to edit the file name if the extension has been removed.
Use the Binary (*.BIN) format when creating a telemetry reference lap file. In addition to
your reference channel(s) you must export the Distance channel if you want to use the data
in a distance plot.
 
Notes

· Only the current time period displayed and selected channels are exported using this
function.

· Use the Export Subset option to export data in the standard EFI format.

5.1.4 Subset

This function allows a subset of the current dataset to be exported to disk.
 
1. On the Export menu, click Subset.

2. Select from the list of previously defined channel groups.
3. Select the disk drive where the exported data is to be saved.
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4. Click OK to save to disk.
 
Notes

· ECU channels and the Engine Logbook are not exported unless the appropriate check
boxes are selected.

5.1.5 Setup file

This function allows a copy of the setup file embedded in the current dataset to be exported
to disk.
1. On the Export menu, click Setup File.

2. Enter a name for the setup file.
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3. Select the drive and folder where the file is to be saved.

4. Click Save to save to disk.
 
Notes

· Setup files are automatically saved as the (*.STP) type.

5.1.6 Options

The options displayed on this window allow you to customize your version of the Analysis
program. Associated features are grouped together and can be selected using the Tab
buttons.
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Graph

· Grids - Settings for the graphic display grids.
· Misc - Settings for the cursors and status bar.
· Zoom - Default settings for the zoom and scroll controls.
· Always on Top -Sets the window to always be in the forefront.

 
Print

· Margins - Defines the printer margins.
· Line Spacing - Spacing for the text on printouts.
· Grid - Allows customization of the print grid.
· Channels - Sets the number of legend channels.

 
Misc
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· Misc - Cursor options and beacon masking.
· Default - Fastest lap selection.
· Tile Mode - Manual or Automatic

 

5.1.7 User Login

Certain features of QwikData 2 are password protected. This window is used when
Edelbrock personnel need to login and activate these features.
 
1. On the File menu, click User Login.

2. From the drop-down list select your user name.

3. In the Password box, type in your password.
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4. Click OK.
 
Notes

· You can click on the Logout button to return to the default Login.

 

5.1.8 Add New Folder

Use this function to add a new folder to the File Folder window.
 
1. On the File menu, click Add New Folder.

                
2. Enter name for new folder

 
3. Select the drive and folder where the dataset is located.
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4. Click on the dataset to read the file details and comments.
5. Double-click the dataset or click OK to open it in the new folder.

 
Notes

· There is a maximum limit of five file folders that can be open at one time.
 

5.1.9 Print

Use this function to print a hard copy of the current window.
 
1. On the File menu, click Print.
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2. The graph or report for the current window will be sent to the printer.
 
Notes

· Use the Print Setup menu to configure your printer.

5.2 View

Summary
The view menu provides methods to analyse data in different formats.  Plots vs time, distance
and one variable vs another (XY plot) are all possible.  The view menu includes the
following:

· Time plot
· Distance plot
· Entire outing
· XY plot
· Histogram
· Measure cursor
· Event markers
· Macro toolbar

 

5.2.1 Time Plot

Use this function to open the time plot window. This plot is useful for looking at events that are
independent of the position of the track or when a wheelspeed input is not available to plot against
distance. Transient events such as the response of the suspension over a bump or the dynamics of the
drive-train during a gearshift should be plotted against time.
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1. On the View menu, click Time Plot.

The time plot window will open and display a graph of the channels loaded in the file folder plotted
against time.  If no channels are chosen, the plot will be blank.  To add channels to the plot, click on
the channels tab at the bottom of the data manager window.  To delete loaded channels from the plot,
right click on them and select delete.
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The scale for the current channel is displayed on the left axis and additional channel information is
displayed at the top of the graph.
 
2. Move the cursor horizontally to a point of interest.
3. Right click to open the zoom and scroll popup menu.
 
The channel numerical data for the current time will update as the cursor is moved. If the track map
is open the current position will also update.
 
Notes

· Clicking on a channel in the data manager makes it the new current channel.
· Right click over the left axis to open the channel scaling popup menu.
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5.2.2 Distance Plot

Use this function to open the distance plot window. This plot is useful for looking at events
that relate to actual track position. Using the track window in conjunction with the distance
plot gives an immediate indication of position on the track. By overlaying data from several
laps you can compare visually the difference in performance at any point on the track.
 
1. On the View menu, click Distance Plot.

 
The distance plot window will open and display a graph of the channels loaded in the file
folder plotted against distance. The scale for the current channel is displayed on the left axis
and additional channel information is displayed at the top of the graph.
 
2. Move the cursor horizontally to a point of interest.
3. Right click to open the zoom and scroll popup menu.
 
The channel numerical data for the current distance will update as the cursor is moved. If the
track map is open the current position will also update.
 
Notes

· Distance Plot requires wheel speed and distance channel logging.
· Clicking on a channel in the file folder makes it the new current channel.
· Right click over the left axis to open the channel scaling popup menu.

5.2.3 Entire Outing

Typically you will look at data for a single lap or part of a lap. You can use this function to
look at data from more than one lap at a time or even for the entire outing.
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1. On the View menu, click Entire Outing.

 
The current plot will change and display the channels loaded in the file folder for the entire
outing. The scale for the current channel is displayed on the left axis and additional channel
information is displayed at the top of the graph.
 
2. Move the cursor horizontally to a point of interest.
3. Right click to open the zoom and scroll popup menu.
 
Double-click over a particular lap to make it the current lap and exit the entire outing view
mode. You can also use the Group Laps feature to look at several consecutive laps from the
same outing.
 
Notes

· Clicking on a channel in the file folder makes it the new current channel.
· Right click over the left axis to open the channel scaling popup menu.

5.2.4 XY Plot

Use this function to open the x-y plot window. This function allows you to plot one channel
against another rather than against time or distance. These plots can be used to identify
patterns or behaviour. e.g. Plotting RPM against Speed produces a sawtooth plot showing
how each gear is used throughout the speed range.
 
X-Y plots are useful for analyzing vehicle dynamics. More advanced use of the x-y plot
involves creating and plotting math channels to analyze the dynamic behaviour of the
vehicle.
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1. On the View menu, click X-Y Plot.

 
The x-y plot window will open and display a graph of the channels loaded in the file folder
plotted against the selected x axis channel. The scale for the current channel is displayed on
the left axis and the scale for the selected x axis is at the bottom of the plot. The formula for
the best fit straight line for the current channel is displayed at the top of the graph.
 
2. Right click to open the options popup menu.
3. Click on Select X Axis to change the current x axis.
 
The selected channel becomes the new x-axis and is plotted against the other channels
loaded in the file folder. You can use the mouse to click and drag the ends of the gradient
line to manually change the best fit.
 
 
Notes

· Clicking on a channel in the file folder makes it the new current channel.
· Right click over the left axis to open the channel scaling popup menu.

5.2.5 Histogram

Use this function to open the histogram window. A histogram plot is a bar chart that shows
how much time a channel spends at different values. Using histograms you can visualize the
distribution of data. e.g. A histogram of RPM can be used to determine where peak power is
delivered.
 
1. On the View menu, click Histogram.
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The histogram window will open and display a bar graph of the channels loaded in the file
folder. The percentage scale is displayed on the left axis and the defined bins for the current
channel are labeled along the bottom.
 
2. Right click to open the options popup menu.
3. Click on Histogram Bins to change the bin count.
 
The histogram will update to reflect the new bin count. The actual percentages for each bin
for the current channel are displayed at the top of histogram. You can use the Set Y Scale
menu to change the default scaling for the Y axis.
 
Notes

· Clicking on a channel in the file folder makes it the new current channel.
· Right click over the left axis to open the channel scaling popup menu.

5.2.6 Measure Cursor

Use this menu to open the measure cursor function. This feature allows you to measure the
difference in channel values between two points on a time or distance plot.
 
1. On the View menu, click Measure Cursor.
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The measure cursor datum point will show at the cursor position for the current channel.
 
2. Click on the graph to locate the position of the datum point.
3. Move the cursor over the graph to the measure point.
 
The numeric display at the top of the window will update and show the delta x and y values
for the current channel as the cursor position changes.
 
4. Click on a channel in the file folder and repeat to measure a different channel.
 
 
Notes

· Measure Cursor option requires wheel speed and distance channel logging.
· The measure cursor function is disabled anytime the graph is refreshed.

5.2.7 Event Markers

Use this menu to enable the event marker function. This feature displays information on
when a channel value reaches a certain condition as defined by the settings in the event
marker editor. e.g. When the engine rpm exceeded a threshold, how long the event occurred
and what was the maximum value.
 
1. On the View menu, click Event Markers.
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2. The event markers feature is now enabled.
3. Click on the menu again to disable this feature.

Notes
· Right click over the left axis to open the scaling's and event marker editor menu.
· Event markers can individually be set and enabled for each channel.

5.2.8 Macro Toolbar

Use this menu to open the macro toolbar. The toolbar provides a convenient way to select
any of the previously defined channel and window layouts. Up to fifteen different layouts
can be saved using the Save Macro function.
 
1. On the View menu, click Macro Toolbar.
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2. The toolbar will be displayed.
3. Click on the menu again to hide the toolbar.
 
Notes

· Using any macro will delete the current channels and window layout.
 

5.3 Edit

Summary
The edit menu provides access to the following:

· Channel properties
· Outing information
· Math channel setup and use
· Color pallette
· Modifying current calibration data
· Modifying data streamed channels from Edelbrock ECU
· Zero channel function

5.3.1 Channel Properties

Use this function to view and edit each of your global channel settings.
1. On the Edit menu, click Channel Properties

 
The channel properties window will open and display all of your logger channels along with the
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parameters defined for each. This window supports name filtering. Press the first letter of a
channel name and the window will automatically refresh but only displaying the channels that
start with that letter. You can also sort channels by clicking on the top of any of the columns.

2. Double-click on a channel and the parameter edit window will open.
3. Edit each of your channel settings.
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You can edit any of the channel parameters except the Name and ID. Channel names can only
be changed using the calibration editor. 
4. Click OK.
5. Repeat step 2 for additional channels.
6. Close the window to save your changes.
 
Options

When you right-click over any of the channel definitions the popup menu with the following
options will open.

· Group Names - Opens the window for editing your group names.
· Print Definitions - Print the definitions for all of your defined channels.
· Print ID's - Prints the channel ID's and types for your analog channels.
· Print ECU Def's - Print the definitions for your ECU channels.
· Edit Tag ID - Allows the current channel to be replaced with an existing definition.

 
 
Notes

· Some functions may not be available depending on your login status.

5.3.2 Outing Info

This function allows the user to edit the outing information stored with the current data set.
 
1. On the Edit menu, click Outing Info.
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2. Edit the outing information as required.
3. Edit any text Comments for the data set.

 
You can also edit the start lap, session and outing numbers from this window. An offset to
the lap count can also be made by setting the number of pace laps.
 
4. Click OK to save changes.
 
Notes

· Changes made to the outing information are permanently saved with the current data
set.

5.3.3 Creating

Use this function to create or edit your math channels. This feature allows complex math
functions to be created using your existing channels in combination with predefined
functions, operators and constants. Math channels can be treated as ordinary channels and
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can be graphed, included in reports and even nested in other math channels.
 
1. On the Edit menu, click Define Math Channels.
 
The math channel editor window will open and display the first math channel you have
defined. The math string text window is a simple editor and can be written to directly or you
can double-click in any of the list boxes to bring a channel, function, operator or constant
into the math text string.
 
2. Click on the Create New Channel menu.
3. Enter the Name for the new math function.
 
It is recommended that you select non-ambiguous names for your math channels and that
they are dissimilar to any existing channels and defined constants. The minimum number of
characters allowed for a math channel name is 2. Any blank characters in the name will
automatically be filled with the underscore character.
 
4. Click OK.
5. Enter the math string for your new function.
 
Certain operators have a higher precedence than others and effect how channels are
calculated. Multiplication and Division have higher precedence than Addition and
Subtraction. If in doubt you can use parenthesis when writing your math strings
 
6. Click OK to accept the changes.
 
 
Notes

· Before you can nest a math channel it must be first be created and saved.
· Use the Select menu or Name button to view a different channel.

· Use the Delete menu to remove an existing math function.
 

 

5.3.4 Importing

Use this function to import predefined math functions.
 
1. On the Edit menu, click Define Math Channels.
2. Click on the Import menu.
3. Select the drive and folder where the math (*.TXT) file is stored.
4. Double-click on the file or click OK to open it.
5. Select the math functions you wish to import from the list.
6. Click OK.
7. You will be prompted to confirm if any duplicate names exist.
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8. Click OK to accept the changes.
 
Notes

· You can use the Export menu to save math functions to a (*.TXT) file.
 

5.3.5 Math Operators

 

Operato
r

Description

+ Arithmetic summation

- Arithmetic subtraction

* Arithmetic multiplication

/ Arithmetic division

^ Arithmetic power

=> Boolean greater or equal

> Boolean greater than

<= Boolean less or equal

< Boolean less

& Boolean logical AND

| Boolean logical OR

# Boolean exclusive OR

% Modulo arithmetic

= Boolean equal

!= Boolean not equal

  
Notes 

· Boolean functions return a value of zero (0) for false and one (1) for true.
 

5.3.6 Math Functions

Available Functions
 
ABS() - Returns the absolute value of the operand. The absolute value of a number is its
unsigned magnitude. For example, ABS(-1) and ABS(1) both return 1.
 
ACos() - Returns the arccosine value of the operand. The ACos function takes the ratio of
two sides of a right triangle and returns the corresponding angle in radians. The ratio is the
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length of the side adjacent to the angle divided by the length of the hypotenuse.
 
ASin() - Returns the arcsine value of the operand. The ASin function takes the ratio of two
sides of a right triangle and returns the corresponding angle in radians. The ratio is the
length of the side opposite the angle divided by the length of the hypotenuse.
 
ATan() - Returns the arctangent value of the operand. The ATan function takes the ratio of
two sides of a right triangle and returns the corresponding angle in radians. The ratio is the
length of the side opposite the angle divided by the length of the side adjacent to the angle.
 
Avg() - Returns the lap average value of the operand. The Avg function sums the channel
values for the current lap and divides the result by the total number of samples.
 
Ceil() - Returns the lap maximum value of the operand. The Ceil function finds the
maximum value for the current lap and returns this value for all samples.
 
Cos() - Returns the cosine value of the operand. The Cos function takes an angle and returns
the ratio of two sides of a right triangle. The ratio is the length of the side adjacent to the
angle divided by the length of the hypotenuse.
 
Delta() - Returns the difference between two values. The Delta function returns the
difference between the operand of the datum lap and the current lap. If no datum is loaded a
value of zero is returned.
 
Deriv() - Returns the derivative value of the operand. The Deriv function calculates the rate
of change of the operand at 3 sample intervals.
 
Exp() - Returns the exponential value of the operand, e (the base of natural logarithms)
raised to a power. The Exp function complements the action of the Log function and is
sometimes referred to as the antilogarithm. The constant e is approximately 2.718282.
 
Floor() - Returns the lap minimum value of the operand. The Floor function finds the
minimum value for the current lap and returns this value for all samples.
 
Gate_Avg() - Returns the gated lap average of the operand. The Gate_Avg function
calculates the average value of the operand but only using values that are not zero.
 
Integ() - Returns the integral value of the operand. The integral function calculates a
running summation of the operand at 3 sample intervals.
 
Ln() - Returns the natural logarithmic value of the operand. The natural logarithm is the
logarithm to the base e.
 
Log() - Returns the base-10 logarithmic value of the operand. It is calculated by dividing the
natural logarithm of the operand by the natural logarithm of 10.
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Max() - Returns the running maximum value of the operand. The Max function tracks the
maximum value of the operand for the current lap.
 
Min() - Returns the running minimum value of the operand. The Min function tracks the
minimum value of the operand for the current lap.
 
Not() - Returns the inverse value of the operand. The Not function returns the logical
negation of the operand. In addition the Not operator inverts the bit values of the operand.
 
Sin() - Returns the Sin value of the operand. The Sin function takes an angle and returns the
ratio of two sides of a right triangle. The ratio is the length of the side opposite the angle
divided by the length of the hypotenuse.
 
Sqrt() - Returns the square root of the operand. The operand must be a value greater than or
equal to zero
 
Tan() - Returns the tangent value of the operand. Tan takes an angle and returns the ratio of
two sides of a right triangle. The ratio is the length of the side opposite the angle divided by
the length of the side adjacent to the angle.
 
Notes

· The trigonometric functions return values expressed in radians.
· To convert degrees to radians, multiply degrees by pi/180. To convert radians to

degrees, multiply radians by 180/pi.
 

5.3.7 Math  Examples

Note: The following math channels are examples and should be treated as such. Their
accuracy and usefulness is not guaranteed.
 
Name Engine_Rate
Syntax Deriv(RPM / 60)
Channels RPM
Definition The rate of change of engine speed.
-  
Name Brake_Bias
Syntax F Brake Pressure / (F Brake Pressure + R Brake Pressure) * 100
Channels Front and Rear Brake Pressures
Definition The ratio of the braking pressures front to rear.
-  
Name Heading
Syntax Integ(Gyro)
Channels Gyro
Definition Integrating the gyro channel returns the heading of the vehicle.
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-  
Name Compare_ET
Syntax Delta(Elapsed Time)
Channels Elapsed Time
Definition The cumulative time difference between the datum and current lap.
-  
Name Gear_Ratio
Syntax (RPM / 60) / (Speed / (0.680 * 3.1415))
Channels RPM and Speed
Definition The ratio of speed between the engine and driven wheels.
-  
Name Ride_Height
Syntax (FL Damper + FR Damper + RL Damper + RR Damper) / 4
Channels Vehicle Dampers
Definition The simple definition of vehicle ride height.
 
 
Notes

· It is recommended to use constants to define any numeric values to improve calculation
accuracy and speed.

 

5.3.8 Creating

Use this function to create or edit your system constants. Constants are names that equate to
numeric values used in your math channels and can be global or outing dependant. Use the
appropriate check box to select which type you want to edit.
 
Global constants are made available for all math channels are for values that do not change
from one outing to the next. Outing dependant constants are for values that change with each
outing and are stored with the current data set.
 
1. On the Edit menu, click Define Constants.
2. Click on the Create button.
3. Enter the Name for the new constant and its Value.
 
Analysis also supports the use of links for defining constants. See the section on defining
and using links later in this section.
 
4. Click OK.
5. Repeat step 2 for additional constants.
6. Click OK to accept the changes.
 
Using Constants
When a math channel that contains a constant is calculated, analysis first looks in the list of
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outing dependant constants. If the value is not found a search is then made in the global
constant list. If neither list contains the constant the math channel cannot be calculated.
 
Defining Links
Constants can also be defined by links to values in the cells of a spreadsheet application
such as Microsoft Excel. The syntax for defining a constant link is :
 
Application Name | Sheet Name ! Row Number Column Number. e.g. excel|sheet1!r4c8.
 
This example would return the value from row 4, column 8 of sheet 1 of an open Excel
spreadsheet. If the application is not open or the cell does not contain a number a value of
zero is returned.
 
Notes

· You can use the Copy to Outing menu to copy all global constants to the current outing.
 

5.3.9 Importing

Use this function to import system constants.
 
1. In the Edit menu, click Define Constants.
2. Click on the Import menu.
1. Select the drive and folder where the constant (*.TXT) file is stored.
3. Double-click on the file or click OK to open it.
4. Select the constants you wish to import from the list.
5. Click OK.
6. You will be prompted to confirm if any duplicate names exist.
7. Click OK to accept the changes.
 
Notes

· You can use the Export menu to save constants to a (*.TXT) file.
 

5.3.10 Color Pallette

Use this function to edit the system palette colors.
 
1. On the Edit menu, click Color Palette.
2. Click on the Color you want to edit.
3. Select a new color from the windows palette.
4. Click OK.
5. Repeat step 2 for additional colors.
6. Click OK to accept the changes.
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Notes

· Custom colors can be defined using the windows palette control.

5.3.11 Current Calibration

Use this function to view and edit the calibrations of your analog channels for the current
data set.
1. On the Edit menu, click Current Calibration.
 
The calibration window will open and display the first analog channel. If you are connected
to your LCU the real-time channel reading in the status bar is active showing the current
output from the sensor and can be used to monitor the response of the sensor as it moves.
The calibration points in the grid are plotted on the graph.
 
2. Use the Select Channel menu to list the available channels.
3. Select the channel for calibration and click OK.
 
The calibration window will display the x y points for the selected channel and refresh the
graphic display. Make sure that the Manual ADC menu is unchecked if you want to perform
your calibration using direct sensor readings.
 
4. Edit the calibration points and choose a calibration type.
5. Apply or clear any calibration offsets.
6. Repeat step 2 for additional channels.
7. Close the calibration window to save your changes.
 
Notes

· Editing a sensor calibration in the analysis application will only apply to the current
data set.

 

5.3.12 ECU Calibration

This function allows you to edit the calibrations of the ECU channels for the current data set
if you are data streaming data from an Edelbrock ECU. ECU channels are calibrated into
engineering units by applying a scale and offset to the raw data.
1. On the Edit menu, click ECU Calibration.
2. Select Standard Channels or Extended .
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3. Select the channel you want to edit from the combo box.

4. Enter the calibration Scale value.
5. Enter the calibration Offset value.

The default calibration values for Edelbrock ECU products can be found in the Appendix
under ECU Calibrations
6. Repeat step 2 for any additional channels.
7. Click OK to save changes.
 
Notes
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· Editing a sensor calibration in the analysis application will only apply to the current
data set.

 

5.3.13 Zero Channels

This function allows you to zero a channel calibration for the current data set. In certain
conditions you may find it useful to make a sensor read zero at a particular measurement. e.
g. to set the vehicle ride height or neutral position of a gear position sensor.
 
1. Create a new Window for the channels you want to zero.

2. Select the window containing the channels for zero and right click, select Zero all
Channels.

3. Input zero or any value desired, click OK
4. LCU configuration will update automatically and channels will be zeroed. 
 
Notes

· Use the calibration editor to remove offsets applied to a sensor calibration.
· Editing a sensor calibration in the analysis application will only apply to the current

data set.
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5.4 Data

Summary
The data menu provides access to the following features and functions:

· Hide file folder
· Remove current scalings
· Add new folder
· Add outing to current data set
· Replace current outing with another
· Delete an outing
· Auto update on new download
· Tile graph windows

5.4.1 Hide File Folder

To maximize the viewing area for your graphs you can use this option to hide the file folder
window.
 
1. On the Data menu, click Hide File Folder.
2. The file folder will be hidden and the menu will be checked.
3. Click on the menu again to restore the view.
 
Notes

· You can also use the F5 hot key to perform this function.

5.4.2 Remove Scalings

Use this function to undo any temporary scalings that have been applied to the current
channel or all channels.
 
1. On the Data menu, click Remove Scalings.
2. The edit window will open and display the current channel.
3. Click on the All Channels check box if required.
4. Click OK to save changes.
 
 
Notes

· Channel scalings cannot be removed if the Make Global check box was selected in the
edit scalings window.
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5.4.3 Add New Folder

Use this function to add a new folder to the File Folder window.
 
1. On the File menu, click Add New Folder.
2. Select the drive and folder where the dataset is located.
3. Click on the dataset to read the file details and comments.
4. Double-click the dataset or click OK to open it in the new folder.
 
 
Notes

· There is a maximum limit of five file folders that can be open at one time.

5.4.4 Delete Folder

Use this function to delete the current file folder.
 
1. On the Folders menu, click Delete Folder.
2. The current folder will be removed from the file folder window.
3. Any open outings and laps in the deleted folder will also be unloaded.
 
Notes

· There is a maximum limit of five file folders that can be open at one time.

5.4.5 Add Outings

Use this function to add a new dataset to the File Folder.
 
1. On the File menu, click Add Outing.
2. Select the drive and folder where the dataset is located.
3. Click on the dataset to read the file details and comments.
4. Double-click the dataset or click OK to open it.
 
Notes

· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Replace Outing menu to replace the current outing.
· Only dataset files of the type (*.DAT) can be read by Analysis.

5.4.6 Replace Outings

Use this function to replace the current dataset in the File Folder.
 
1. On the File menu, click Replace Outing.
2. Select the drive and folder where the new dataset is located.
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3. Click on the dataset to read the file details and comments.
4. Double-click the dataset or click OK to select it.
 
 
Notes

· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Add Outing menu to add a new outing to the File Folder.
· Only dataset files of the type (*.DAT) can be read by Analysis.

5.4.7 Replace All Outings

Use this function to delete all of the datasets currently loaded in the File Folder and replace
them with a single new outing.
 
1. On the Data menu, click Replace All Outings.
2. Select the drive and folder where the new dataset is located.
3. Click on the dataset to read the file details and comments.
4. Double-click the dataset or click OK to select it.
5. The currently loaded outings will all be deleted.
 
 
Notes

· To open a file you've used recently, you can use the Recent File menu list.
· You can use the Add Global menu to add an outing to all open folders.

5.4.8 Delete Outing

Use this function to delete the current dataset from the File Folder.
 
1. On the Data menu, click Delete Outing.
2. The current outing will be removed from the file folder.
 
 
Notes

· To open a file you've used recently, you can use the Recent File menu list.
 

5.4.9 Auto Update

This feature automatically replaces the current outing in the file folder with new data
immediately after the logger download has been completed.
 
1. On the Auto Update menu, click On New Data.
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2. The auto update feature is now active and the menu will be checked.
3. Click on the menu again to deactivate the feature.
 
 
Notes

· The current outing is replaced if more than one outing is loaded in the file folder.

5.4.10 Tile Graphs

This feature changes the full graph view into tiles for each individual channel loaded in the
file folder. There are two mode of operation for this feature.
 
Automatic - The graph is evenly divided into the number of channels loaded in the file
folder.
 
Manual - The screen percentage used for each channel is set manually under channel
parameters.
 
1. On the Data menu, click Tile Graphs.
2. Tile mode is now selected and the menu will be checked.
3. Click on the menu again to restore the standard view.
 
Notes

· Tile mode settings can be changed under the file Options menu.

5.5 ECU Calibrations

Channel Units Offset Scale Comments
Engine RPM rpm 0 1  
Battery volts 0 0.07  
Throttle deg 0 0.5  
Airbox Pressure In Hg 0 0.125 See Notes
Exhaust Pressure In Hg 0 0.125 See Notes
Fuel Pressure psi 0 1  
Oil Pressure psi 0 1  
Lateral G G -6.35 0.05  
Fuel Temperature deg C -50 1  
Air Temperature deg C -50 1  
Water Temperature deg C -50 1  
Oil Temperature deg C -50 1  
ECU Temperature deg C -50 1  
Lambda 1 ratio 0.6 0.005  
Lambda 2 ratio 0.6 0.005  
CDI Temperature deg C -50 1 Race 4.0 only
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TPS rate bits -128 1  
Gear Position # -1 1  
Mixture Switch % -12 2  
Boost Switch # 1 1  
Beacon volts 0 0.02  
Duty 1 % 0 0.39 Wastegate Output 1
Duty 2 % 0 0.39 Wastegate Output 2
Frontwheel mph 0 1 See Notes
Rearwheel mph 0 1  
Fuel Used Gal 0 0.01 Use 0.1 for liters
Injection mSec 0 0.001  
Spark Advance deg 0 0.25  
Lambda Correction 1 % -100 0.781  
Lambda Setpoint ratio 0.6 0.005  
EGT 1 deg C -98 4.731 Race 4.0 only
EGT 2 deg C -98 4.731 Race 4.0 only
FLAG0 bits 0 1  
FLGCUT bits 0 1  
Power Cut % 0 3.125  
FLAG2 bits 0 1  
FLAG3 bits 0 1  
FLAG4 bits 0 1 Knock output
Intake Cam deg 0 0.25  
Exhaust Cam deg 0 0.25  
Sync Position deg 0 1  
Slip % 0 0.195  
Lambda 1 Temp ohms 0 1  
Heater Duty % 0 0.391  
Shift Switch volts 0 0.02  
Pit Limiter bits 0 1  
Lambda Correction 2 % -100 0.781  
Duty 3 % 0 0.391 DC Motor Output
Pedal Position deg 0 0.5  
Feedback volts 0 0.5  
Duty 4 bits 0 1 Nitrous Stage Flag
Lambda 2 Temp ohms 0 1  
 
Notes

· Pressure calibrations may vary depending on scales used in the map.
· Wheelspeeds will output in kph if metric units are selected in the setup.
· To change temperatures to Deg F use Offset = -58 and Scale = 1.8.
· Lambda temps are only valid when using Bosch Wide Band sensors.
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5.6 Hot Keys

 
Analysis Hot Keys
 
Hot key Menu Description
Ctrl+P Print Print the current plot or report.
Ctrl+Q Exit Exit the program.
Ctrl+T Time Plot Open the time plot window.
Ctrl+D Distance Plot Open the distance plot window.
Ctrl+Y XY Plot Open the XY plot window.
Ctrl+H Histogram Open the histogram window.
Ctrl+M Measure Cursor Display the measure cursor.
Ctrl+E Log Book Open the engine logbook window.
Ctrl+O Outing Info Open the outing data window.
Ctrl+I Enter/Edit Splits Open the split editor window.
F5 Hide File Folder Hide the logger file folder window.
Ctrl+X Track and Data Open the track map and data cursor windows.
Ctrl+F1 Replace Outing Replace the current outing in the file folder.
Shift+F1 Add Outing Add a new outing to the file folder.
Ctrl+N Next Lap Change to the next lap.
Ctrl+B Previous Lap Change to the previous lap.
F3 Group Laps Open the group laps window.
Ctrl+F3 Replace current lap Replace the current lap.
Shift+F3 Add Lap(s) Add lap(s) to the current outing.
Ctrl+F2 Replace current Replace the current channel.
Shift +Del Delete Channel Delete the current channel.
Ctrl+S Scalings Open the channel scalings editor.
Ctrl+C Channel Color Open the channel color editor.
Ctrl+Z Zero Channels Open the zero channels editor.
Ctrl+G Entire Outing View the entire outing.
Ctrl+U Undo Last Undo last zoom command.
Ctrl+L Scroll Left Scroll plot to the left.
Ctrl+R Scroll Right Scroll plot to the right.
Ctrl+V Tile Graphs Change to tile graphs view.
Shift+F5 Tile Vertically Tile open windows vertically.
Shift+F6 Tile Horizontally Tile open windows horizontally.
Shift+F7 Save Macro Save current screen as a macro.

6 Mapping Guide

The following sections describe procedures and tips for setup and tuning the most common
areas of the engine calibration.
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6.1 Sensor Calibration

Most of the engine sensors are calibrated using a 2 dimensional table of engineering units for
each of the raw bit values on the map. The standard map consists of 20 calibration points
which can be individually set by the user by editing the breakpoints. The gear position
channel is calibrated by a linear table of raw bit values corresponding to each of the gear
positions. The calibration procedure is described below.

Procedure
1. Open System Editor and select the Monitor ADC function.
2. Using the dropdown combo box select the sensor you want to calibrate.
3. Step the sensor through its range of raw bit counts and note the corresponding

engineering values for each point.
4. Enter these values into the appropriate calibration table in the System Editor.

Sensors
· Temp Sensors (units deg C)
· Pressure Sensors (units In Hg and psi)
· Throttle Sensor (units deg)
· Gear Position

6.2 Pickup Settings

Typical values for the crank pickup position are 10 to 15 deg BTDC. To ensure the most
accurate ignition timing during engine start the ignition fires asynchronously with the static
crank pickup position. This prevents spark scatter during the cranking phase when the engine
rpm is very low and erratic. 

Typical value for the sync pickup position is 45 deg. BTDC on the compression stroke. This
pickup is used to identify the location of the number one cylinder and occurs once every 2
engine revolutions. Its exact location is not critical but must be set to trigger at least 10 deg.
before the crank pickup position. The sync position calculated by the ECU can be monitored
by the comms program. (Note : This feature is unavailabe for 60-2 and 36-1 trigger wheel
configurations).

Notes
· The static crank pickup position must be correctly set in the map or will result in

ignition timing errors.
· You cannot run the engine at an ignition timing value of less than the static crank pickup

position.
· Positioning the sync (cam position) pickup too close to the crank pickup can result in

sequence errors and engine misfire.
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· Some versions of firmware require the pickup position to be set in an advanced position
i.e. 60 deg BTDC.

· Inductive pickups when wired backwards will trigger late and cause a retard of the
ignition timing.

· Magnetic (VR type) sensors must be configured for falling edge triggger

Pickup Delay

All pickups have an inherent delay that varies with each manufactures design. Hall effect
sensors have smaller delays, typically 50uS whereas inductive sensors have higher values
such as 150uS. The ECU software has a provision to eliminate ignition timing errors caused
by pickup delay as described below.

1. Check the ignition timing at a low speed such as 2000 rpm.
2. Adjust the pickup position constant so that the timing value matches that in the map.
3. Run the engine up to higher rpm such as 5000 rpm and note any error in timing.
4. Change the pickup delay constant. Increase the value if the timing is retarding.
5. Repeat step 3 and check again for errors.

See the section on Spark Constants for further information on setting and tuning these
variables.

6.3 Distributed applications - Synching the Ignition Timing

On distributed applications, the commanded ignition timing is only as accurate as the relative
position of the crank position pattern to the actual crank position.  Since the distributor's
rotational position is adjustable, it must be synched to the engine.  The following basic
procedure is used:

1. Use timing light to measure actual ignition advance
2. Compare observed timing to the displayed value in System Editor
3. If they do not match, rotate the distributor until they match

Often normal fluctuations in commanded ignition timing make it difficult to sync the timing. 
One trick to make this task easier is to "zero out" the ignition trim tables and "flatten" the
main spark map to command a "fixed" timing.  See below.

TIP:
Zero out all spark trims and set a flat spark map to simplify the timing synch
procedure.
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To highlight the whole table, left click on the top left cell of the table and select fill range.

Be sure the whole table is highlighted blue and select a fixed value.  30 degrees works well
for most engines.
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To zero out the ignition trims, the following tables are affected:

Spark f(Airbox)
Spark f(Water)
Spark f(Air)
Spark f(Fuel P)

Ensure each of the above tables contains zeros as shown below:
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Once this is done, the commanded ignition timing will be 30 degrees.  Check the actual
ignition timing with a timing light and verify 30 degrees advance.  Adjust the distributor as
necessary.  Increase the RPM to 1500-2500 RPM and make sure the timing does not drift.

6.4 EFI Tuning Strategies

The Engine Management System functions by receiving inputs from various sensors, making
calculations and operational decisions, and sending appropriate instructions to outputs that
control devices and actuators. In order to do this, the Engine Control Module (ECM) converts
the analog inputs to digital signals and processes them within the microprocessor. Outputs are
conditioned as required for the assigned purpose.
 
Your Edelbrock system is capable of two different fuel/timing control strategies.  The MAP-N
strategy uses a base fuel map that varies as a function of engine speed and manifold pressure. 
The desired base injector pulsewidth is displayed in the table.  The Alpha-N strategy uses a
base fuel map that varies with engine speed and throttle position.  The desired base injector
pulsewidth is displayed in the table.  The Alpha-N strategy works very well for engines with
very large camshafts that exhibit very low idle vacuum.  The table below summarizes the
advantages and disadvantages to each control strategy.
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MAP-N Alpha-N

Advantages

· Relatively quick and easy to tune
· Base fuel map in units of injector

pulsewidth
· Very common tuning method

used in many available
aftermarket EFI systems.

· Works well and easy to tune for
boosted applications

· Easy to modify calibration if
larger injectors installed

· Works well for large overlap
camshafts Not affected by low idle
vacuum signal

· Relatively quick and easy to tune
· Base fuel map in units of injector

pulsewidth
· Easy to modify calibration if larger

injectors installed

Disadvantages

· Does not work well with large
overlap camshafts due to low
idle vacuum

· Requires temperature based trim
tables

· Indirect measurement of load
· Calibration could be inconsistent

if trim tables are not properly
tuned

· Idle mixture affected by closed
throttle TPS voltage drift

· Requires temperature based trim
tables

· Indirect measurement of load
· Does not work well with idle air

control motors.
· Calibration could be inconsistent if

trim tables are not properly tuned

 
The engine management system requires sensor data to maintain efficient operation under
various conditions, and to provide feedback to the ECM regarding the current operating
conditions. The sensors needed for basic operation include: ECT (Engine Coolant
Temperature), IAT (Intake Air Temperature) or (Charge Air Temperature), TPS (Throttle
Position Sensor), CTS (Crankshaft Trigger Sensor), MAP (Manifold Absolute Pressure)
sensor, and O2 (oxygen sensor). Other sensors can be added for additional control information
or data acquisition; however, the sensors listed are the minimum ones required for basic
engine control with this system.

Selecting either MAP-N (Speed Density) or Alpha-N strategies
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To use the Alpha-N strategy, be sure to un-check the Set Speed Density Mode check box
above.  When this is done, the next time System Editor is opened, all load breakpoint settings
will default to throttle position.  Be sure the TPS sensor is calibrated properly and the load
axis in the main fuel and spark maps are set for maximum resolution.  In other words, the
highest load breakpoint should be very close to the max displayed TPS value.  Note that the
breakpoints do not need to be linear.  More breakpoints can be defined at lower throttle
settings to increase part throttle resolution.

6.5 Idle Control

When the idle control function is active, the ECU performs the following functions:

· Measures engine RPM and compares it to a target RPM
· If the measured RPM is lower than the target, the ECU opens the idle control valve 
· If the measured RPM is higher than the target, the ECU closes the idle control valve
· If the measured RPM is equal to the target (within limits), the ECU maintains the current

idle control valve position

The speed of the response and the magnitude of the changes applied by the control system are
determined by the control gains.  The gains are constants defined in the calibration.  One set
of gains will not necessarily work for every application.  Engines with large camshafts and
lopey idle typically require faster control gains.  Stock or mildly modified engines with
smaller camshafts typically require slower gains to avoid surging.
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Idle Control Function Thresholds

In order for the idle control function to begin, certain criteria must be met.  If these criteria
aren't met or aren't set up properly in the calibration, the idle control function will not work
correctly.

The most important criteria for entering idle control is the Throttle Limit constant.  The
example above shows a throttle limit of 15 degrees.  This means that unless the measured
throttle angle is BELOW 15 degrees, the ECU will not even try to control engine speed to the
target value.  Novice tuners setting up an  engine for the first time expect the engine to start
and idle at a reasonable RPM right away.  If it doesn't, they blame the idle control function. 
One of two things usually happens:

1. The fuel and/or spark tune is not right so the idle control system surges trying to maintain a
target
2. The throttle opening is manipulated to keep the engine running exceeding the throttle limit
threshold and disabling idle control altogether

TIP:
Always disable idle control until the idle and off idle fuel/spark tune is setup.

To disable idle control, either unplug the IAC connector or disable it in the IAC configuration



Power to Win234

by de-selecting the Enable IAC Control constant.

Another criteria for entering idle control is the RPM Limit.  The example above shows an
RPM Limit of 1500.  This means that unless the engine RPM is below 1500, the ECU will try
to control idle.  A common scenario when beginning a new tune is the throttle set too far
open.  The engine is started and the engine speed quickly exceeds the RPM Limit.  Engine
speed will just hang high since the ECU is not even trying to pull it down.  Again, the solution
here is to ensure idle control is disabled until the fuel/spark and closed throttle setpoint is
adjusted correctly.

Tuning the Closed Loop Control Gains

The closed loop control gains are found in the idle constants window shown above.  One
method for tuning the gains is outlined below:

1. Disable the integral gain by setting it to zero.
2. Start with a proportional gain of 10.0
3. Enable closed loop control by selecting the Enable IAC Control option in the IAC

Configuration window.
4. Start the engine and allow it to come to operating temperature.
5. Verify the closed throttle angle is below the throttle limit threshold value.  If not adjust as

necessary.
6. Introduce a system disturbance by quickly opening and closing the throttle.
7. Monitor the oscillations.  Increase the proportional gain value until the magnitude of each

successive oscillation is roughly one quarter in amplitude of the previous peak.  In other
words, if the RPM fluctuates from 800 - 1000 RPM (200 RPM difference) on one sweep,
tune the proportional gain until the following oscillation is one quarter the previous or 50
RPM.

8. Enable the integral gain and begin increasing it slowly while repeating the disturbance test
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above each time.  Continue increasing the integral gain until the oscillations are completely
dampened out.

6.6 Fuel Tuning Requirements

Objectives
What are the tuning objectives for fuel control?  Unfortunately, there isn't a single answer to
this question.  Engines have different fuel tuning requirements under different operating
conditions and these can vary widely from one engine to another.  Factors that affect fuel
requirements include, but are not limited to:

· Displacement
· Compression ratio
· Camshaft specifications - lift, duration, overlap, etc.
· Cylinder head design - valve size, port volume and shape, combustion chamber shape, etc.
· Intake manifold design - plenum size, port volume and shape, etc.
· Throttle body size and design
· Vehicle weight and gearing
· Exhaust manifold / header design and vehicle exhaust system configuration  
· Normally aspirated vs forced induction
· Fuel type - gasoline, methanol or other?  octane rating?
· Street only vehicle or racing application?

For street or street/strip type combinations, in general; the objective is to optimize the fuel
tune for "best power" under high load part throttle and wide open throttle high RPM
conditions.  "Best economy" should be the objective in the areas of the fuel map used for
street and highway cruising.  Idle and part throttle acceleration areas will usually fall
somewhere in between.

When tuning for a race only application, economy is usually not a concern unless the
application is for road or oval track type racing where good fuel mileage is desirable,
especially under caution/yellow flag conditions.  

What is "best power" and "best economy"?

Best Power Target AFR
Gasoline spark ignited engines (normally aspirated) typically make best power between 12.5
and 13.0:1 AFR. The power curve through this range is usually very flat so the amount of
power gained from running at 13.0:1 vs 12.5:1 is usually minimal. Running slightly richer
will lower the combustion chamber temperatures and allow for more detonation margin. If
your application is turbocharged or supercharged, you need to target a slightly richer AFR.
For safe operation, an AFR of 11.3 to 11.8:1 is best. This can vary by application.  The excess
fuel tends to cool the piston and combustion chamber.  This can help avoid spark knock
problems.

Best Economy Target
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The most efficient combustion occurs at an AFR of around 14.7:1 for gasoline. At cruise
power settings with high engine vacuum, you can typically run slightly leaner without any
adverse effects. Engines can usually tolerate AFRs in the 15-15.5:1 range without any
problems. Be mindful of reversion problems though. See above.

Locked Throttle Mixture Distribution Data
The curves below illustrate the general effect of air/fuel ratio on performance. To obtain this
data, an engine is operated under precisely controlled conditions. The throttle angle is locked
in one position and the ignition timing is set to an optimum fixed value. The test is initiated
with a very rich air/fuel ratio (less than 10.5:1). The fuel flow rate is then slowly reduced and
data is collected along the way. The maximum power operating point is typically reached first
at a relatively rich air/fuel ratio. As the mixture is leaned further, the cylinder head
temperatures (CHT) reach a peak then begin to decrease. The exhaust gas temperature (EGT)
indication reaches a peak shortly thereafter then the specific fuel consumption reaches a
minimum. If the fuel flow is reduced even further (to greater than 17:1), EGT's, CHT's and
engine power begin to fall off very rapidly causing the specific fuel consumption to rise.
Operating the engine in this range results in very poor performance.
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How to measure/record AFR
High quality wideband oxygen sensor systems used to be very expensive and limited to
laboratory use only.  When the OEM vehicle manufacturers began using wideband sensors to
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increase fuel economy, the cost of these system began to drop significantly.  Wideband
sensor/controller kit pricing dropped by a factor of 10 from several thousand dollars to several
hundred.  Several popular suppliers of aftermarket wideband sensor kits are listed below:

Dynojet
http://www.widebandcommander.com

AEM
http://www.aempower.com

Innovate Motorsports
http://www.innovatemotorsports.com

Daytona Sensors
http://www.daytona-sensors.com/

Errors Caused by Exhaust Reversion
If your vehicle/engine has a very low restriction exhaust system and a relatively large
camshaft with a lot of overlap, you will have a significant amount of reversion at idle and
high vacuum areas. Reversion occurs when the exhaust flow is actually sucked back into the
engine during cam overlap. This can cause errors in the O2 sensor reading and usually results
in a false lean condition.

6.7 Main fuel map tuning tips

Main fuel map areas explained
The following graphic defines in general the various tuning areas of a typical main fuel map. 
The arrows do not point to specific cells or sites, rather areas that can overlap with one
another and will shift depending on the engine combination being tuned.  

The choice to tune in table or graphical view is somewhat personal but it should be noted that
tuning in the graphical view will highlight dips and valleys and make it easier to see where
problem areas may lie.  Transitions from one area of a map to another should be smooth and
free of steps, peaks or dips.  Inconsistencies like these can create tuning problems, especially
in the idle and part throttle cruise areas.     
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NOTE on oxygen sensors
All Pro Pro Flo XT Plus or XTR systems are capable of using either narrow band or wideband
O2 sensors. The difference between a narrowband and wideband O2 sensor is the range over
which the sensor is accurate. A narrowband is basically a switch that only tells the ECU if the
air fuel ratio (AFR) is richer or leaner than 14.7:1. A wideband sensor/controller typically has
a linear voltage output that is accurate over a range of 10 to 20:1 AFR.

To get the most out of any fuel injection system installation, a proper wideband O2 sensor/
controller installation is hard to beat. At typical cruising conditions, it is difficult to tell (by
the seat of your pants) the difference between an engine running at an AFR of 13.0:1 and one
running at 14.5:1 but the difference in fuel flow and economy between those conditions is
huge. A wideband will tell you instantly exactly what the AFR is under all conditions.

NOTE on recommended AFR values below
The recommended AFR values are for reference on normally aspirated engines only.  Forced
induction engines will have very different tuning requirements.  High overlap camshafts,
leaking exhaust systems and incorrect oxygen sensor installation can affect the observed AFR
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data.  It is always the responsibility of the tuner to ensure the calibration is safe and optimized
for the vehicle being tuned.  

Idle
Defines the closed throttle operating areas.  The RPM and vacuum/load range can vary greatly
and depends on the engine combination.  A typical gasoline V8 engine with a stock or mild
performance cam will idle in the 650-750 RPM range with as much as 20"-24" of vacuum at
idle.  Engines with big camshafts optimized for high RPM performance will idle in the 850-
1200 RPM range with is little as 6" of vacuum at idle.

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
14.5 - 14.8 13.8 - 14.5 13.5 - 14.0

  

Part Throttle Accel / Tip In
Defines the part throttle acceleration areas of the map, the areas used accelerating normally
from a stop.   

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
14.5 - 14.8 13.8 - 14.5 13.5 - 14.0

 

Cruise
Defines the high vacuum cruising areas of the map, the areas used cruising steadily on the
highway.

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
14.5 - 14.8 14.5 - 14.8 14.5 - 15.0

High Load Lugging
Defines the low vacuum (high pressure) area at relatively low RPM, the area reached on
vehicle with a manual transmission at high throttle angles climbing a grade.  The "lugging"
area.  

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
12.5 - 13.0 13.0 - 13.5 13.0 - 13.5
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High RPM High Vac
Defines the high RPM high vacuum area, the area reached revving the engine in neutral or
park.  

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
13.5 - 14.0 13.5 - 14.0 13.5 - 14.0

Part Throttle High RPM
Defines the high RPM low vacuum (not wide open throttle) area.  The area reached
accelerating aggressively but not at wide open throttle.

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
13.0 - 13.5 13.0 - 13.5 13.0 - 13.5

 

Wide Open Throttle High RPM
Defines the wide open throttle high RPM area.

Recommended air fuel ratio (AFR), fully warm engine:

Stock Mild Performance High Performance
12.5 - 13.0 12.5 - 13.0 12.5 - 13.0

   

6.8 Idle

The AFR required for a stable idle is dictated primarily by the camshaft profile. A long
duration cam, with big valve overlap, results in an inlet charge that is  diluted by exhaust gas.
This diluted charge burns slowly and may require a great deal of spark advance. In addition,
the combustion tends to be erratic, so a rich mixture is required to minimize cyclic variation
(the lopey “rump-rump” characteristic) caused by partial burn cycles. The AFR may need to
be 11.5 or richer with a really long duration cam. With a short duration cam, the AFR does
not need to be this rich for a stable idle and may be as lean as 14.7 (stoichiometry) in cases
where emissions need to be at a minimum.

Often, the manifold pressure (engine vacuum) indication can be used to optimize both the fuel
and spark settings at idle.  Start the engine and allow it to reach normal operating temperature.
Working on one area at a time, usually the fuel tune, start by adding or subtracting fuel in the
idle area.  While doing so, monitor the engine vacuum (or absolute pressure) indication.  The
better the engine runs, the more vacuum it will pull at idle.  Continue to add or subtract fuel
until you have maximized the engine vacuum at a given RPM.  If you find this "sweet spot"
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where the engine runs the best and continue to lean the mixture a few percent beyond this
point, you will improve your overall fuel economy.  Once the fuel tune is optimized, repeat
the same procedure with the spark advance.  Again, adjust the commanded spark values to
maximize engine vacuum at a given RPM.

   

6.9 Off-Idle & Slow Cruise / Low Speed & Light Load

The factors that influence AFR at idle also effect the metering requirements at off-idle
operating conditions where the engine rpm is low and the load low (low inlet density - high
Manifold Vacuum / or MV). Again, the longer valve duration (and overlap) requires richer
AFR for surge-free operation. In the immediate off-idle range the AFR may need to be nearly
as rich as the idle; perhaps 12.5 to 13.0 and gradually becoming leaner with increase in speed
or load. With a very mild camshaft profile, the engine will often tolerate AFR in the 14.0 to
15.0 range under these same operating conditions.  

Transient conditions like this often require the tuner to calibrate more by "feel" than anything
else.  Experiment.  Add or subtract fuel and/or spark timing.  in the off-idle light acceleration
areas.  Try to minimize the fuel pulsewidth while maintaining smooth power application and
acceleration.  Do the same with spark advance.  

6.10 Cruise & Light Acceleration / Medium Speeds & Loads

As engine rpm increases and the throttle is opened, the effect of valve duration and overlap
begin to diminish. There is much less inlet charge dilution and a correspondingly leaner AFR
may be used without encountering surge or other driveability problems. AFRs from 14.0 to
15.5 (or even leaner) are common. The “best economy” AFR range from 15.5 to 16.5 requires
additional spark advance to compensate for the slow burn rates of lean mixtures.  At these
very light load settings, try to minimize the fuel pulsewidths.  Lean the mixture in these areas
until a slight "hesitation" is noticed then richen it slightly.  This should establish a "best
economy" tune. 

6.11 Heavy Load - Part Throttle

As load on the engine increases from additional throttle opening (high inlet density - low MV)
the AFR needs to be enrichened to provide more power and avoid the driveability problems
associated with lean AFR at high loads. The AFR should be somewhere between the Cruise
and WOT AFR values; from about 14.5 to 13.0, depending upon the load and speed.  Again,
pay attention to how the engine "feels" while operating in these areas.  Keep in mind that
engine loads and stresses are higher now and require a mixture just slightly leaner than "best
power" settings.  Be cautious with forced induction applications here.  Boost can climb even
at part throttle settings so enrichen the mixture accordingly.
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6.12 Wide Open Throttle

All 4-cycle gasoline engines have about the same AFR requirements at WOT, where the
objective is maximum torque/power. The leanest AFR that provides maximum power is
known as LBT - Lean Best Torque and is usually around 13.3 AFR. The richest AFR, known
as RBT - Rich Best Torque is usually around 11.5 AFR. The spread between LBT and RBT
can be somewhat closer than this at high engine speeds. The best target AFR for WOT is
between 12.0 and 12.5; which insures best WOT power under all circumstances.  Forced
induction applications will require a slightly richer mixture to provide adequate cooling and
detonation margin.

6.13 Spark Tuning Requirements

Spark timing controls when combustion starts in the cycle.  If combustion starts too early,
there is too much force transferred from the piston to the gasses at the top of the compression
stroke.  If combustion starts too late, peak cylinder pressure is reduced.  This reduces torque. 
At a given fixed throttle position, air/fuel ratio and engine speed, the spark timing that
produces the maximum brake torque is called MBT or maximum brake torque timing.  

In general, as speed increases spark timing must be advanced to maintain optimum timing
because the duration of the combustion process in crank degrees increases.  Optimum timing
also depends on load.  As load and intake manifold are decreased, the spark timing must be
advanced to maintain optimum performance.

Spark timing affects peak cylinder pressure and therefore peak unburned and burned gas
temperatures.  Retarding spark timing from the optimum reduces these values.  Retarding
timing is used to reduce emissions and to avoid detonation (knock).  Often, spark timing is
reduced at idle to slow the engine speed and reduce the load on the idle air control system. 
Retarding the timing too much, in addition to greatly reducing engine torque and horsepower,
can cause excessive heat at the exhaust valve and into the exhaust system.  Although retarding
the spark timing will reduce the peak combustion temperatures, it can lead to higher
temperatures when the exhaust valve opens and is subject to flow.

Combustion chamber size and shape also has a large influence on MBT timing.  The shape of
the combustion chamber (along with other characteristics) affects how long it takes for the
combustion process to happen.  In general, modern overhead cam engines, require less total
timing than older engines because the combustion process happens much faster.  The faster
the combustion process happens, the less prone it is to detonation.

Boosted applications require less total timing than normally aspirated ones.  In general, spark
timing should be retarded at least one degree for every pound of positive manifold pressure. 
Again, this is only a rule of thumb.
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6.14 Cold Start and Warmup

The combustion process requires vaporized fuel.  Much of this vaporization occurs as the air
and fuel droplets are drawn past the intake valve but a large portion must take place before the
valve opens.  In a cold engine, the air, fuel and all the parts contacted by the fuel are at
temperatures that do not promote vaporization.  Because of this, additional fuel must be added
to compensate.  The degree of this fuel addition depends on the temperature.  

6.15 Accel Function

The accel enrichment function is used to provide additional fuel to the engine during transient
conditions. The ECU measures the opening rate of the throttle and calculates an amount of
additional fuel to be added to the base injection time.

Criteria
· Before the accel function is activated the accel rate must first be above the Min. Accel

Limit.
· If the accel rate is greater than the Max. Accel Limit this value is used in the

calculation.
· The accel rate is decremented by the Accel Decay constant once per engine revolution

after a transient event has been detected until it returns back to zero.
· A scaling constant of 100 is used to convert the numbers to engineering units of

microseconds.

Calculation

Accel Fuel = Accel Rate x 100 x Accel f(Water) x Accel f(RPM)

Assuming an accel rate of 20 bits and modifiers of 1.0 and 1.2 for each of the correction
tables we would calculate the accel fuel for the first engine revolution as follows :

Accel Fuel = (20 x 100 x 1.0 x 1.2) = 2400 uS

Notes
· Negative throttle rate values are not used by the accel enrichment function.
· The throttle accel rate can be logged by the ECU internal logger to help with tuning this

function.
· See the section on Accel Constants for further information on setting and tuning these

variables.

6.16 Suggested dyno mapping procedure

This section outlines the basic procedures for mapping an engine on the dyno. It is
recommended that the closed loop control mode is used to expedite and simplify the mapping
procedure. If your ECU is configured with an internal logger you can record your mapping
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session for later review.

Before Starting
1. Start the Editor with the ECU on line and make sure that the correct map is loaded.
2. Clear any error codes using the Clear Diagnostics function.
3. Make sure that the static crank trigger position matches the value set in the map.
4. Clear the lambda table using the Clear Lambda function.
5. Make sure that the throttle position sensor reads 10 deg. with the idle screw backed out

and reads at least 85 deg. at wide open throttle.

Initial Start-up
1. Start the engine and adjust the fuel to achieve a smooth idle.
2. Check the ignition timing and make sure it matches the values in the map. Refer to

Pickup Settings in System Editor for further information on correcting any timing
errors.

3. If your system is configured to use lambda sensors enable the closed loop at this time.
4. Warm up the engine and check that all of the engine sensors are reading correctly.

Mapping Procedures

The general principal of mapping is to run the engine at each of the defined rpm and load
sites, adjust the fuel to the required value and then save these changes in the ECU. It is
recommended that the Active Cursor option is enabled to track the position of the current cell.

1. Set the engine at the first rpm and throttle site that you want to map.
2. Adjust the fuel using the global trim keys "F8" and "F9" to reach your target fuel

numbers.

The global trim value is displayed at the top of the current map window.  If you are
using closed loop mode the global trims are adjusted automatically and require no user
input.

3. Press the Enter key to save the changes in the ECU.

If you have selected any of the Copy Cell features from the Options Menu, you can use
the F11 key to edit more cells at a time. Please refer to the Mapping Options section for
further information on these features.

4. Without moving the throttle move the engine to the next rpm site and repeat steps 2 and
3.

5. When the last rpm point has been mapped move the throttle to the next site and start
over.

6. When you have mapped all of the sites save the new map to disk.

Notes
· When using the Enter key to save changes to the ECU it is important to run the engine

as close to each rpm and throttle site as possible to minimize errors.
· When using speed density mode use the MAP sensor instead of the throttle for the load
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axis.
· If closed loop is enabled in the engine map it cannot be disabled from the tool bar.

6.17 PID Tuning

The term PID controller is an acronym for a closed loop system with proportional, integral
and derivative modes in its control algorithm. The fact that these three modes exist does not
imply that all three modes are necessarily used for any given application.

The purpose of a closed loop control system is to reduce the error between the measurement
and the setpoint. The ability of the system to reduce these errors depends on the different
controller settings. There are three main modes that contribute to the final output as follows :

Control Modes
· Proportional Mode - The proportional contribution to the output is equal to the error of

the measurement from the setpoint multiplied by a gain value. Almost all feedback
controllers use proportional mode.

· Integral Mode - The integral contribution to the output is equal to the sum (integral) of
the error multiplied by a gain value. As long as an error exists the integral action will
continue to drive the output and work towards eliminating the error.

· Derivative Mode - The derivative contribution to the output is equal to the rate of
change (derivative) of the error with respect to time. It provides an anticipatory type of
control that enables the use of higher gains, shortens oscillation, and reduces overshoot
for a given setpoint change.

· Final Output - The final output is the sum of these three mode as follows : Output = P +
I + D

Tuning Methods

The quarter amplitude method as described here is one of many used for tuning closed loop
control systems. It has proved to be effective in tuning many of the of the functions associated
with engine control systems.

1. Turn the integral and derivative modes off and enable the closed loop control with
proportional mode only.

2. Increment the proportional gain by a quarter of the previous value and monitor the
output for oscillations.

3. Continue until the outputs successive peaks are about one quarter in ampitude of the
previous peak.

4. Enable the integral mode and increment the gain in small steps to eliminate the output
error.

5. Finally enable and add derivative control only if the control loop output needs better
performance.

Notes
· Special algorithms cannot do better than a well tuned PID controller for unmeasured



Mapping Guide 247

load disturbances.
· Integral mode eliminates offset but reduces stability and increases overshoot for setpoint

changes.
· Control loops with setpoint changes or excessive hysteresis need more derivative action

and less integral.

6.18 Nitrous Control (XT Plus Only)

The diagram below shows a typical 2 stage nitrous setup.  The Pro Flo XT Plus systems
include a pre-terminated connector that includes all nitrous function outputs.  AUX Pin 2 and
AUX Pin 3 refer to pins 2 and 3 of the Auxiliary connector respectively.  The important thing
to remember is that you can not directly control nitrous solenoids with the ECU outputs.  A
typical nitrous solenoid can draw as much as 40 amps of current.  This high current draw
requires relays.    

Stage setup example:
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The stage setup example above will do the following:

· Add 12 lb/hr fuel flow per injector per stage
· Nitrous stages 1 - 4 activate sequentially one second apart each stage
· Spark timing is retarded 2 degrees per stage

Notes
· Unused stages must have the fuel added and spark retard constants set to zero.
· Fuel units are pounds per hour (lbs/hr) and time constants are in seconds (sec).

6.19 Tuning for regular vs premium fuels

The tendency for a given fuel to detonate is measured by its octane number. The higher the
octane, the less chance there is for detonation. Engines built for performance typically have
higher compression ratios and require a premium fuel. It is possible however to operate these
engines on lower cost “regular” fuels if certain precautions are taken.

Normal combustion in spark ignited engines begins with the spark plug firing. The plug
ignites the air-fuel mixture and a flame develops. The flame travels from the ignition point
through the combustion chamber burning the mixture trapped in the chamber. Detonation is
defined as spontaneous ignition of portions of the mixture at the outer edges of the chamber
not yet reached by the normal combustion flame front. This spontaneous ignition creates
sharp pressure waves in the engine that cause the familiar pinging sound. These pressure
spikes can lead to engine damage under severe conditions.

First it is necessary to understand the factors that affect detonation tendency. Not all of these
items require changes to fuel or spark tuning. In some cases, simple mechanical changes can
greatly reduce the likelihood of spark knock.

Spark Timing 
Time, pressure and temperature all influence knock tendency. When the spark advance is
increased, the peak pressure in the combustion chamber is increased because the ignition
event starts sooner and there is more time for the pressure to build during the burning process.
Higher peak pressure and longer burn times lead to higher chamber temperatures and increase
the chance of spark knock.

Air-Fuel Ratio 
Changes in air-fuel ratio can cause changes in flame speed, combustion wall temperatures,
cylinder pressure and gas reaction time. In general unless starting from a very lean condition
(greater than ~16:1 AFR), a richer mixture will decrease the combustion chamber temperature
and also the likelihood of spark knock.

Inlet Pressure and Compression Ratio 
Increases in either one of these values increases the likelihood of detonation. Higher inlet
pressure leads to increased temperature and can lead to detonation. Superchargers and
turbochargers increase both inlet pressure and temperature.
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Inlet Temperature 
Increasing the inlet temperature increases the gas temperature at a given pressure and
increases the tendency to detonate. Simple steps to reduce the temperature of the inlet air can
greatly reduce the chance of spark knock.

Coolant Temperature 
The effect of coolant temperature is similar to that of inlet temperature. Increased coolant
temperature leads to an increase in overall gas temperature and the chance of spark knock
occurring.

Air-Fuel Mixture Distribution 
Uneven mixture distribution can lead to detonation. In most cases under high load conditions,
the cylinders that run leaner than the rest will also run hotter. Hotter chambers increase
detonation tendency. Electronic fuel injection using sequential port arrangements allow for
trimming of individual cylinders. The lean cylinders can be enrichened to compensate for the
increased airflow while the other cylinders are left alone. This kind of tuning is best
accomplished on an engine dynamometer with appropriate data logging.

Engine Speed 
Increasing engine speed, decreases compression time and can decrease detonation tendency
assuming all other significant variables are held constant, inlet temp, coolant temp, air fuel
mixture, spark timing, etc.
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